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CHAPTERa

Oracle Tuxedo Application Rehosting
Workbench Users Guide

This chapter contains the following topics:

e Introduction

Prerequisites

Component and Layout

Detailed Rehosting M ethodology
e Performing the Data Migration

Introduction
What is Rehosting?

Rehosting is away to preserve the expensive investments in business logic and business data
trapped in proprietary hardware and software, while opening paths to future modernization by
moving to an open and more extensible architecture.

Product Overview

Refinefor Z/OS Replatforming package provides automated migration tool sto enable customers
to replatform COBOL, JCL, DB2, VSAM files and related assets from an IBM DB2 mainframe
environment to aUNIX environment with an Oracle Tuxedo transaction processor and an Oracle
database.
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The objectives of the plug-in are to help address these areas of complexity by providing the
following:

e One migration process is organized by an Tuxedo ART Workbench Project. this enables
you to navigate project artifacts in the Tuxedo ART Workbench navigator and perform
corresponding actions on the selected project.

e Help select and specify parameters and options required to define configuration settings for
the project as awhole and for specific tools. Most options in the flat configuration files can
be configured and modified in the project properties.

e Execute specific tools/commands required at a particular step in the process, using
configuration and other resources for any parameters/options to be specified on the
command line. Review output messages in the Tuxedo ART Workbench Consolein real
time.

e Review catalog generated reports.
e Along with the conversion, a progress monitor shows the source file being converted.

e Guide you through the migration process step-by-step.

Oracle Tuxedo Application Rehosting Workbench

Refinefor Z/OS Replatforming and Oracle Tuxedo Application Runtimefor CICSand Batch are
used within the context of arehosting project. The process guide givesaglobal view of rehosting
and the use of the conversion and runtime tools in this process. A rehosting project requires the
creation of specific test, integration and production environments. The different functions of a
rehosting project are typicaly:

e Plan the project, setting the general requirements and planning the target architecture
options.

e Prepare the assets to be converted and install and configure the target environment.
e Convert the assets.

e Integrate the assetsin the target environment.

These functions may be performed iteratively, typically a project consists of the following
phases:

e Setting project strategy.

e Assessment study.

Oracle Tuxedo Application Rehosting Workbench Users Guide
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e Pilot project.
e Implementation.

Each of these phasesis made up of different steps, the results of these steps may be tested and the
steps reiterated as necessary.

Rehosting Lifecycle Overview

Rehosting is performed within a project organized into phases and steps. Each step produces one
or more deliverables. In parallel to the different steps of the rehosting project are aparallel series
of test steps that validate the different phases of the project.

A project concerns different people who have different roles and responsibilities within the
project. A project is carried out within an environment and it isimpossible to describe the
different phases and steps of aproject without first describing the environment in which they need
to be performed.

Project Environment

There are five clearly distinct environments necessary to carry-out a rehosting project. These
include two source (pre-migration) environments and three target (post-migration) environments
as described below:

1. A current production source environment for the assets to be converted.

2. A test source environment for storing and isolating the operations extracted from the
production environment and for creating atest database.

3. A test target environment for running, tuning and testing the converted assets.

4. Anintegration target environment, which is used to host al activities such asintegration,
operations migration or pre switch-over processing.

5. A production target environment for the converted and tested assets.

Table 1-1 Project Environments

Environments Production Integration Test
Source Production Source Test Source
Target Production Target Integration target Test Target

Oracle Tuxedo Application Rehosting Workbench Users Guide 1-3



Oracle Tuxedo Application Rehosting Workbench Users Guide

Depending on your needs, there may be several occurrences of the same platform to allow teams
to work in parallel within the same project.

Project Phase Overview

A project isdivided into different phases of work, producing clear deliverablesthat are validated
before proceeding to the next phase of the project. These phases are as follows

Table 1-2 Project Phases

Phase Migration Steps Test Step Environment Language/
Data
PROJECT Project Definition
MANAGEMENT
PRE-CONVERSION Asset Generation Source Production  Both
to Source Test

Asset Cataloging Source Test Language

Asset Rationalization

(if necessary)

External Planning and

Specifications preparation for

Architecture Target

Development environments

Data Conversion Source Test to Data

Target test
TEST Test Engineering Source Test Both
PREPARATION Test Preparation
Test Tooling

PILOT Pilot Set Conversion  Pilot Set Testing Target Test Language
BALANCE Balance Conversion Balance Testing Target Test Language
INTEGRATION System Integration System Testing Target Test to Both

Operations Migration

Operations Testing

Target Integration

1-4 Oracle Tuxedo Application Rehosting Workbench Users Guide
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Tahle 1-2 Project Phases

Phase Migration Steps Test Step Environment Language/
Data
SWITCH-OVER Maintenance Maintenance Target Test Both
Conversion Testing Dry Runs
Maintenance

Conversion Testing

Switch-Over Target Integration
to Target
Production
EDUCATION Education And
Training

Graphically, the different phases may be grouped as shown below:
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Figure 1-1 Project Phases and Processes

Phase Process
Project
Project Dedinition
Management
Extemnal
Pre-Conversion Specifications
Architecture
Development
Data Discovery & !
Download Asset Generation
Data Remodeling & ,
R Asset Cataloging
. Asset
Data Validation Rationalization
Pilot Pilot Conversion
Balance Balance Conversion
Inte gration System Integration
Operations Integration

Overview of Using the Product in a Project

Refinefor Z/OS Replatforming isused for converting and integrating program components and
data. The following diagram shows the use of the program components, and how they are used
to prepare source files for migrating to different environments.
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Figure 1-2 Language Migration

PRODUCTION| INTEGRATION TEST
Catalog
SOURCE g
Generate epare
assets "
Convert
assets
TARGET Switchpver Intdgrate
A ~ asdets
e

Refine for Z/OS Replatforming components are used to convert assets, enabling them after
post-conversion adjustments to be moved from the from the source test environment to the target
test environment.

Oracle Tuxedo Application Runtime for CICS and Batch components are used to integrate the
converted assets after testing and integration preparation on the target test environment. The
COBOL programs, JCL and associated components are integrated with the UNIX, Oracle
database and Tuxedo transaction environments. These components are tested to work with the
batch and CICS components produced during the conversion process.

Oracle Tuxedo Application Rehosting Workbench Users Guide 1-1
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Figure 1-3 Data Migration

asspts

PRODUCTION | INTEGRATION TEST
Prepare
SOURCE Tests
Generate
assefs -
Convert data
Switchove
TARGET Integrate

The assets to be migrated are generated and moved to the source test machine. The migrated
assets are then converted and moved to atarget test machine containing an Oracle database. After
testing, the datais moved to an integration environment where rehosting tools are integrated with
the programs to test their quality and performance using the converted data. When switchover
occurs the latest datais converted directly from the source production environment to the target

production environment.
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Figure 1-4 Migration Architecture
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Prerequisites

Platform
Linux32/Linux64

Software Environment

JRE 1.6.0 or higher

Eclipse IDE for Java Developers Galileo (3.5) or higher

Perl version 5.8.8 or higher

Skills

The following skills are required.

Prerequisites
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http://www.eclipse.org/downloads/packages/eclipse-ide-java-developers/galileosr2

Oracle Tuxedo Application Rehosting Workbench Users Guide

e Migration Process and Concepts

You must understand the processes, concepts and terminology used by the Rehosting
Workbench Cataloger (i.e., know the inputs, outputs and configuration expected by the
Cataloger and how it analyzes all the components separately and together to determine
whether the asset is consistent and can be migrated).

e Eclipse Skills

Eclipse skills are required to perform certain actions accompanying the migration process.
You must know:

— View, Navigator, Perspective etc.

— A set of operations to open new project wizard, open project properties page and open
view.

— If you are testing the plug-in, you must do the following:
» Remove the workspace.

* Run Eclipseusing the "-clean" option.

Installing the Plug-in

Toinstal the plug-in you must copy the com.oracle. tuxedo.wbplugin x.x.x.x.jar file
(located inutils/eclipse_plugin sub-directory under the Tuxedo ART Workbench
installation directory) to the sECLIPSE_HOME/plugins directory and then restart Eclipse.

Note:  You can only use one version of plug-in at one time; you must remove all the previous
plug-in versions before installing a new version.

However, when you update version, the new plug-in may not take affect after restarting
Eclipse. Use the -clean option as command line arguments when starting Eclipseto force
Eclipseto reinitialize these caches.

Component and Layout

1-10

The plug-in has an Tuxedo ART Workbench Perspective which organizes Tuxedo ART
Workbench views, menus and toolbars around the eclipse. It also has a navigator made for
Tuxedo ART Workbench projects.

The plug-in has Catal oger Report View and Process Monitor View to help you analyze the
migration process.

e Tuxedo ART Workbench Perspective

Oracle Tuxedo Application Rehosting Workbench Users Guide



Component and Layout

Tuxedo ART Workbench Navigator

Migration Process Cheat Sheet

Eclipse Preferences

e Menu Items and Tasks

Tuxedo ART Workbench Perspective
In the Eclipse Platform a Perspective determines the visible actions and views within a window.
The Tuxedo ART Workbench Perspective is made up of the following views:

e Workbench Navigator

e General Navigator

e Problems

e Report

e Progress Monitor

From the Tuxedo ART Workbench Perspective, Tuxedo ART Workbench specific
actions/’commands are also shown as menu items and toolbar buttons.

Tuxedo ART Workbench Navigator

The Tuxedo ART Workbench Navigator isvery similar totheinternal Eclipse General Navigator.
The differenceis that Tuxedo ART Workbench Navigator only displays ART Projects.

Cataloger Report View

The cataloger output reports are shown in the report view (as shown in Figure 1-5), with tabs for
each report. The view isintegrated with ART perspective. Click the Close button to close it or
re-open it from main menu.

Oracle Tuxedo Application Rehosting Workbench Users Guide 1-1
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Figure 1-5 Report View Example
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The report view has following features:
e Sort
The report contents are organized in atable. You can sort by clicking on the table heading.

e Colored Warning
The anomaly level of each report is colored by level.

Table 1-3 Color Warning

Anomaly Level Color
OK Green
WARING Yellow
ERROR Red
FATAL Red

o Refresh

The content of report refreshes automatically after the convert operation or create new
project operation.

You can aso refresh the content by clicking the Refresh button on the menu bar of report
view.

1-12 Oracle Tuxedo Application Rehosting Workbench Users Guide



Component and Layout

Progress Monitor View

The progress monitor view allows you to see which source file or schemais being processed. A
sourcetreeisinitially displayed to show the structure of sources or schemasin the current project
organized by source types as shown in Figure 1-6.

Along with the Cataloging, JCL conversion and COBOL conversion processes, the current
processing source file is highlighted in the source tree.

For DB conversion and File conversion, the current processing db schema or file schemais
highlighted in the schemalist.

Figure 1-6 Sample of Progress Monitor View

=] Progress Monitor Z2
< [&] STDB2ORA

b [& JCL files
I [Z] COBOL Batch
P> & coBoL cics
P [&% BMS Maps
~

%) DB Schemas

Migration Process Cheat Sheet

The Plug-in has a Migration Process Cheat Sheet to guide you though the conversion tasks
step-by-step. To open the cheat sheet click “Help->Cheat Sheets” on main menu, and then select
the cheat sheet Create ART migration project for STDB20RA sample under ART group.

Thischeat sheet demonstrates how to perform Mainframe artifacts migration by using the Tuxedo
ART Workbench Eclipse Plug-in. After ART project creation, all Tuxedo ART Workbench
functions (including cataloging, converting VSAM files, converting DB2 schemas, converting
COBOL and JCL sources), can be done in Eclipse.

Oracle Tuxedo Application Rehosting Workbench Users Guide 1-13
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Eclipse Preferences

Some Tuxedo ART Workbench global options are set in the Eclipse Preference page. Include
following:

Workbench Installation Directory
This global preference will take effect to all ART projects by default.

Menu Items and Tasks

The section provides a genera overview of menu items and their associated tasks.

For amore detailed menu item example, see Appendix B: Appendix C: Oracle Tuxedo
Application Rehosting Workbench Logs

e |mport
e Prepare
e Analyze

Convert

Configure

Build

e Deploy
e Run

o Reset
Figure 1-7 provides an Tuxedo ART Workbench high-level workflow illustration.
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Figure 1-7 Tuxedo ART Workbench High-Level Workflow
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Import

The process of copying assets into a ART project. User can specify which sub-directory to be
imported by using import wizard. These raw files are unchanged in the whole process of the

migration.

Prepare

Preparation requires the migration assets are collected and pre-processed for further conversion.
It includes the process of updating the format of the original assets, such asfile trancoding,
remove unrecognized character and file renaming.

Preparation tasks are listed in Table 1-4.
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Table 1-4 Preparation Tasks

Task

Description

Source Assets

Output

Execute custom script

Special task customized by

User specified scope.

Custom scripts are executed

before prepare steps user can be executed before before preparation.
preparation process.

MBCS code page Convert the multiple-byte All All files are converted into

conversions charactersin EBCDIC ASCII-based encodings.
encoding to multiple-byte
charactersin ASCII-based
encodings.

dos2unix conversion  Convert filesfrom DOS All All Windows returns are
format (using OXODOA as replaced by UNIX returns.
newline) to UNIX format
(using OX0A as newline).

Rename sourcefile Change file name (exclude All All files are UPPER CASE

name to UPPER
CASE

extension) to UPPER CASE.

named with lower case
postfix.

Execute custom script
after prepare steps

Special task customized by
user can be executed after
preparation process.

User specified scope

Custom scripts are executed
after preparation.

Analyze

Populate the source assets and generate analyze reports.
Analysistasks arelisted in Table 1-5.

Table 1-5 Analysis Tasks

Task

Description

Source assets

Outputs

Configure scope

The detailed configuration
items are showed in wizard.

all

Assets description file
(named system.desc)

1-16
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Table 1-5 Analysis Tasks

Component and Layout

Task Description Source assets Outputs
Convert COBOL Convert COBOL and COPY  COBOL/COPY Free format files, and ".orig"
format. BOOKS into free format. BOOKS files
Catalog the source All the source assets defined  all POB repository Reports
assets in file system.desc will be
catal oged.
Convert

Convert phase supportsincremental conversion for COBOL conversion and JCL conversion, the
incremental conversion isbased on thetimestamp of a POB file and the corresponding target file,
conversion for a POB file is only done when its timestamp is newer than corresponding target
file. However, Convert phase doesn't support incremental conversion for RDBMS and FILE
conversion because of the difference of underlying mechanism between them.

Conversionstasks are listed in Table 1-6.

Tahle 1-6 Conversation Tasks

Task Description Source assets Outputs

Convert File Generate the components Datamap.re and Unloading and reloading

Definitions used to migrate zZ/OSfiles. mapper.re programs.

Convert DB Schema  Generate the components POB repository. Translated DDL scripts.
used to migrate ZZOS DB2 Unloading and reloading
databases. programs.

Convert COBOL Convert COBOL programs POB repository. Translated COBOL

Components from z/OS COBOL to Micro programs.

Focus COBOL or
COBOL-IT.

Convert JCL Trandates z/OS JCL files POB repository. Korn shell programs.

Components into Unix/Linux shell scripts
using the Korn shell syntax.

Convert CICS CSD Convert RDO to resource RDO files Translated RDO files.

description.
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Note:

"Convert File Definitions" also include "buffer converter" and "reverse converter”. By

default, those two converters are disabled; they can be enabled in project properties page.

Configure

In this step, the default build scripts, tuxedo configurefile, CICS and Batch runtime environment
configure file are generated. It can be customized with user specified option through wizards
under configure menu.

Configuration tasks are listed in Table 1-7.

Table 1-7 Configuration Tasks

Task

Description

Configurable Options

Output

Configure build
settings

Generate makefiles for each

target components directory

and aroot makefile.

Databases options. COBOL
compiler options. ART CICS
pre-processor option and so
on.

M akefilesunder target
directory.

Configure tuxedo
domain

Generate ubbconfig template

IPC KEY, Machine Name

and other ubb configurations.

ubbconfig.em
ubbconfig.null
ubbconfig.tsam

Configure CICS
runtime

Generate ubbconfig and
setenv file for CICS runtime

CICS Runtime location and
Monitor settings and so on.

ubbconfig, setenv and
other filesin
configure/CICS_RT
directory

Configure Batch
Runtime

Generate ubbconfig and
setenv file for Batch runtime

Batch Runtime location,
JESROQT and Monitor
settings and so on.

ubbconfig, setenv and
other filesin
configure/BATCH
_RT directory

Configure IMS
Runtime

Generate ubbconfig and
setenv file for IMS runtime

IMS Runtime location,
Monitor settings and so on

ubbconfig, setenv and
other filesin
configure/IMS_RT
directory

Note: Currently, only the connection to Oracle Database as a client is supported. The
connection string is"sqlplus user/password@connect_identifier".
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Build

Component and Layout

In this step, database schemawill be created; application components, data reloading programs,
data access programs, tuxedo configuration file will be compiled.

Build tasks are listed in Table 1-8.

Table 1-8 Tasks

Task Description Outputs

Create database schema In case of using database, Tables and other database
database schemawill be objects will be created in the
created in this step. target database.

Build application COBOL sourcefiles(include Binary files under target

components Batch and CICS) and BMS  component directory.

files will be compiled.

Build datareloading
programs

Datarel oading programswill
be compiled.

Binary files under target
reload directory.

Build data access programs

Dataaccess programswill be
compiled.

Binary files under target
DML directory.

Build tuxedo configuration
file

Tuxedo configuration file
will be compiled.

Binary tuxedo configuration
file (named tuxconfig) under
deploy directory
(BATCH_RT/config/tux/
and CICS_RT/config/tux)

Deploy

The process of packing the converted asset and un-pack on the target platformif it isthe local

machine.

Deployment tasks are listed in Table 1-9.
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Table 1-9 Deployment Tasks

Task

Description

Outputs

Pack target

Including all of the converted
files, generated makefiles,
KIX resource files and
ARTJES configuration file.

Tar filesin pack directory.

Deploy application

Untar the package under the
specified directory.

Filesin deploy directory.

Setup runtime Createnecessary components  Filesin sub-directories
for runtime, more IMS_RT, BATCH_RT, and
specifically, createrequired  CICS_RT under deploy
directories, create TLOG, directory.
create /Q for JES, IMS, etc.

Reload file data Reload file datainto Filesin location where user
specified directory. specified in the wizard.

Reload DB2 data Reload db2 datainto Oracle  Datain Oracle database.
database.

Run

The process of running the converted application on the target platform for testing. Missing "Run
tasks are listed in Table 1-10.
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Table 1-10 Run Tasks

Component and Layout

Task

Start/Stop CICS Runtime

Description Outputs

Set environment for CICS ART CICSRuntime. Domain
Runtime. starts/stopped.
Start/shutdown the Tuxedo

domain configured for CICS

Runtime.

Start/Stop Batch Runtime,
Manipulate Jobs

Set environment for Batch ART Batch Runtime.
Runtime. Domain starts/stopped. Job

Start/shutdown the Tuxedo properties arelisted
domain configured for Batch
Runtime.

Submit/cancel/hol d/rel ease/p
urge/restart jobs, view job
log, etc.

Start/Stop IMS Runtime

Set environment for IMS ART IMS Runtime. Domain
Runtime. starts/stopped.

Start/shutdown the Tuxedo
domain configured for IMS
Runtime.

Reset
Roll back the specified steps.

Table 1-11 Reset Tasks

Reset tasks are listed in Table 1-11.

Task Description

Clean Import Undo the process "Import". All the filesin
$project/imported directory will be removed.

Clean Prepare Undo the process "Prepare”. All thefilesin
$project/prepared directory will be removed.

Clean Source Undo the process "Analyze". All thefilesin

$project/source directory will be removed.
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Table 1-11 Reset Tasks

Task Description

Clean POB Repository Clean all the pob filesin $project/source
directory.

Clean Target Undo the process "Convert". The output of

converting steps will be removed.

Clean Configuration Undo the process "configure". ubbconfig,
setenv and other configuration files will be
removed.

Clean Build Binaries Undo the process "build". The output of

building steps will be removed.

Clean All Undo al of the above process. Remove all the
files except filesin $project/param and
$project/scripts.

Detailed Rehosting Methodology
Creating an ART Project
Configuring Project Properties

Creating an ART Project

Y ou must create anew ART Project though New Project Wizard. Do the following:

1. Select awizard as shown in Figure 1-8.
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Figure 1-8 Select a Wizard

- New Project 3

Select a wizard

Create a new Tuxedo ART project [

Wizards:

| type filter text

b = General
¥ = ART

b = CVS
b = Java

b = Plug-in Development

b (= Team Logical Model Example

@ < Back

Cancel Finish

2. Designate the project name as shown in Figure 1-9.

Figure 1-9 Project Name

£ ART Project Wizard
Create an ART Project

Enter a project name.

Project name: IDBZORA

Use default location

Location: Iftestarea,flipengfworkspace,fDBzORA Browse... |

@ < Back I Next = I Cancel | Finish |

3. Specify the Tuxedo ART Workbench install directory as show in Figure 1-10.
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Figure 1-10 Select the Workbench install Directory.

]

Gelect he ART Workbench imabsll Tolder
werkBench eaiall Dirsctony [essreafpergniacie sl wel 2110 Diavwie.
= Back Mt = Cancel

4. Spectify the root directory which contains source files as shown in Figure 1-11.

Figure 1-11 Specify Root Directory Source Files

Mk O Ry

Seden the applaariten auice wifaos folder

dpphcrion Source Foider | teaarealeengeemple s STOBIORA 0N ;nlunu I

‘) = Pack et | coascar | Fireh |

5. Specify taarget database and COBOL compiler shown in Figure 1-12.

Figure 1-12 Choose Database and Compiler
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Configuring Project Properties

After creating anew ART project, you must configure the project propertiesin the project
properties page as shown in Figure 1-13.

Figure 1-13 Project Properties Page

=

b Resource

= ART Workbench

Cataloger
P COBOL Converter
DB2 Converter

File Converter

¢ Global

b JCL Converter
Builders
Project References

Run/Debug Settings

P Task Repository

Task Tags

b validation

WikiText

|1 E—T— D)

@)

Properties for STDB2ZORA

Global

General |COBOL | |CL |SQL

[rwan

Minimum Free RAM Percent [20

Default Sequential Mode

[] Use File Catalog

) Record () Line

[ Enable Buffer Converter [] Enable Reyerse Converter

Restore Defaults Apply

Most of the configurable optionsin Tuxedo ART Workbench can be configured in the project
properties pages. It provides an easy way for to view and modify Tuxedo ART Workbench
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configuration options. Those options are organized by type. For more information, see
"Description of Configuration Files' in the Tuxedo ART Workbench Reference Guide.

Import

This section provides information how to use the Eclipse plug-in import wizard.

All the sub-directories of the directory which you specified while creating project will be showed
in first column of table; you can click second column to import or not import related
sub-directory; the last column isthe status of importing, it will display "Y es" if this sub-directory
has be imported before, otherwise it display "No".

If users have done the analyze and/or convert phases for imported source files, and then re-run
the import wizard to import new source files or new sub-directories containing sourcefiles, only
the later imported source files will be processed in analyze phase, that isincremental processing,
unless users have to clean the output of analyze phase.

Prepare

This section provides information and instructions regarding how to use the Eclipse plug-in
preparation wizard.

Execute Custom Script Before Prepare Steps

A custom script is automatically executed by the interpreter before the preparation process; it is
called using the directory path as an argument.

If multiple directories are selected, the custom script is executed multiple times, using the
directory path as the argument each time.

The standard output and standard custom script execution errors are dumped to the logfile.

MBCS Code Page Conversion.
EBCDIC-based encoding is used on IBM mainframes. ASClI-based encoding is used on open
systems.

Y ou can use this utility to convert the multiple-byte charactersin EBCDIC encoding (e.g.,
IBM-1390) to multiple-byte characters on open system (e.g., Shift-J'S). The encoding names
used in ICU are the same as the ones used by iconv, which isacommon utility in UNIX/Linux,
SO you can retrieve encoding names easily by reading iconv online help.
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Tip:  Typecommand "uconv -1" inthe shel lists encoding names.

dos2unix Conversion

The newline marker isdifferent between DOS systems (using 0x0poa) and UNIX/Linux systems
(using 0x03).

Y ou can use this utility to convert text filesin DOS format to UNIX/Linux format.

Rename Source File Name to UPPER CASE

It provides a function to change file name (exclude extension) to upper case.

Execute Custom Script after prepare steps

It does the task similar with "Execute Custom Script before prepare steps'. The script in here
applies on source files which have already been processed by preparation tasks.

Analyze

This section aims to:

e Provide information and instructions about how to use Tuxedo ART Workbench
Cataloger.

e Help you to configure and run Tuxedo ART Workbench Cataloger tools.

e Show how to verify the results by interpreting messages and status information.
This guide includes information about the following:

e How to use Tuxedo ART Workbench Cataloger within the whole migration process.

e Best practices on how to prepare assets to be migrated, organize work spaces and
effectively use Tuxedo ART Workbench tools.

Note: These practices and methodologies are not part of Tuxedo ART Workbench product but
are presented in this guide to help new users. Y ou can proceed otherwise, customize
Tuxedo ART Workbench in your own way and develop your own methods.

The Tuxedo ART Workbench Cataloger is described in the following sections:
e Skills
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Requirements & Prerequisites

Overview of the Cataloger in the Replatforming Process

Cataloging Steps
e Using the Make Utility

e Clean POB Repository

Skills

Migration Process and Concepts

Y ou should understand the processes, concepts and terminology used by Tuxedo ART
Workbench Catal oger; know theinputs, outputs and configuration expected by the Catal oger and
how it analyzes all the components separately and together to determine whether the asset is
consistent and can be migrated.

The Tuxedo ART Workbench Reference Guide describes precisely al features of the Cataloger.
Read at least the three first sections of the Cataloger chapter for an introduction to the concepts,
terminology, inputs and outputs, and configuration.

UNIX/Linux Skills

UNIX/Linux skills are required to work correctly on the migration platform environment and
perform certain actions accompanying the catal oguing process. Y ou need to know:

e The standard Unix/Linux commands to create, modify, display and delete configuration
files and output files.

e The standard Unix/Linux commands and specialized scripts (shells, makefile, cvs) to store
and manage the original z/OS asset before and after catal oging.

e A set of commands (shell, makefile) to start, monitor and terminate the execution of
Tuxedo ART Workbench Cataloger.

z/0S Skills

Y ou should be able to identify and understand z/OS components and programming languages.
General skillsin zZ/OS environment (COBOL, files, DB2, CICS, JCL, utilities) are sufficient.
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Requirements & Prerequisites

Preparing the Migration Platform

The migration platform is the platform on which the Tuxedo ART Workbench migration tools
execute, including the Cataloger. Thisplatform isbased on Linux running on an Intel-compatible
hardware platform.

Before performing any action, Tuxedo ART Workbench should be installed and configured
according to specifications and requirements detailed in the Oracle Tuxedo Application
Rehosting Workbench Installation Guide.

Configure Scope

This section describes the usage of configure scope wizard. All theimported sub-directories will
be showed in first column of the table.Plug-in can detect sourcetypes automatically in some case,
therules are as follow.

1. (1) Plug-in only identifies the source type of each sub-directory with built-in file suffix.
* . cpy - COPYBOOK
* . cbl - COBOL Source Program, including CICS, Batch and Sub
*.jcl - JCL Script
*.bms, *.map - BMSMap
*.sql, *.ddl, *.db2 - SQL Scripts
*.sysin - SYSIN files
* . rdo - RDOfiles
* .proc, *incl - JCL libraries

2. Under each sub-folder of source, it'srecommended that there is only one kind of source files
with only one known suffix mentioned above, so that the analyze wizard can identify the
source type of each sub-directory, otherwise users may need to specify the directory type and
the suffix or suffix list of the source files for such sub-folders. The rule for source type
detection and the rule for specifying source suffix are described in following items.
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Suffix Type

* el JCL

* . bms, *.map BMS

*.ddl, *db2, *.sql SQL-Script

* . sysin JCL-Sysin

* proc CL-Lib(Proc)

*.incl JCL-Lib(Include)

* . cpy COBOL-Library

*.cbl COBOL-Batch, COBOL-TPR, COBOL-Sub, COBOL-IMS
* . rdo RDO

1-30

Whenever aknown suffix isfound, the analyze wizard stops searching and determines the source
type of the sub-directory as the type corresponding to the found suffix.

3.

The sourcetype of asub-directory will be determined by checking whether there arefileswith
one of the known suffix in following suffix order:

Whenever a known suffix is found, the analyze wizard stops searching and determines the
source type of the sub-directory as the type corresponding to the found suffix.

If asub-directory is given a source type by the analyze wizard based on the rule in item (3),
but end users know there are other source files of same type with different suffix, end users
need to specify alist of suffix in the analyze wizard. For example, end users can specify

"* ddl, *.sgl" to indicate to the analyze wizard that the source files with suffix "ddl™ or suffix
"sgl" are all SQL scripts.

If a sub-directory is given a source type by the analyze wizard, but end users know it's not
correct. That's, the naming convention of the source assets are not matching with the
pre-defined naming ruleby ART lifecycle. Inthiscase, end users need to specify correct type
for the sub-directory and specify which suffixes correspond to this type.

If asub-directory can't be given a source type because it doesn't contain any source fileswith
any one of known suffix, end users have to firstly specify the type of the sub-directory, then
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specify one or more suffix so that analyze wizard can identify which source files belong to
thistype.

Normally end users specify a suffix like "*.xxx", it worksin most cases. However, if some
source files expected to be processed actually don't have suffix, a special pattern, "NULL",
has to be used by end users to specify that there is not suffix. Besides, end users need to
specify the directory type. Then, source files without suffix will be renamed by adding a
suffix according to the specified source type.

User can enable or disable processing of each sub-directory by clicking the last column of
the table.

There are many options appeared while clicking "Advanced settings for sub-directory". To
make the clear meaning of each option, refer to "Cataloger" section in the Oracle Tuxedo
Application Rehosting Workbench Reference Guide

Overview of the Cataloger in the Replatforming Process

This section describes the inputs and outputs of the Catal oging step and dependencies with other
migration steps in the replatforming process.

Simple Sample Application

In order to illustrate all of the migration activities performed and how to use Tuxedo ART
Workbench Cataloger to determine whether the asset is consistent and can be migrated to the
target platform, the Simple Application strIr.EORA Will be used. sTFILEORA is provided with
Tuxedo ART Workbench set of tools.

Cataloging Migration Steps
Description of the catal oging operations shown in the graphic:

1
2.

Read the configuration files and the description of the source files prepared for cataloging

Parse each of the components in the source asset and create an internal representation called
packed object base (with extension .pob). Identify internal inconsistencies in these
components (e.g. syntax error or reference to an undeclared variable);

Compute cross-reference rel ationships between these components, such asaCALL statement
from a COBOL program to a COBOL sub-program;

Identify mutual inconsistenciesin these relationships, such asa CALL statement referencing
a sub-program missing from the asset, or an SQL table referenced by none of the COBOL
programsin the asset (unused component);
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5. Create CSV-format reports listing all the components in the asset, together with their status
(missing, unused or correct) and all the anomalies (inconsistencies) detected above.

The operations described above are explained in more detail in the next sections.
Cataloging Steps

Building-up an Asset

Thisstep isapre-requisite for the Catal oger and, as mentioned in the Oracle Tuxedo Application
Process Guide that gives an overview of the whole migration process, it is up to the user of

Tuxedo ART Workbench to gather these source files on the source platform, transfer themto the
migration platform, install them in an appropriate file structure and prepare them for migration.

Building up the asset consists of several steps from getting sources to organizing them to be
available asavalid input to the Catal oger tool:

1. Gathering sourcesto be migrated from z/OS
2. Transfer the sourcesto Tuxedo ART Workbench platform

3. Dispatch and prepare sources by types as they are expected by the Catal oguer

Organize components by type: put al CICS programsin one directory that could contain
sub-directories, the same applies for COBOL includes, Batch programs, Jobs, etc.

4. Some other actions may be required: such as clean components from certain characters or
lines added after the extraction from z/OS or during the transfer.

Initialization and Configuring the Working Environment

As Tuxedo ART Workbench Cataloger isthefirst tool of the Oracle Tuxedo Application
Workbench suite used in the migration process, ageneral configuration step for thewhole project
to be performed is explained here.

Configuration Objectives

e Reduce the time needed to prepare the working environment and avoid further possible
errors due to configuration.

e |nitialize the configuration for other WorkBench tools not only for the Catal oger.

e Recommend a standard organization to facilitate team work.
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Recommended File Structure

The more organized and standardized the working space, the more migration tasks will be easier
and automated.

Inthefollowing sample weillustrate atypica organization and we recommend working with the
same structure.

Listing 1-1 Sample Application Hierarchy

SampleApp

| -- Logs

| -- param

| ‘-- system.desc
| -- source

| ‘-- makefile
|-- trf

|-- tools

|-- tmp

The contents of each directory are:

e Source

Contains all sources to be migrated and prepared as input for Tuxedo ART Workbench
tools.

Workspace where all Tuxedo ART Workbench processes can find the source code.
e param

Contains all configuration files (parameters and hints for use by Tuxedo ART Workbench
toals).

e Logs

Working directory where all Tuxedo ART Workbench tools are launched, all log files are
generated
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e tools

Directory to place specific tools developed by the user during the migration process.
o trf

Directory where conversion results are generated.
e tmp

Directory where temporary and intermediate files generated during conversion operations
are placed.

Setting Environment and Working Variables

It is recommended that each time you work on a project using Tuxedo ART Workbench to set
certain environment variables that will be useful later. The only environment variable that is
mandatory is REFINEDISTRIB; others can be used for simplification reasons.

Table 1-12 explains the usage of proposed variables.

Table 1-12 Rehosting Workbench Environment Variables

Variable Value Usage

REFINEDISTRIB Linux64, or Linux32 Specifies the architecture of Tuxedo ART
Workbench binary files.

PROJECT $ {HOME} Project root within the workspace. HOME is
used for training. But value should be
something like /project/SampleApp

CVSROOT ${PROJECT}/CVS_DELIVRY CVSrepository to use containing the source
and configuration files.

LOGS ${PROJECT}/Logs Structurewhere Tuxedo ART Workbench logs
are stored

PARAM ${PROJECT} /param Directory where the parameter files are stored

SOURCE ${PROJECT} /source Structure where the sourcefilesto trandate are
stored

REFINEDIR /<InstallDir>/refine Root of Tuxedo ART Workbench binariesand
utilities

PHOENIX ${REFINEDIR} Variable used by Tuxedo ART Workbench
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Table 1-12 Rehosting Workbench Environment Variables

Variable Value Usage

TMPPROJECT ${PROJECT} / tmp Temporary structure for R4Z Tuxedo ART
Workbench

PATH ${PATH}:/platform/Tool PATH complement

S

In the Simple Application example project, we use a setting file named $PROJECT/.project that
contains all initializations using an export Linux command. Thisfileisto be executed each time
anew Linux session is opened to work in the project

Listing 1-2 Extract from Simple Application .project File:

echo "Welcome to SampleApp"

export GROUP=refine

export PROJECT=S${HOME} /SampleApp

export LOGS=${PROJECT}/Logs

export SOURCE=${PROJECT}/source

export PARAM=S${PROJECT} /param

export REFINEDIR=/product/art_wbllgRl/refine
export PHOENIX=${REFINEDIR}

export TMPPROJECT=${PROJECT} /tmp

export REFINEDISTRIB=Linux64

Project Initialization Summary
Toinitialize anew project, proceed as follow:

1. Create afile structure as described above.

2. Copy asampleof the configuration (system.desc, version.mk, options-catalog, etc.) filesfrom
Simple Application to $PROJECT /param directory to make any necessary modifications.
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3. Copy the makefile from the source (SimpleApp) into $PROJECT/source.

4. Createafile .project under sprogECT and initialize it with variables listed in Setting
Environment and Working Variables. Variablesin the file are to be exported each time you
work on the project.

5. Copy the prepared source files to $PROJECT/source
6. Optional: Manage the source and configuration files under CVS.

Configuration

Y ou need to set at |least two configuration files, additional configuration filesare described in the
advanced usage section.

The two configuration files needed by the Catal oger are:
e System description file
e General option file

System Description File
The system description file is the main configuration file for Tuxedo ART Workbench tools.

For the Simple Application example:
e The system-name is SampleApp
e The path where sources to be migrated are stored is . . /source

e To inform the Catal oger of the location of the global options file you can use relative or
absolute naming but it is recommended to use an absolute path when you have multiple
source environments to migrate.

global-options catalog = "../param/options-catalog.desc".

e Then add entries for each directory containing components to be catal ogued.

Listing 1-3 System Description for Simple Application

system SampleApp root "../source"
global-options

catalog="../param/options-catalog.desc",
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no-END-Xxx.

DBMS-VERSION="8".

Q

% Copies
directory "COPY"
% DDL

directory "DDL"

% Batch

directory "BATCH"

"INCLUDE" .
% Cics COBOL Tp
%

directory "CICS"
"INCLUDE" .

Detailed Rehosting Methodology

type COBOL-Library files "*.cpy".

type SQL-SCRIPT files "*.ddl".

type COBOL-Batch files "*.cbl" libraries "COPY". %,

type COBOL-TPR files "*.cbl" libraries "COPY". %,

Global Options

The purpose of the Cataloger optionsfileisto give the Cataloger additional information that will

influence its behavior.

Inthe Simple Application examplewe use only three options, of course other options can be used;
see the Tuxedo ART Workbench Reference Guide for afull list of options.

Listing 1-4 Global Options File for the Simple Application

%% Options for cataloging the system

job-card-optional.
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Executing the Cataloger
One Operation
Y ou can launch the Catal oging with one command; all operations are performed sequentially.
The example command line syntax is:
${REFINEDIR} /refine r4z-catalog -s $PARAM/system.desc
Where:
e ${REFINEDIR} iSthe directory where Tuxedo ART Workbench tools are installed.
e $(caTALOG) isthe version of the Cataloger to be used
e s (sysTeM) isthe path of the system description file.
In our sample the command will be;
From directory $1.0Gs/catalog execute the command:

S{REFINEDIR}/refine r4z-catalog -s $PARAM/system.desc

The execution log is printed on the screen and at the sameis redirected in log file under the
directory from which you lunched the command.

Step by Step

Parsing

Running this step is useful when you want to check specific programs without waiting for the
whole cataloging to see the results.

Listing 1-5 Parsing Examples

# parse only one program

S{REFINEDIR}/refine rdz-preparse-files -s $SPARAM/system.desc
CICS/PGMM000.cbl

# parse a list of programs

# build a list that contains programs with path from source
(CICS/PGMMO00.cbl)
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${REFINEDIR} /refine rdz-preparse-files -s $PARAM/system.desc -f
list-of-file

Analysis

Theresult of this step isthe binary file named symtab-Sampleapp . pob that represents
inter-component information.

Listing 1-6 Analysis Example

cd SLOGDIR/catalog

S{REFINEDIR}/refine rdz-analyze -s S$SPARAM/system.desc

Print Reports
In this step information stored in binary filesis collected and printed in CSV format reports.

Listing 1-7 Print Reports Example

cd SLOGDIR/catalog

SREFINEDIR/refine rdz-fast-final -v M2_L3_3 -s $SPARAM/system.desc

In the Simple Application reports are generated in $PROJECT/source/Reports-SampleApp:
® report-SAMPLEAPP-Anomalies

® report-SAMPLEAPP-COBOL-Copy

® report-SAMPLEAPP-COBOL-Programs

® report-SAMPLEAPP-JCL-Files

® report-SAMPLEAPP-JCL-Jobs

® report-SAMPLEAPP-JCL-Sub-Files

® report-SAMPLEAPP-SQL-Tables
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® report-SAMPLEAPP-SQL-Views

® report-SAMPLEAPP-Transactions

The different reports are described in the Oracle Tuxedo Application Rehosting Workbench
Reference guide.

Result Analysis and Validation

Using the cataloging reports, you can perform different actionsin order to create the exact asset
set to be migrated and launch Tuxedo ART Workbench steps: COBOL conversion, JCL
translation and Data conversion.

Note: Thisdoes not mean that catal oging and conversion activities are strictly sequential, they
may overlap.

Inventory
After cataloging each Program, Copy, Job, Include is given a status depending on its use.

Table 1-13 Inventory Status

Status Description

CORRECT Components are present in source and used:
e Copybooks used at least by one program,

e Programsused at |east by onetransaction, by at least onejcl or by at
least one program

e All jobs are considered as used.
e JCL sub-file use at least by one Job.
Action: Accept it
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Table 1-13 Inventory Status

Status Description

UNUSED Component present is source but not used:
»  Copybooks that are not called by a program

* Programsthat are not called by atransaction, or by aJob and that are
not called as a sub-program by a program,

e JCL sub-filesthat are not used by a Job
Action: Decide whether to keep the component or to delete it from asset

MISSING Component is not present in the asset but at least onereferenceto it has
been found:

e Copybooks used at least by one program,

* Programsused at least by one transaction, by at least one JCL or by
at least one program.

* JCL sub-filesused by at least one Job

Action: Decide whether to add missing components or delete calling
components that could be unused or unnecessary.

Anomaly Analysis
All the errors reported in the Anomalies Report must be analyzed:

e FATAL and ERROR severity level anomalies make the component or asset unsuitable for
conversion, they must be analyzed and fixed.

e NOTICE and WARNING severity level anomalies should also be analyzed and they can be
kept if there is no impact on the conversion.

The asset should be free from severe errors before proceeding to conversion.

Completion Criteria

Cataloging can be considered complete once all expected outputs are generated (pob files and
cataloging reports).

Asaprocess, it depends on the context of the project, but generally cataloguing is considered as
completed when:

e All Unused and Missing components are either fixed or justified.

e All errors are fixed or justified.
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Using the Make Utility

make isaUNIX utility intended to automate and optimize the construction of targets (files or
actions).

Wehighly recommend using make to perform the different operationsthat compose the migration
process because this enables you to:

e Have all (executable) processes documented.
e Effectively manage incremental operations and hence save time.

e Control and check the results of processes.

Y ou should have adescriptor file namedmake£i1e inthe sourcedirectory in which all operations
are implemented (a makefile is prepared in the source directory during the initialization of a
project).

The following two sections describe the make configuration and how to use the Catal oger
functions through make.

Make Configuration

Version.mk

The version.mk configuration filein $PARAM is used to set the variables and parameters
required by the make utility.

In thisfile specify where each type of component isinstalled and their extensions, and the
versions of the different tools to be used. Thisfile also describes how the log files are organized.

Listing 1-8 Extract From version.mk for Simple Application

Root = S${PROJECT}

#

# Define directory Project
#

Find Jcl = JCL

Find_Prg = BATCH

Find Tpr = CICS
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Find_Spg
Find_Map = MAP

SCHEMAS = AV

#Logs organisation

#

LOGDIR := $(LOGS)

CATALDIR := $(LOGS) /catalog
PARSEDIR := $(LOGS) /parse
TRADJCLDIR := $(LOGS) /trans-jcl
TRADDIR := $(LOGS) /trans-cbl
DATADIR := $(LOGS) /data
MakeFile

The contents of the makefile summarize the tasks to be performed:
e Including vesion.mk
e Controlling if the main variables are set
e Collecting the value of variables and building the required lists to process.

e Implementing the targets.
The makefile provided with the Simple Application is auto-documented.

Parsing

Parsing All Programs
From the $source directory execute the command:

> make pob

Thelog fileisgenerated in $1.0GS/parse
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Check Need to Be Parsed

> make pob VERIF=TRUE

Check: Parse of BATCH/PGMMBO02.cbl Need Process.. To obtain
BATCH/pob/PGMMB02.cbl.pob

Parsing of One Program
Sample: parsing the program BATCH/ PGMMBO?2 . cbl

> make BATCH/pob/PGMMBO02.cbl.pob

Thelog fileisgenerated in sL.oGs/parse

Cataloging
To launch cataloging use:

make catalog

Thelog fileis generated in $1.0Gs/catalog

Advanced Usage of Make
To Add or Update a Target
Y ou can update the makefile to add some targets or to update existing ones.

For example, if you developed you own script (report . sh) to generate a customized report
based on basic cataloguing reports, place your script in sTooLs directory.

The makefile can be modified as follow:

e To add a new target to execute the new script:
Reporting:
@${TOOLS} /report.sh

e To update existing catalog target
catalog:

@$ (REAL_CMD) S${REFINEDIR}/refine r4z-catalog -v $(CATALOG) -s
S (SYSTEM) $ (LOG_FILE_FLAGS_CAT)

@make reporting

Your customized report will be updated automatically after each catal og execution.
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Debugging the Make Target
Sometimes a command through make cannot work properly because of alack of configuration.

Proceed asfollow:
1. Copy the used makefile to debug copy (makfile.debug), to not disturb current operations.
2. Modify makefile.debug changing rea1r,_cvp to COMMENT

catalog:

@$ (COMMENT) S${REFINEDIR}/refine r4z-catalog -v $(CATALOG) -s
$(SYSTEM) $ (LOG_FILE_FLAGS_CAT)

Using the Command with Option VERIF=TRUE

> make catalog VERIF=TRUE -f makefile.debug

The command to be executed is printed = after replacement of al variables.
Clean POB Repository
Convert

e File-to-File Migration Process

e The File-to-Oracle Migration Process

e The File-To-Db2/luw (UDB) Migration Process
e The DB2-to-Oracle Migration Process

File-to-File Migration Process
Migrating data filesis described in the following sections:

e File Organization
e |nitializing the Process
e Preparing the Environment

e Generating the Components
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File Organization
When migrating from a z/OS source platform to atarget platform, the first question to ask, when
vsAM is concerned, is whether to keep afile or migrate the datato an Oracle table.

The Tuxedo ART Workbench File-to-File converter is used for those files that keep their source
platform format (sequential, relative or indexed files) on the target platform. On the target
platform, these files use atarget COBOL (Micro Focus COBOL/COBOL-IT) file organization
equivalent to the one on the source platform.

Table 1-14 lists the file organizations handled by z/OS and indicates the organi zation proposed
on the target platform:

Table 1-14 z/0S to UNIX File Organizations

2/0S Source File UNIX ISAM Target File
QSAM Line sequential ISAM
VSAM KSDS Indexed ISAM
VSAM RRDS Relative ISAM
VSAM ESDS Line sequentia ISAM

Note: Theconversion of ZZOSfilesto ISAM UNIX fileshasno direct link to the conversion of
COBOL application programs or the translation of JCL.

PDS File Organization

Filesthat are part of a PDS are identified as such by their physical file name, for example:
METAWOO.NIV1.ESSAI(FIC).

An unloading JCL adapted to PDS is generated in this case. The source and target file
organizations as indicated in the above table are applied.

GDG File Organization

Generation Data Group (GDG) files are handled specially by the unloading and reloading
componentsin order to maintain their specificity (number of GDG archivesto unload and rel oad).
They are subsequently managed as generation filesby Oracle Tuxedo A pplication Runtime Batch
(for moreinformation, seethe Oracle Tuxedo Application Runtime Batch Reference Guide). On
the target platform these files have a LINE SEQUENTIAL organization.
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Migration Process Steps

The principle steps in the File-to-File migration process, explained in detail in the rest of this
chapter, are:

Create an overal list of the files to be migrated.

List those files that will not be converted to Oracle tables.

For each of thesefiles, create afile description.

When necessary, create alist of discrimination rules.

Prepare the environment to be used to generate the components.

Using Tuxedo ART Workbench generate the components used in the following steps.
Unload the data from the source platform.

Transfer the data to the target platform.

© ©®© N o 0o &~ w N PR

Transcode and reload the data.

10. Check the results.

Initializing the Process
This section describes the steps to be performed before starting the file migration.

Requirements

The migration of zZ/OS filesto UNIX/Linux is dependant on the results of the Tuxedo ART
Workbench Cataloger (for more information, see Analyze). It does not have any impact on the
conversion of COBOL components or the translation of JCL components.

Listing the Files to Be Migrated
Thefirst task isto list al of the filesto be migrated, for example, the permanent files input to
processing units that do not come from an Oracle table.

File Descriptions and Managing Files With the Same Structure

For each candidate file for migration, its structure should be described in COBOL format. This
description isused in a COBOL copy by the Tuxedo ART Workbench COBOL converter,
subject to the limitations described in COBOL Description.

Oracle Tuxedo Application Rehosting Workbench Users Guide 1-41



Oracle Tuxedo Application Rehosting Workbench Users Guide

1-48

Once built, the list of filesto migrate can be purged of files with the same structure in order to
savework when migrating the files by limiting the number of programs required to transcode and
reload data.

Using the purged list of files, alast task consists of building the files:
® Datamap-<datamap name>.re

® mapper-<mapper name>.re

Note: Thepopulate.sh utility (located in REFINEDIR/scripts/file/populate.sh), can
be used to help generate these two configuration files automatically. For more
information, See REFINEDIR/scripts/file/README. txt.

COBOL Description

A COBOL description is related to each file and considered as the representative COBOL
description used within the application programs. This description can be a complex COBOL
structure using all COBOL data types, including the OCCURS and REDEFINES nations.

This COBOL description will often be more devel oped than the COBOL file description (FD).
For example, an FD field can be described as a PIC X (364) but really contain athree times
defined areaincluding, in one case a COM P-3 based numerals table, and in another case a
complex description of several characters/digits fields etc.

It isthis developed COBOL description which describes the application reality and thereforeis
used as a base to migrate a specific physical file.

The quality of the file processing execution depends on the quality of this COBOL description.

From this point, the COBOL description is not separable from the file and when referring to the
file concerned, we mean both the file and its representative COBOL description. The description
must be provided in COBOL format, in afile with the following name;

<COPY name>.cpy

Note: If acopy book on the source platform provides a detailed description of thefile, the copy
can be directly used and declared in Tuxedo ART Workbench .

COBOL Description Format
The format of the COBOL description must conform to the following rules:

e Only onelevel 01.
e Theword FILLER isnot allowed.

e Fields names must be unique.
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e Somewords arereserved. A list issupplied in the Appendix of the Tuxedo ART
Workbench Reference Guide.

e The description should begin in column 1 without any preceding COBOL sequence
numbers.

e Comments may beinserted by placing an * in column 1.

e Field level numbers can start from column 2.

Example

Column

123 456178 911111111 11222222
012 3 45678 90123 435

*DESCRI PT

o
P4
o
M
M
—
m
X
X
X
X

0 5 FVvi14x1 P I C X

COBOL Description and Related Discrimination Rules

Within aCOBOL description there are several different waysto describe the same memory field,
which means to store objects with different structures and descriptions at the same place.

As the same memory field can contain objects with different descriptions, to be able to read the
file, we need a mechanism to determine the description to use in order to interpret correctly this
data area.

We need arule which, according to some criteria, generally the content of one or more fields of
the record, will enable us to determine (discriminate) the description to use for reading the
re-defined area.

In Tuxedo ART Workbench thisruleis called a discrimination rule.

Any redefinition inside a COBOL description lacking discrimination rules presents a major risk
during the file transcoding. Therefore, any non-equivalent redefined field requests a
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discrimination rule. On the other hand, any equivalent redefinition (called technical redefinition)
must be subject to a cleansing within the COBOL description (see the example below).

The discrimination rules must be presented per file and highlight the differences and
discriminated areas. Regarding thefiles, it isimpossible to reference afield external to thefile
description.

The following description is a sample of a COPY as expected by Tuxedo ART Workbench :

Listing 1-9 COBOL COPY Sample

01 FV14.

05 FV14-X1 PIC X.

05 FV14-X2 PIC XXX.

05 FV14-X3.
10 FV14-MTMGFA PIC 9(2).
10 FV14-NMASMG PIC X(2).
10 FV14-FILLER PIC X(12).
10 FV14-COINFA PIC 9(6)V99.

05 FV14-X4 REDEFINES FV14-X3.

10 FV14-MTMGFA PIC 9(6)V99.
10 FV14-FILLER PIC X(4).

10 FV14-IRETCA PIC X(01).
10 FV14-FILLER PIC X(2).

10 FV14-ZNCERT.

15 FV14-ZNALEA COMP-2.
15 FV14-NOSCP1 COMP-2.
15 FV14-NOSEC2 COMP-2.
15 FV14-NOCERT PIC 9(4)COMP-3.

15 FV14-FILLERPIC X (16).

05 FV14-X5 REDEFINES FV14-X3.
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10 FV14-FIL1 PIC X(16).

10 FV14-MNT1 PIC S9(6)V99.

05 FV14-X6 REDEFINES FV14-X3.
10 FV14-FIL3 PIC X(16).
10 FV14-MNT3 PIC S9(6).
10 FV14-FIL4 PIC X(2).

The discrimination rules are written in the following format:

Listing 1-10 COBOL COPY Discrimination Rules

Field FV14-X3

Rule if FV14-X1 = “A” then FV14-X3
elseif FV14-X1 = “B” then FV14-X4
elseif FV14-X1 = “C” then FV14-X5
else FV14-X6

Note: Inthe COBOL description, thefield FVV14-X3 must bethefirst field to be redefined. The
order of subsequent fields: FV14-X4, FV14-X5 and FV 14-X6 is not important.

The copy name of the COBOL description is: <COPY name>.cpy

Redefinition Examples
Non-Equivalent Redefinition

Listing 1-11 Non-equivalent Redefinition Example

01 FV15.
05 FV15-MTMGFA PIC 9(2).

05 FV15-ZNPCP3.
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10 FV15-NMASMG PIC X(2).
10 FV15-FILLER PIC X(12).
10 FV15-COINFA PIC 9(6)V99.

05 FV15-ZNB2T REDEFINES FV15-ZNPCP3.

10 FV15-MTMGFA PIC 9(4)V99.
10 FV15-FILLER PIC X(4).

10 FV15-IRETCA PIC X(01).
10 FV15-FILLER PIC X(2).

10 FV15-ZNCERT

15 FV15-ZNALEA COMP-2.

15 FV15-NOSCP1 COMP-2.

15 FV15-NOSEC2 COMP-2.

15 FV15-NOCERT PIC 9(4) COMP-3.
15 FV15-FILLER PIC X(16).

In the above example, two fields (FV15-ZNPCP3 and FV15-ZNB2T) have different structures:
an EBCDIC aphanumeric field in one case and afield composed of EBCDIC dataand COMP2,
COMP3 datain a second case.

The implementation of adiscrimination rule will be necessary to migrate the datato a UNIX
platform.

Listing 1-12 Related Discrimination Rules

Field FV15-ZNPCP3
Rule if FV15-MTMGFA = 12 then FV15-ZNPCP3

elseif FV15-MTMGFA = 08 and FV15-NMASMG = "KC" then FV15-ZNB2T
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Equivalent Redefinition Called Technical Redefinition

Listing 1-13 Technical Redefinition Initial Situation

01 FV1.

05 FV1-ZNPCP3.

10

10

10

10

10

10

10

10

10

FV1-MTMGFA

FV1-NMASMG

FV1-FILLER

FV1-COINFA

PIC 9(6)V99.
PIC X(25).
PIC X(12).

PIC 9(10).

FV2-COINFA REDEFINES FV1-COINFA.

15 FV2-ZNALEA

15 FV2-NOSCP1l

15 FV2- FILLER

FV15-MTMGFA

FV15-FILLER

FV15-IRETCA

FV15-FILLER

PIC 9(2).
PIC 9(4).
PIC
PIC
PIC X(4).
PIC X(01).

PIC X(2).

Listing 1-14 Technical Redefinition Potential Expected Results

01
05
10
10
10
10
10

FV1.

FV1-ZNPCP3.

FV1-MTMGFA
FV1-NMASMG
FV1-FILLER

FV1-COINFA

FV15-MTMGFA PIC 9(6)V99.

PIC 9(6)V99.

PIC X(25).
PIC X(12).
PIC 9(10).

01 FV1.

05 FV1-ZNPCP3.

10 FV1-MTMGFA PIC 9(6)V99.
10 FV1-NMASMG PIC X(25).
10 FV1-FILLER PIC X(12).
10 FV2-COINFA.

15 FV2-ZNALEA PIC 9(2).

Oracle Tuxedo Application Rehosting Workbench Users Guide



Oracle Tuxedo Application Rehosting Workbench Users Guide

10 FV15-FILLER PIC X(4). 15 FV2-NOSCP1l PIC 9(4).
10 FV15-IRETCA PIC X(01). 15 FV2- FILLER PIC X(4).
10 FV15-FILLER PIC X(2). 10 FV15-MTMGFA PIC 9(6)V99.

10 FV15-FILLER
10 FV15-IRETCA

10 FV15-FILLER

PIC X(4).
PIC X(01).

PIC X(2).

In the above example, the two descriptions correspond to a simple EBCDIC a phanumeric
character string (without binary, packed or signed numeric fields). thistype of structure does not

require the implementation of a discrimination rule.

Preparing the Environment

This section describes the tasks to perform before generating the components to be used to

migrate the data files.

Initializing Environment Variables

Before executing Tuxedo ART Workbench set the following environment variables:

® export TMPPROJECT=$HOME/tmp

— thelocation for storing temporary objects generated by the process.

You should regularly clean this directory.

® export PARAM=$HOME/param

— thelocation of the configuration files.

Implementing the Configuration Files

Three files need to be placed in Tuxedo ART Workbench file structure as described by:

e sparaM for:
— db-param.cfg,
e $pARAM/file for:
— Datamap-<configuration name>.re,

— mapper-<configuration name>.re.
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For aFile-to-File conversion you must create these files yourself.

Note: The Datamap and mapper configuration files must use the same configuration name.

Two other configuration files:

e file-templates.txt

® file-move-assignation.pgm

are automatically placed in the file structure during the installation of Tuxedo ART Workbench
. If specific versions of these files are required for particular Z/OS filesthey will be placed in the
$parAM/ file file structure.

Configuring the Files

The following examples show the configuration of three files; two QSAM files and one vsam
ksbs file. There are no discrimination rules to implement for these files.

Database Parameter File (db-param.cfg)

For the db-param.cfg file, the only parameter you may need to modify isthe target_os
parameter .

Listing 1-15 db-param.cfg Example

# This configuration file is used by FILE & RDBMS converter
# Lines beginning with "#" are ignored

# write information in lower case

# common parameters for FILE and RDBMS

# source information is written into system descriptor file (0S, DBMS=,
# DBMS-VERSION=)

target_rdbms_name:oracle

target_rdbms_version:11

target_os:unix

# optional parameter

target_cobol:cobol_mf

hexa-map-file:tr-hexa.map
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#

# specific parameters for FILE to RDBMS conversion
file:char_limit_until_varchar:29

# specific parameters for RDBMS conversion
rdbms:date_format:YYYY/MM/DD

rdbms: timestamp_format:YYYY/MM/DD HH24 MI SS
rdbms: time_format:HH24 MI SS

# rename object files

# the file param/rdbms/rename-objects-<schema>.txt is automatically loaded
# by the tool if it exists.

Mandatory Parameter

target_os:unix

Name of the target operating system.

Optional Parameter

target_cobol:cobol_mf
Name of the COBOL language. Accepted values are “cobol_mf” (default value) and
“cobol_it".

In this example, the language is Micro Focus COBOL.

hexa-map-file:tr-hexa.map
Specifiesamapping tablefile between EBCDIC (z2/OS code set) and ASCI I (Linux/UNIX
code set) hexadecimal values; if hexa-map-file isnot specified, awarning will be
logged.

Datamap Parameter File (Datamap-<configuration name>.re)
Each z/OS file to be migrated must be listed.

The following parameters must be set:
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Table 1-15 Datamap Parameters

Parameter Value in Example Set By
configuration FTFILOO1 Freely chosen by user.
name

(data map FTFILOOl-map)

system name PROJ001 Determined during cataloging in the

(system cat::PROJ001) System Description File.

file name PJO1DDD.DO.QSAM.KBCOI001 z/OS physical file name.

Organization Sequential Source organization

Note: The description of the different parameters used is provided in the Oracle Tuxedo
Application Workbench Reference Guide - File To File Convertor.

Inthe following example, the first two filesare QSAM files, the organization istherefore always
sequential. The PJ01AAA. SS.VSAM. CUSTOMER fileisavsam ksps file and the organization is
therefore indexed. The parameters, keys offset 1 bytes length 6 bytes primary,
describe the key. In this example, the key issix byteslong starting in position 1.

Listing 1-16 Example Datamap File: Datamap-FTFIL001.re

%% Lines beginning with "%%" are ignored

data map FTFILOOl-map system cat::PROJ0O01

%

oe

oo
oe

Datamap File PJ01DDD.DO.QSAM.KBCOIO0O1

%

oe

file PJ01DDD.DO.QSAM.KBCOIOO01

organization Sequential

%

o°

oo
o°

Datamap File PJ01DDD.DO.QSAM.KBCOI002

oo
oe
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file PJ01DDD.DO.QSAM.KBCOIO02

organization Sequential

oe
oe

oe

% Datamap File PJ01AAA.SS.VSAM.CUSTOMER

oe
oe

file PJO1AAA.SS.VSAM.CUSTOMER
organization Indexed

keys offset 1 bytes length 6 bytes primary

Mapping Parameter File (mapper-<configuration name>.re)
Each z/OSfile to be migrated, that is included in the Datamap configuration file, must be listed.

The following parameters must be set:

Table 1-16 Mapping Parameters

Parameter Value in Example Set By
configuration FTFILOO1 Identical to the name used in the
name (ufas mapper FTFILO01) datamap configuration file.
file name PJ01DDD.DO.QSAM.KBCOI001 Name used in the Datamap file.
include include During the generation, the string
"#VAR : RECS-SOURCE#/BCOACO1E  #VAR:RECS-SOURCE# Wwill be
.cpy" replaced by the directory namewhere
the copy files are located:
SPARAM/file/recs-source
The name of the copy file
BCOACO1E.cpy isfreely chosen by
the user when creating thefile.
map record map record REC-ENTREE REC-ENTREE correspondsto the
defined in level 01 field name in the copy file.
"#VAR :RECS-SOURCE#/BCOACO1E
.cpy"
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Table 1-16 Mapping Parameters

Parameter Value in Example Set By

logical name logical name FQSAMO1 Chosen by the user, maximum eight
characters. This nameis used for
naming the objects (COBOL, JCL)
created by the different toolsin
Tuxedo ART Workbench .

Note: Y ou cannot use hyphens (-)
inlogical names.

converter name converter name FQSAMO1 Same name and use as logical name.

Notes: The description of the different parameters used is provided in the Oracle Tuxedo
Application Workbench Reference Guide - File To File Convertor.

Listing 1-17 Example Mapper File: mapper-FTFIL001.re

%% Lines beginning with "%%" are ignored

ufas mapper FTFILOO0L1

oe
90

oe

% Desc file PJO1DDD.DO.QSAM.KBCOIOO01

oe

%

file PJO1DDD.DO.QSAM.KBCOI001 transferred

include "#VAR:RECS-SOURCE#/BCOACO1lE.cpy"

map record REC-ENTREE defined in "#VAR:RECS-SOURCE#/BCOACO1E.cpy"
source record REC-ENTREE defined in "#VAR:RECS-SOURCE#/BCOACO1E.cpy"
logical name FQSAMO1

converter name FQSAMO1

oe
oe

o
oe

Desc file PJ01DDD.DO.QSAM.KBCOIO002

oe
oe
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file PJ01DDD.DO.QSAM.KBCOI002 transferred

include "#VAR:RECS-SOURCE#/BCOACO4E.cpy"

map record REC-ENTREE-2 defined in "#VAR:RECS-SOURCE#/BCOACO4E.cpy"
source record REC-ENTREE-2 defined in "#VAR:RECS-SOURCE#/BCOACO04E.cpy"
logical name FQSAMO02

converter name FQSAMO02

oe
oe

oe
oe

Desc file PJ01AAA.SS.VSAM.CUSTOMER

oe
oe

file PJO1AAA.SS.VSAM.CUSTOMER transferred

include "COPY/ODCSFOB.cpy"

map record VS-ODCSFO-RECORD defined in "COPY/ODCSFOB.cpy"
source record VS-ODCSFO-RECORD in "COPY/ODCSFOB.cpy"
logical name ODCSF0B

converter name ODCSF0B

Installing the Copy Files
Create a $PARAM/ file/recs-source directory to hold the copy files.
Once the COBOL Description files have been prepared, the copy files described in the

mapper-<configuration name>.ref“eSh0Ukjbepk%xﬂinthe$PARAM/file/recs—source
directory.

If you use aCOBOL copy book from the source platform to describe afile (see notein COBOL
Description), thenitisthelocation of the copy book that isdirectly used in the mapping parameter
fileasinthe "copy/0oDCSFOB. cpy" example above.

Generating the Components

To generate the components used to migrate zZ/OS files Tuxedo ART Workbench usesthe
file.sh command. This section describes the command.
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file.sh

Name
file.sh — Generate zZ/OS migration components.

Synopsis
file.sh [ [-g] [-m] [-1 <installation directory>] <configuration name> -s

<installation directory> (<configuration name>,...) ]

Description
file.sh generates the components used to migrate z/OS files using Tuxedo ART Workbench .

Options

-g <configuration name>
Generation option. The unloading and loading components are generated in
$TMPPROJECT USing the information provided by the configuration files.

-m <configuration name>
M aodification option. Makesthe generated shell scripts executable. The COBOL programs
are adapted to thetarget COBOL fixed format. When present, the shell script that modifies
the generated source filesis executed.

-i <installation directory><configuration name>
Installation option. Places the components in the installation directory. This operation
uses the information located in the file-move-assignation.pgm file.

-s
Not applicable to File-to-File migration except when the attributes clauseis set to
LOGICAL_MODULE_ONLY.

In this case, this option enables the generation of the configuration filesand DML utilities
used by the COBOL converter. All configuration files are created in
$PARAM/dynamic-config and DML filesin <trf>/DML directory.

Example

file.sh -gmi SHOME/trf FTFILOO1

Locations of Generated Files

The unloading and loading components generated with the -1 $HOME/trf option are placed in
the following locations:
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Table 1-17 Location of Components

Location Contents

$HOME/trf/unload/file/<configuration name> 1heJCL usedfor each
unloading are generated for
each <configuration name>.

$HOME/trf/reload/file/<configuration name- 1heprogramsandKSH used
for each loading are
generated for each
<configuration name>.

$TMPPROJECT/outputs The generation log files

M apper-log-<configuration
name> can be used to
resolve problems.

Modifying Generated Components

The generated components may be modified using a project’s own scripts.These scripts (sed,
awk, perl,...) should be placed in:

SPARAM/file/file-modif-source.sh

When present, thisfilewill be automatically executed at the end of the generation process. It will
be called using the <configuration name> asan argument.

Using the Make Utility

MakeisaUNIX utility intended to automate and optimize the construction of targets (files or
actions).

Y ou should have a descriptor file named makefile in the source directory in which al operations

are implemented (amakefile is prepared in the source directory during the initialization of a
project).

The next two sections describe configuring amake file and how to use Tuxedo ART Workbench
File-To-File Converter functions with amakefile.
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Configuring a Make File

Version.mk

Theversion.mk configurationfilein $param isused to set the variablesand parametersrequired
by the make utility.

In version.mk specify where each type of component isinstalled and their extensions, as well
asthe versions of the different tools to be used. Thisfile also describes how the log files are
organized.

The following general variables should be set at the beginning of migration processin the

version.mk file
® ROOT_PROJECT
® DIR_TRADDATA
® TOOLS_DATA

® LOGDIR

In addition, the FILE_scHEMAS variable is specific to file migration, it indicates the different
configurations to process.

This configuration should be complete before using the makefile.

Make File Contents
The contents of the makefile summarize the tasks to be performed:

e Including vesion.mk
e Controlling if the main variables are set
e Collecting the value of variables and building the required lists to process.

e Implementing the targets.
A makefile and aversion.mk file are provided with Tuxedo ART Workbench Simple
Application.
Using a Makefile with Tuxedo ART Workbench File-To-File Converter

The make FileConvert command can be used to launch Tuxedo ART Workbench
File-To-File Converter. It enablesthe generation of the componentsrequired to migrate z/OSfiles
to aUNIX/Linux target platform.
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The make file launchesthe file.sh tool withthe -g, -m and -1 options, for al configurations
contained in the FILE_SCHEMAS Variable.

The File-to-Oracle Migration Process

e File Organization

Initializing the Process

Re-engineering Rules to Implement

Preparing the Environment

e Generating the Components

File Organization

When migrating vsau files from a source platform to an Oracle UNIX target platform, the first
guestion to ask, when VSAM is concerned, is whether to keep afile or migrate the datato an
Oracletable.

The following file organizations handled by z/OS can be migrated using Tuxedo ART
Workbench to Oracle databases; vsaMm RRDS, ESDS and KSDS.

The Tuxedo ART Workbench File-to-Oracle Converter is used for those files that are to be
converted to Oracle tables. For files that remain in file format, see Executing the File-to-File
Generated Converter Programs.

Migration Process Steps

The principle stepsin the File-To-Oracle migration process, explained in detail in therest of this
chapter, are:

Create an overall list of the files to be migrated.

List those files that will be converted to Oracle tables.

For each of these files, when necessary, create alist of discrimination rules.

Prepare the environment to be used to generate the components.

Using Tuxedo ART Workbench generate the components used in the following steps.

Unload the data from the source platform.

N o o~ w NP

Transfer the data to the target platform.
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8. Transcode and reload the data.

9. Check theresults.

10. Compile the access routines and the generated utilities.
11. Create the Oracle database.

Interaction With Other Oracle Tuxedo Application Rehosting Workbench Tools

The migration of datain VSAM filesto Oracle tables is dependant on the results of the Tuxedo
ART Workbench Cataloger (for more information, see Analyze). The File-to-Oracle migration
impactsthe COBOL and JCL conversion and should be completed before beginning the COBOL
program conversion work.

Initializing the Process

This section describes the steps to be performed before starting the migration of VSAM filesto
Oracletables.

Listing the Files to Be Migrated

Thefirst task isto list al of the VSAM files to be migrated (in conjunction with the use of the
File -to-File converter), and then identify those files that should be converted to Oracle tables.

For example, permanent files to be later used via Oracle or files that need locking at the record
level.

File Descriptions and Managing Files With the Same Structure

For each candidate file for migration, its structure should be described in COBOL format. This
description isused in a COBOL copy by Tuxedo ART Workbench COBOL converter, subject
to the limitations described in COBOL Description.

Once built, the list of filesto migrate can be purged of files with the same structure in order to
save work when migrating the files by limiting the number of programs required to transcode and
reload data.

From the purged list of files, alast task consists of building thefiles:
® Datamap-<configuration name>.re
® mapper-<configuration name>.re

Note: Thepopulate.sh utility (located in REFINEDIR/scripts/file/populate.sh), Can
be used to help generate these two configuration files automatically. For more
information, Se€ REFINEDIR/scripts/file/README. txt.
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COBOL Description

A COBOL description is related to each file and considered as the representative COBOL
description used within the application programs. This description can be a complex COBOL
structure using all COBOL data types, including the occurs and REDEFINES Notions.

This COBOL description will often be more devel oped than the COBOL file description (FD).
For example, an FD field can be described as a PIC X (364) but really contain athree times
defined area including, in one case a COMP-3 based numerals table, and in another case a
complex description of several characters/digitsfields etc.

It isthis developed COBOL description which describes the application reality and thereforeis
used as a base to migrate a specific physicd file.

The quality of the file processing execution depends on the quality of this COBOL description.

From this point, the COBOL description is not separable from the file and when referring to the
file concerned, we mean both the file and its representative COBOL description. The description
must be provided in COBOL format, in afile with the following name:

<COPY name>.cpy

Note: If acopy book on the source platform provides a detailed description of thefile, thefile
can be directly used and declared in Tuxedo ART Workbench .

COBOL Description Format
The format of the COBOL description must conform to the following rules:

e Only onelevel 01.
e Theword FILLER isnot allowed.
e Fields names must be unique.

e Somewords arereserved. A list is supplied in the Appendix of the Oracle Tuxedo
Application Rehosting Workbench Reference Guide.

e The description should begin in column 1 without any preceding sequence numbers.
e Comments may beinserted by placing an * in column 1.

e Field level numbers can start from column 2.
Table 1-18 lists the examples of COBOL description format.
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Table 1-18 COBOL Description Format

Column

123 456178739

—

o —
u—

N —
W —
T QN
€1 —
o —
[ pu—y
o —
O —
oON
—_ N
NN
W N
=N
g1 N

*DESCRI PT

o
P4
o
M
M
—
m
X
X
X
X

0 5 FVvi14x1 P I C X

COBOL Description and Related Discrimination Rules

Within aCOBOL description there are several different waysto describe the same memory field,
which means to store objects with different structures and descriptions at the same place.

Asthe same memory field can contain objects with different descriptions, to be able to read the
file, we need a mechanism to determine the description to use in order to interpret correctly this
data area.

We need arule which, according to some criteria, generally the content of one or more fields of
the record, will enable us to determine (discriminate) the description to use for reading the
re-defined area.

In Tuxedo ART Workbench thisruleis called adiscrimination rule.

Any redefinition inside a COBOL description lacking discrimination rules presents amajor risk
during the file transcoding. Therefore, any non-equivalent redefined field requests a
discrimination rule. On the other hand, any equivalent redefinition (called technical redefinition)
must be subject to a cleansing within the COBOL description (see the example below).

The discrimination rules must be presented per file and highlight the differences and
discriminated areas. Regarding thefiles, it isimpossible to reference afield external to thefile
description.

The following description is a sample of a COPY as expected by Tuxedo ART Workbench :
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Listing 1-18 COBOL COPY Example

01 FV14.

05

05

05

FV14-X1 PIC X.

FV14-X2 PIC XXX.

FV14-X3.

10 FV14-MTMGFA PIC 9(2).

10 FV14-NMASMG PIC X(2).

10 FV14-FILLER PIC X(12).
10 FV14-COINFA PIC 9(6)V99.

05 FV14-X4 REDEFINES FV14-X3.

05

05

10

10

10

10

10

FV14-MTMGFA PIC 9(6)V99.
FV14-FILLER PIC X(4).
FV14-IRETCA PIC X(01).
FV14-FILLER PIC X(2).
FV14-ZNCERT.

15 FV14-ZNALEA COMP-2.
15 FV14-NOSCP1 COMP-2.
15 FV14-NOSEC2 COMP-2.
15 FV14-NOCERT PIC 9(4)COMP-3.

15 FV14-FILLERPIC X(16).

FV14-X5 REDEFINES FV14-X3.

10

10

FV14-FIL1 PIC X(16).

FV14-MNT1 PIC S9(6)V99.

FV14-X6 REDEFINES FV14-X3.

10 FV14-FIL3 PIC X(16).
10 FV14-MNT3 PIC S9(6).
10 FV14-FIL4 PIC X(2).
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The discrimination rules are written in the following format:

Listing 1-19 COBOL COPY Discrimination Rules

Field FV14-X3

Rule if FV14-X1 = “A” then FV14-X3
elseif FV14-X1 = “B” then FV14-X4
elseif FV14-X1 = “C” then FV14-X5
else FV14-X6

Note: Inthe COBOL description, thefield FVV14-X3 must bethefirst field to be redefined. The

order of subsequent fields: F\V14-X4, FV14-X5 and FV 14-X6 is hot important.

The copy name of the COBOL description is: <COPY name>.cpy

Redefinition Examples

Non-Equivalent Redefinition

Listing 1-20 Non-equivalent Redefinition Example

01 FV15.
05 FV15-MTMGFA PIC 9(2).

05 FV15-ZNPCP3.

10 FV15-NMASMG PIC X(2).
10 FV15-FILLER PIC X(12).
10 FV15-COINFA PIC 9(6)V99.

05 FV15-ZNB2T REDEFINES FV15-ZNPCP3.

10 FV15-MTMGFA PIC 9(4)V99.
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10 FV15-FILLER PIC X(4).
10 FV15-IRETCA PIC X(01).
10 FV15-FILLER PIC X(2).

10 FV15-ZNCERT

15 FV15-ZNALEA COMP-2.

15 FV15-NOSCP1 COMP-2.

15 FV15-NOSEC2 COMP-2.

15 FV15-NOCERT PIC 9(4) COMP-3.
15 FV15-FILLER PIC X(16).

In the above example, two fields (rFvi5-znpcp3 and Fvis-znB2T) have different structures: an
EBCDIC aphanumeric field in one case and a field composed of EBCDIC dataand COMP2,
COMP3 datain a second case.

The implementation of adiscrimination rule will be necessary to migrate the datato a UNIX
platform.

Listing 1-21 Related Discrimination Rules

Field FV15-ZNPCP3
Rule if FV15-MTMGFA = 12 then FV15-ZNPCP3

elseif FV15-MTMGFA = 08 and FV15-NMASMG = "KC" then FV15-ZNB2T

Equivalent Redefinition Called Technical Redefinition

Listing 1-22 Technical Redefinition Initial Situation

01 FV1.

05 FV1-ZNPCP3.
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10 FV1-MTMGFA

10 FV1-NMASMG

10 FV1-FILLER

10 FV1-COINFA
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PIC 9(6)V99.
PIC X(25).
PIC X(12).

PIC 9(10).

10 FV2-COINFA REDEFINES FV1-COINFA.

15 FV2-ZNALEA PIC 9(2).
15 FV2-NOSCP1l PIC 9(4).
15 FV2- FILLER PIC 9(4).

10 FV15-MTMGFA

10 FV15-FILLER

10 FV15-IRETCA

10 FV15-FILLER

PIC 9(6)V99.
PIC X(4).
PIC X(01).

PIC X(2).

Listing 1-23 Technical Redefinition Potential Expected Results

01
05
10
10
10
10
10
10
10
10

FVl.

FV1-ZNPCP3.

FV1-MTMGFA PIC 9(6)V99.
FV1-NMASMG PIC X(25).
FV1-FILLER PIC X(12).

FV1-COINFA PIC 9(10).

FV15-MTMGFA PIC 9(6)V99.

FV15-FILLER PIC X (4).
FV15-IRETCA PIC X(01).

FV15-FILLER PIC X(2).

01 FV1.

05 FV1-ZNPCP3.

10 FV1-MTMGFA PIC 9(6)V99.
10 FV1-NMASMG PIC X(25).
10 FV1-FILLER PIC X(12).
10 FV2-COINFA.
15 FV2-ZNALEA PIC 9(2).

15 FV2-NOSCP1l PIC 9(4).

15 FV2- FILLER PIC X(4).
10 FV15-MTMGFA PIC 9(6)V99.
10 FV15-FILLER PIC X(4).
10 FV15-IRETCA PIC X(01).

10 FV15-FILLER PIC X(2).
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In the above example, the two descriptions correspond to asimple EBCDIC al phanumeric
character string (without binary, packed or signed numeric fields). thistype of structure does not
require the implementation of a discrimination rule.

Re-engineering Rules to Implement

This section describes the reengineering rules applied by Tuxedo ART Workbench when
migrating datafrom VSAM filesto an Oracle database.

Migration Rules Applied
e Each VSAM file used in CICS becomes an Oracle table.

e Each table nameis stipulated in the mapper-<configuration name>.re fileusing the
table name clause.

e Each elementary field name contained in the copy description of the file becomes a column
name in an Oracle table. Hyphens (-) are replaced by underscore (_) characters.

e For sequential vsau files (vsaM ESDS):
Tuxedo ART Workbench adds a technical column: *_sSEQ_NUM NUMBER(8).

This column is incremented each time a new line is added to the table; the column
becomes the primary key of thetable.

e For relative vsam files (vsaM RRDS):
Tuxedo ART Workbench adds atechnical column *_RELATIVE NUM.

The size of the column is deduced from the information supplied in the Datamap parameter
file; the column becomes the primary key of the table.

The column:
— isincremented when a sequential write is made to the table, and the relative key is zero.
— contains the relative key when the relative key is not zero.
e For indexed vsau files (vsaM xsDs):

Tuxedo ART Workbench does not add a technical column unless duplicate keys are
accepted; the primary key of the vsau file becomes the primary key of the table.
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Rules Applied to Picture Clauses

Thefollowing rules are applied to COBOL Picture clauses when migrating data from vsaw files
to Oracle tables:

Table 1-19 Picture Clause Re-engineering

COBOL Picture Oracle format

PIC 9(length) NUMBER (length)
PIC S9(length)

PIC 9(length) COMP-3

PIC S9(length) COMP-3

PIC 9(prec,scale) NUMBER(prec+scale, scale)
PIC S9(prec,scale)

PIC 9(prec,scale) COMP-3

PIC S9(prec,scale) COMP-3

PIC S9(length) BINARY NUMBER(real_binary_length)

PIC S9(length) COMP Sample:

PIC S9(length) COMP-4 PIC S9(4) BINARY is migrated as
NUMBER (5)

COMP-1 or COMP-2 DATATYPE_DOUBLE

PIC X(..) Becomes CHAR if length <= 2000

Becomes VARCHAR? if length > 2000

Note: If the parameter:
file:char_limit_until_wvarc
har issetinthedb-param.cfg
file, it takes precedence over the above
rule.

Rules Applied to Occurs and Redefines Clauses

For OCCURS and REDEFINES clauses with discrimination rules, three reengineering
possibilities are proposed:

e Creation of asub-table:
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— Redefinitions: each description is associated with a sub-table (one sub-table for each
description).

— Occurs: one sub-table is created containing atechnical column that references the
element of the array to which the data corresponds.

e Creation of an opaque field:

— Redefinitions: all the descriptions are stored in an opaque field type CHAR or
VARCHAR2.

— Occurs: all the occurrences are stored in an opaque field type CHAR or VARCHAR2.

e Extended description

— Redefinitions: al the fields described in the copy file are created as columnsin the
Oracletable.

— Occurs: each occurrence of afield in aredefined areais created as a column in the
Oracle table, one column for each occurrence in the OCCURS clause.

Example VSAM File Migration to Oracle Tahle

In the following example, the indexed vsawu file described in opcsroB uses as a primary key the
vs-cUSTIDENT field.

Listing 1-24 Example VSAM Copy Description

* Customer record description

* -Record length : 266

01 VS-ODCSFO-RECORD.

05 VS-CUSTIDENT PIC 9(006) .
05 VS-CUSTLNAME PIC X(030).
05 VS-CUSTFNAME PIC X(020).
05 VS-CUSTADDRS PIC X(030).
05 VS-CUSTCITY PIC X(020).
05 VS-CUSTSTATE PIC X(002).
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05 VS-CUSTBDATE-G
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PIC 9(008).

REDEFINES VS-CUSTBDATE.

10 VS-CUSTBDATE-CC PIC 9(002).

10 VS-CUSTBDATE-YY PIC 9(002).

10 VS-CUSTBDATE-MM PIC 9(002).

10 VS-CUSTBDATE-DD PIC 9(002).

05 VS-CUSTEMAIL

05 VS-CUSTPHONE

05 VS-FILLER

PIC X(040).
PIC 9(010).

PIC X(100).

Listing 1-25 Oracle Table Generated From VSAM File

WHENEVER SQLERROR CONTINUE;

DROP TABLE CUSTOMER CASCADE CONSTRAINTS;

WHENEVER SQLERROR EXIT 3;

CREATE TABLE CUSTOMER

VS_CUSTIDENT

VS_SEQ_NUM

VS_CUSTLNAME

VS_CUSTFNAME

VS_CUSTADDRS

VS_CUSTCITY

VS_CUSTSTATE

VS_CUSTBDATE

VS_CUSTEMAIL

VS_CUSTPHONE

NUMBER (6) NOT NULL,
NUMBER (8) NOT NULL,
VARCHAR2 (30) ,

CHAR (20),

VARCHAR2 (30) ,

CHAR (20),
CHAR (2),
NUMBER (8) ,

VARCHAR2 (40) ,

NUMBER (10) ,
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VS_FILLER VARCHARZ2 (100) ,
CONSTRAINT PK_CUSTOMER PRIMARY KEY (
VS_CUSTIDENT)
CONSTRAINT UK_CUSTOMER UNIQUE (

VS_SEQ_NUM)

Note: The copy book opcsror contains afield redefinition: vs-cUusTBDATE-G PIC 9(008),
asthisisatechnical field, no discrimination rule isimplemented. In this case, only the
redefined field is created in the generated table vs_CUSTBDATE NUMBER (8) .

Preparing the Environment

This section describes the tasks to perform before generating the components to be used to
migrate data from VSAM filesto Oracle tables.

Initializing Environment Variables
Before executing Tuxedo ART Workbench set the following environment variables:

® export TMPPROJECT=$Home/tmp
— thelocation for storing temporary objects generated by the process.
® export $PARAM=$HOME/param

— the location of the configuration files.

Implementing the Configuration Files
Three files need to be placed in Tuxedo ART Workbench file structure as described by:

e $parau for:
— db-param.cfg,

e $PARAM/file for:
— Datamap-<configuration name>.re,

— mapper-<configuration name>.re.
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For aFile-To-Oracle conversion you must createthe patamap-<configuration name>.re and
mapper-<configuration name>.re filesyourself.

Two other configuration files:
e file-templates.txt

® file-move-assignation.pgm

are automatically generated in the file structure during the installation of Tuxedo ART
Workbench . If specific versions of these files are required for particular zZZOS files they will be
placed in the sparaM/file file structure.

Configuring the Files

Database Parameter File (db-param.cfg)
For the db-param.cfg file, only the target and file parameters need to be adapted.

Listing 1-26 db-param.cfg Example

# This configuration file is used by FILE & RDBMS converter
# Lines beginning with "#" are ignored

# write information in lower case

# common parameters for FILE and RDBMS

# source information is written into system descriptor file (0S, DBMS=,
# DBMS-VERSION=)

target_rdbms_name:oracle

target_rdbms_version:11

target_os:unix

# optional parameter

target_cobol:cobol_mf

hexa-map-file:tr-hexa.map

#

# specific parameters for FILE to RDBMS conversion

file:char limit_until_varchar:29
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# specific parameters for RDBMS conversion
rdbms:date_format:YYYY/MM/DD

rdbms: timestamp_format:YYYY/MM/DD HH24 MI SS
rdbms: time_format:HH24 MI SS

# rename object files

# the file param/rdbms/rename-objects-<schema>.txt is automatically loaded
# by the tool if it exists.

Mandatory Parameters
® target_rdbms_name: oracle

name of the target RDBMS.

® target_rdbms_version:ll

version of the target RDBMS.

® target_os.unix

Name of the target operating system.

® file:char_limit_until_varchar:29

Indicates the maximum field length of a COBOL alphanumeric (PIC X) field before the
field be transformed into an ORACLE VARCHAR data type.

In this example, fields longer than 29 characters become varcHaR, fields shorter than 30
characters become cHaRr fields.

Optional Parameters

target_cobol:cobol_mf
Name of the COBOL language. Accepted values are “cobol_mf” (default value) and

“cobol_it".

In this example, the language is Micro Focus COBOL.

hexa-map-file:tr-hexa.map
Specifiesamapping tablefile between EBCDIC (z2/OS code set) and ASCI I (Linux/UNIX
code set) hexadecimal values; if hexa-map-file isnot specified, awarning will be
logged.
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Datamap Parameter File (Datamap-<configuration name>.re)
Each VSAM file to be migrated must be listed.

The following parameters must be set:

Table 1-20 Datamap Parameters

Parameter Value in example Set by

configuration name  STFILEORA Freely chosen by user.
(data map STFILEORA-map)

system name STFILEORA Determined during cataloging in the

(system cat::STFILEORA) System Description File.

file name PJO1AAA.SSVSAM.CUSTOMER 2/OS physical file name.

Organization Indexed Source organization

Note: The description of the different parameters used is provided in the Oracle Tuxedo
Application Rehosting Workbench Reference Guide - File To File Convertor.

TherJoiaaa.ss.vsam.cusToMER fileisavsam ksps file and the organization is therefore
indexed. The parameters, keys offset 1 bytes length 6 bytes primary, describethe
key. In this example, the key is six bytes long starting in positionl.

Listing 1-27 Example Datamap File: Datamap-STFILEORA.re

%% Lines beginning with "%%" are ignored
data map STFILEORA-map system cat::STFILEORA
%%
%% Datamap File PJ01AAA.SS.VSAM.CUSTOMER
2%
file PJO1AAA.SS.VSAM.CUSTOMER

organization Indexed

keys offset 1 bytes length 6 bytes primary
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Mapping Parameter File (mapper-<configuration name>.re)

Each z/OSfile to be migrated, that isincluded in the Datamap configuration file, must be listed.

A file parameter and its options must beincluded for every vsau fileto convert to an Oracletable.
The following parameters must be set:

Table 1-21 Mapping Parameters

Parameter

Value in example

Set by

configuration name

STFILEORA
(ufas mapper STFILEORA)

Coherent with the name used in the
datamap configuration file.

file name PJO1AAA.SSVSAM.CUSTOMER Name used in the Datamap file.
include include "COPY/ODCSFOB.cpy"  Thenameand path of the copy file
BCOACO1E.cpy isfreely chosenby
the user when creating the file.
table name table name CUSTOMER Provideanamefor the Oracletableto
be created.
map record map record VS-ODCSFO-RECORD VS-ODCSFO-RECORD corresponds
defined in to thelevel 01 field namein the copy
"COPY/ODCSFOB.cpy" file.
logical name logical name ODCSFOB Chosen by the user, maximum eight

characters. Thisnameis used for
naming the objects (COBOL, JCL)
created by the different toolsin
Tuxedo ART Workbench .

converter name

converter name ODCSFOB

Same name and use as logical name.

Note: The description of the different parameters used is provided in the Oracle Tuxedo
Application Rehosting Workbench Reference Guide - File To File Convertor.

Listing 1-28 Example mapper File: mapper-STFILEORA.re

%% Lines beginning with "%%" are ignored

ufas mapper STFILEORA
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oe
oe

oe
oe

Desc file PJ01AAA.SS.VSAM.CUSTOMER

oe
oe

file PJO1AAA.SS.VSAM.CUSTOMER transferred converted
table name CUSTOMER
include "COPY/ODCSFOB.cpy"
map record VS-ODCSFO-RECORD defined in "COPY/ODCSFOB.cpy"
source record VS-ODCSFO0-RECORD in "COPY/ODCSFOB.cpy"
logical name ODCSF0B
converter name ODCSF0B

attributes LOGICAL_MODULE_IN_ADDITION

Installing the Copy Files

Once the COBOL Description files have been prepared, the copy files described in the
mapper-<configuration name>.ref“eShOUkjbep“%xﬂinthe$PARAM/file/recs—source
directory.

If you use aCOBOL copy book from the source platform to describe afile (see notein COBOL
Description), thenitisthelocation of the copy book that isdirectly used in the mapping parameter
fileasinthe "copy/0oDCSFOB. cpy" example above.

Generating the Components

To generate the components used to migrate datafrom VSAM fileto Oracle tables Tuxedo ART
Workbench usesthe file.sh command. This section describes the command.

file.sh

Name
file.sh — Generate z/OS migration components.

Synopsis
file.sh [ [-g] [-m] [-1 <installation directory>] <configuration name> -s

<installation directory> (<configuration name>,...) ]
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Description
file.sh generates the components used to migrate VSAM files by Tuxedo ART Workbench .

Options

-g <configuration name>
Generation option. The unloading and loading components are generated in
$TMPPROJECT Using the information provided by the configuration files.

-m <configuration name>
M odification option. Makesthe generated shell scripts executable. The COBOL programs
are adapted to thetarget COBOL fixed format. When present, the shell script that modifies
the generated source filesis executed.

-i <installation directory> <configuration name>
Installation option. Places the components in the installation directory. This operation
uses theinformation located in the file-move-assignation.pgm file.

-s<ingtallation directory> <schema name>,...)
Enables the generation of the configuration files and DML utilities used by the COBOL
converter. All configuration filesare created in $PARAM/dynamic-config and DML files
in<trf>/pML directory.

Example
file.sh -gmi SHOME/trf FTFILOO1

Using the Make Utility

MakeisaUNIX utility intended to automate and optimize the construction of targets (files or
actions).

Y ou should have a descriptor file named makefile in the source directory in which all operations
are implemented (a makefile is prepared in the source directory during the initialization of a
project).

The next two sections describe configuring amake file and how to use Tuxedo ART Workbench
File-To-File Converter functions with a make file.

Configuring a Make File

Version.mk

Theversion.mk configurationfilein sparam isused to set the variables and parametersrequired
by the make utility.
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Inversion.mk specify where each type of component isinstalled and their extensions, as well
asthe versions of the different tools to be used. Thisfile also describes how thelog files are
organized.

The following general variables should be set at the beginning of migration processin the

version.mk file:
® ROOT_PROJECT
® DIR_TRADDATA
® TOOLS_DATA

® LOGDIR

In addition, the F1LE_scHEMAS variable is specific to file migration, it indicates the different
configurations to process.

This configuration should be complete before using the make file.

Make File Contents
The contents of the makefile summarize the tasks to be performed:

e Including vesion.mk
e Controlling if the main variables are set
e Collecting the value of variables and building the required lists to process.

e Implementing the targets.
A makefile and aversion.mk file are provided with Tuxedo ART Workbench Simple
Application.

Using a makefile with Oracle Tuxedo Application Rehosting Workbench File-To-File Converter

The make FileConvert command can be used to launch Tuxedo ART Workbench

File-To-File Converter. It enablesthe generation of the componentsrequired to migrate Z/OSfiles
to a UNIX/Linux target platform.

The makefilelaunchesthe file.sh tool withthe -g, -m and -1 options, for all configurations
contained in the FILE_SCHEMAS Variable.

Locations of Generated Files

The unloading and loading components generated with the -1 $HOME/tr £ option are placed in
the following locations:
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Table 1-22 Location of Components

Location

Contents

SHOME/trf/unload/file/<configuration name>

Theprogramsand JCL used for each
unloading are generated for each
<configuration name>.

SHOME/trf/reload/file/<configuration name>

The programs and KSH used for
each loading are generated for each
<configuration name>.

Example: loadfile-ODCSFO.ksh
RELFILE-ODCSFO0.cbl

STMPPROJECT/outputs

The generation log files
Mapper-log-<configuration name>
can be used to resolve problems.

SHOME/trf/SQL/file/<schema name>

Location of the SQL scriptsfor creating
tablesand the Korn shell scriptsused to
perform various technical operations
for the Oracle tables generated.

$HOME/ trf /DML

Location of the COBOL and

PRO* COBOL access routines. These
routines are executed by the COBOL
programs instead of the access verbs
used for the VSAM file migrated to
Oracle tables.

Examples of Generated Components

For the example used in this chapter, the following scripts are generated.
The SQL script used to create the CUSTOMER table is named:

e ODCSFOB.g

The scripts used for the different technical operations are named:

o cleantable-ODCSFOB.ksh
o createtable-ODCSFOB.ksh
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droptable-ODCSFOB.ksh
ifemptytable-ODCSFOB.ksh
ifexisttable-ODCSFOB.ksh

Nine COBOL programs are generated, their usageis described in the Oracle Tuxedo Application
Rehosting Workbench Reference Guide.

ASG_ODCSFO0B.cbl
close_all_files_STFILEORA.cbl
dml_locking.cbl
init_all_files.cbl
UL_ODCSFOB.cbl

close_all files.cbl
DL_ODCSFO0B.cbl
getfileinfo.cbl

init_all files_ STFILEORA.cbl

One PRO*COBOL program for accessing the ORACLE CUSTOMER table is generated:

RM_ODCSFOB.pco

Modifying Generated Components
The generated components may be modified using aproject’ sown scripts. these scripts (sed, awk,

per

l,...) should be placed in:

SPARAM/file/file-modif-source.sh

When present, thisfile will be automatically executed at the end of the generation process. It will
be called using the <configuration name> asan argument.

Migrating data files is described in the following sections:

The File-To-Db2/luw (UDB) Migration Process

File Organization
Initializing the Process

Re-engineering Rules to Implement
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e Preparing the Environment

e Generating the Components

File Organizations

When migrating VSAM filesfrom asource platform to an DB2/L uw(udb) UNIX target platform,
the first question to ask, when VSAM is concerned, is whether to keep afile or migrate the data
to a DB2/Luw(udb) table.

The following file organizations handled by z/OS can be migrated using Tuxedo ART
Workbench to Oracle databases; vsaMm RRDS, ESDS and KSDS.

The Tuxedo ART Workbench File-To-File Converter is used for those files that are to be
converted to Oracle tables. For files that remain in file format, the Oracle Tuxedo Application
Workbench Reference Guide, File-to-File Converter.

Migration Process Steps

The principle stepsin the File-To-Db2/luw (UDB) migration process, explained in detail in the
rest of this chapter, are:

Create an overall list of the files to be migrated.

List those files that will be converted to DB2/Luw(udb) tables.

For each of these files, when necessary, create alist of discrimination rules.

Prepare the environment to be used to generate the components.

Using Tuxedo ART Workbench generate the components used in the following steps.
Unload the data from the source platform.

Transfer the data to the target platform.

Transcode and reload the data.

© oo N o o ~ w D P

Check the results.
10. Compile the access routines and the generated utilities.

11. Create the Oracle database.
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Interaction With Other Oracle Tuxedo Application Rehosting Workbench Tools

The migration of datain VSAM filesto DB2/Luw(udb) tablesis dependant on the results of the
Cataloger. The File-To-Db2/luw (UDB) migration impacts the COBOL and JCL conversion and
should be completed before beginning the COBOL program conversion work.

Initializing the Process

This section describes the steps to be performed before starting the migration of vsaw filesto
DB2/Luw(udb) tables.

Listing the Files to Be Migrated

Thefirst task isto list al of the VSAM files to be migrated (in conjunction with the use of the
File-to-File converter), and then identify those files that should be converted to DB2/L uw(udb)
tables. For example, permanent files to be later used viaDB2/Luw or files that need locking at
the record level.

File Descriptions and Managing Files With the Same Structure

For each candidate file for migration, its structure should be described in COBOL format. This
description isused in a COBOL copy by Tuxedo ART Workbench COBOL converter, subject
to the limitations described in COBOL Description.

Once built, the list of filesto migrate can be purged of files with the same structure in order to
save work when migrating the files by limiting the number of programs required to transcode and
reload data.

From the purged list of files, alast task consists of building the files:

® Datamap-<configuration name>.re
® mapper-<configuration name>.re

Note: Thepopulate.sh utility (located in REFINEDIR/scripts/file/populate.sh), can
be used to help generate these two configuration files automatically. For more
information, See REFINEDIR/scripts/file/README. txt.

COBOL Description

A COBOL description is related to each file and considered as the representative COBOL
description used within the application programs. This description can be a complex COBOL
structure using all COBOL data types, including the OCCURS and REDEFINES notions.

This COBOL description will often be more developed than the COBOL file description (FD).
For example, an FD field can be described as a PIC X (364) but really contain athree times
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defined areaincluding, in one case a COMP-3 based numerals table, and in another case a
complex description of several characters/digits fields etc.

It isthis developed COBOL description which describes the application reality and thereforeis
used as a base to migrate a specific physical file.

The quality of the file processing execution depends on the quality of this COBOL description.
From this point, the COBOL description is not separable from the file and when referring to the
file concerned, we mean both the file and its representative COBOL description. The description
must be provided in COBOL format, in afile with the following name:

<COPY name>.cpy

Note: If acopy book on the source platform provides a detailed description of thefile, thefile
can be directly used and declared in Tuxedo ART Workbench .

COBOL Description Format
The format of the COBOL description must conform to the following rules:

e Only onelevel 01.
e Theword FILLER isnot allowed.
e Fields names must be unique.

e Some words are reserved. A list is supplied in the Appendix of the Oracle Tuxedo
Application Rehosting Workbench Reference Guide.

e The description should begin in column 1 without any preceding sequence numbers.
e Comments may beinserted by placing an * in column 1.

e Field level numbers can start from column 2.

Example

Column

123 4567891111111 1112222 22
0123 4561748910123 405

*DESCRI P TI ON

@]
M
M
—
m
X
X
X
X

0 1 F Vv 14
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Column

123 45617819 1

1 1
01 2

[ QN
1 —
o —
[
o —
O —
oON
—_ N
NN
w N
= N
a1 N

1
3

0 5 FVvi14x1 P I

O
X

COBOL Description and Related Discrimination Rules

Within aCOBOL description there are severa different waysto describe the same memory field,
which means to store objects with different structures and descriptions at the same place.

Asthe same memory field can contain objects with different descriptions, to be able to read the
file, we need a mechanism to determine the description to use in order to interpret correctly this
data area.

We need arule which, according to some criteria, generally the content of one or more fields of
the record, will enable us to determine (discriminate) the description to use for reading the
re-defined area. In Tuxedo ART Workbench thisruleis called adiscrimination rule.

Any redefinition inside a COBOL description lacking discrimination rules presents a major risk
during the file transcoding. Therefore, any non-equivaent redefined field requests a
discrimination rule. On the other hand, any equivalent redefinition (called technical redefinition)
must be subject to a cleansing within the COBOL description (see the example below).

The discrimination rules must be presented per file and highlight the differences and
discriminated areas. Regarding thefiles, it isimpossible to reference afield external to thefile
description.

The following description is a sample of a COPY as expected by Tuxedo ART Workbench :

Listing 1-29 COBOL COPY Sample

01 FV14.
05 Fv14-X1 PIC X.

05 FV14-X2 PIC XXX.
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05 FV14-X3.
10 FV14-MTMGFA PIC 9(2).
10 FV14-NMASMG PIC X(2).
10 FV14-FILLER PIC X(12).
10 FV14-COINFA PIC 9(6)V99.

05 FV14-X4 REDEFINES FV14-X3.

10 FV14-MTMGFA PIC 9(6)V99.
10 FV14-FILLER PIC X(4).

10 FV14-IRETCA PIC X(01).
10 FV14-FILLER PIC X(2).

10 FV14-ZNCERT.

15 FV14-ZNALEA COMP-2.
15 FV14-NOSCP1 COMP-2.
15 FV14-NOSEC2 COMP-2.
15 FV14-NOCERT PIC 9(4)COMP-3.

15 FV14-FILLERPIC X(16).
05 FV14-X5 REDEFINES FV14-X3.
10 FV14-FIL1 PIC X(16).

10 FV14-MNT1 PIC S9(6)V99.

05 FV14-X6 REDEFINES FV14-X3.
10 FV14-FIL3 PIC X(16).
10 FV14-MNT3 PIC S9(6).
10 FV14-FIL4 PIC X(2).

The discrimination rules are written in the following format:
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Field FV14-X3

Rule if FV14-X1 = “A”
elseif FV14-X1 = “B”
elseif FV14-X1 = “C”
else

then FV14-X3

then FV14-X4

then FV14-X5

FV14-X6

Note: Inthe COBOL description, thefield FVV14-X3 must bethefirst field to be redefined. The

order of subsequent fields: F\V14-X4, FV14-X5 and FV 14-X6 is hot important.

The copy name of the COBOL description is. <COPY name>.cpy

Redefinition Examples

Non-Equivalent Redefinition

Listing 1-31 Non-equivalent Redefinition Example

01 FV15.

05 FV15-MTMGFA

05 FV15-ZNPCP3.

10 FV15-NMASMG

10 FV15-FILLER

10 FV15-COINFA

PIC 9(2).

PIC X(2).
PIC X(12).

PIC 9(6)V99.

05 FV15-ZNB2T REDEFINES FV15-ZNPCP3.

10 FV15-MTMGFA

10 FV15-FILLER

10 FV15-IRETCA

10 FV15-FILLER

10 FV15-ZNCERT

PIC 9(4)V99.
PIC X(4).
PIC X(01).

PIC X(2).
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15 FV15-ZNALEA COMP-2.

15 FV15-NOSCP1 COMP-2.

15 FV15-NOSEC2 COMP-2.

15 FV15-NOCERT PIC 9(4) COMP-3.
15 FV15-FILLER PIC X(16).

In the above example, two fields (FV15-ZNPCP3 and FV15-ZNB2T) have different structures:
an EBCDIC aphanumeric field in one case and afield composed of EBCDIC dataand COMP2,
COMP3 datain a second case.

The implementation of adiscrimination rule will be necessary to migrate the datato a UNIX
platform.

Listing 1-32 Related Discrimination Rules

Field FV15-ZNPCP3
Rule if FV15-MTMGFA = 12 then FV15-ZNPCP3

elseif FV15-MTMGFA = 08 and FV15-NMASMG = "KC" then FV15-ZNB2T

Equivalent Redefinition Called Technical Redefinition

Listing 1-33 Technical Redefinition Initial Situation

01 FV1.

05 FV1-ZNPCP3.

10 FV1-MTMGFA PIC 9(6)V99.
10 FV1-NMASMG PIC X(25).
10 FV1-FILLER PIC X(12).
10 FV1-COINFA PIC 9(10).
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FV2-COINFA REDEFINES FV1-COINFA.

15 FV2-ZNALEA PIC 9(2)

15 FV2-NOSCP1 PIC 9(4)

15 FV2- FILLER PIC 9(4)
FV15-MTMGFA PIC 9(6)V99
FV15-FILLER PIC X (4)
FV15-IRETCA PIC X(01)
FV15-FILLER PIC X(2)

Listing 1-34 Technical Redefinition Potential Expected Results

01
05
10
10
10
10
10
10
10
10
05
10
10
10
10
15
15
15

FVl.
FV1-ZNPCP3.
FV1-MTMGFA
FV1-NMASMG
FV1-FILLER
FV1-COINFA
FV15-MTMGFA
FV15-FILLER
FV15-IRETCA
FV15-FILLER
FV1-ZNPCP3.
FV1-MTMGFA
FV1-NMASMG
FV1-FILLER
FV2-COINFA.
FV2-ZNALEA
FV2-NOSCP1

Fv2- FILLER

PIC 9(6)V99.
PIC X(25).
PIC X(12).
PIC 9(10).
PIC 9(6)V99.
PIC X(4).
PIC X(01).

PIC X(2).01 FVI1.

PIC 9(6)V99.
PIC X(25).

PIC X(12).

PIC 9(2).
PIC 9(4).

PIC X(4).
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10 FV15-MTMGFA PIC 9(6)V99.
10 FV15-FILLER PIC X(4).
10 FV15-IRETCA PIC X(01).

10 FV15-FILLER PIC X(2).

01 FV1. 01 FV1.
05 FV1-ZNPCP3. 05 FV1-ZNPCP3.

10 FV1-MTMGFA PIC 10 FV1-MTMGFA PIC
9(6)V99. 9(6)V99.

10 FV1-NMASMG PIC 10 FV1-NMASMG PIC
X(25). X(25).

10 FV1-FILLER PIC 10 FV1-FILLER PIC
X(12). X(12).

10 FV1-COINFA PIC 10 FV2-COINFA.
9(10).

15 FV2-ZNALEA
10 FV15-MTMGFA PIC PIC 9(2).

9(6)v93. 15 FV2-NOSCP1
10 FV15-FILLER PIC PIC 9(4).
x(4) 15 FV2-
10 FV15-IRETCA PIC FILLER PIC X(4).
x(01) 10 FV15-MTMGFA PIC
10 FV15-FILLER PIC 9(6)V99.
x(2) 10 FV15-FILLER PIC
X(4)
10 FV15-IRETCA PIC
X(01)
10 FV15-FILLER PIC
X(2)
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In the above example, the two descriptions correspond to asimple EBCDIC al phanumeric
character string (without binary, packed or signed numeric fields). thistype of structure does not
require the implementation of a discrimination rule.

Re-Engineering Rules to Implement

This section describes the reengineering rules applied by Tuxedo ART Workbench when
migrating datafrom VSAM filesto a DB2/Luw(udb) database.

Migration Rules Applied

Each VSAM file used in CICS becomes an DB2/Luw(udb) table.

Each table name is stipulated in the mapper-<configuration name>.re file using the
table name clause.

Each elementary field name contained in the copy description of the file becomes a column
name in an Oracle table. Hyphens (-) are replaced by underscore (_) characters.

For sequential vsau files (vsam ESDS):
Tuxedo ART Workbench adds atechnical column: *_sSEQ NUM NUMERIC (8).

This column is incremented each time anew line is added to the table; the column
becomes the primary key of thetable.

For relative vsau files (vsaM RRDS):
Tuxedo ART Workbench adds atechnical column *_RELATIVE NUM.

The size of the column is deduced from the information supplied in the Datamap parameter
file; the column becomes the primary key of the table.

The column:
— isincremented when a sequential write is made to the table, and the relative key is zero.
— contains the relative key when the relative key is not zero.

For indexed vsau files (vsaM xsDs):

Tuxedo ART Workbench does not add atechnical column unless duplicate keys are
accepted; the primary key of the vsau file becomes the primary key of the table.
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Rules Applied to Picture Clauses

Thefollowing rules are applied to COBOL Picture clauses when migrating data from vsawfiles
to Oracle tables

Table 1-23 Picture Clause Re-engineering

COBOL Picture Oracle format

PIC 9(length) NUMERIC (length)
PIC S9(length)

PIC 9(length) COMP-3

PIC S9(length) COMP-3

PIC 9(prec,scale) NUMERIC (prec+scale, scale)
PIC S9(prec,scale)

PIC 9(prec,scale) COMP-3

PIC S9(prec,scale) COMP-3

PIC S9(length) BINARY NUMERIC (real_binary_length)

PIC S9(length) COMP Example:

PIC S9(length) COMP-4 PIC S9(4) BINARY ismigrated as
NUMERIC (5)

COMP-1 REAL

COMP-2 DOUBLE

PIC X(..) Becomes CHAR if length <= 255

Becomes VARCHAR if length > 255

Note: If the parameter:
file:char_limit_until_varc
har issetinthedb-param.cfg
file, it takes precedence over the above
rule.

Rules Applied to Occurs and Redefines Clauses

For OCCURS and REDEFINES clauses with discrimination rules, three reengineering
possibilities are proposed:
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— Redefinitions: each description is associated with a sub-table (one sub-table for each
description).

— Occurs: one sub-table is created containing atechnical column that references the
element of the array to which the data corresponds.

e Creation of an opaque field:

— Redefinitions: all the descriptions are stored in an opaque field type CHAR or
VARCHAR.

— Occurs: all the occurrences are stored in an opaque field type CHAR or VARCHAR.

e Extended description

— Redefinitions: al the fields described in the copy file are created as columnsin the
Oracletable.

— Occurs: each occurrence of afield in aredefined areais created as a column in the
Oracle table, one column for each occurrence in the OCCURS clause.

Example VSAM File Migration to DB2/Luw(udh) Table
In the following example, the indexed VSAM file described in opcsros uses as a primary key

the vs-cusTipeNT field.

Listing 1-35 Example VSAM Copy Description

* Customer record description

* -Record length :

01 VS-ODCSFO-RECORD.

05

05

05

05

05

VS-CUSTIDENT

VS-CUSTLNAME

VS-CUSTFNAME

VS-CUSTADDRS

VS-CUSTCITY

PIC 9(006).
PIC X(030).
PIC X(020).
PIC X(030).

PIC X(020).
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05 VS-CUSTSTATE PIC X(002).
05 VS-CUSTBDATE PIC 9(008).
05 VS-CUSTBDATE-G REDEFINES VS-CUSTBDATE.

10 VS-CUSTBDATE-CC PIC 9(002).
10 VS-CUSTBDATE-YY PIC 9(002).
10 VS-CUSTBDATE-MM PIC 9(002).

10 VS-CUSTBDATE-DD PIC 9(002).

05 VS-CUSTEMAIL PIC X(040).
05 VS-CUSTPHONE PIC 9(010).
05 VS-FILLER PIC X(100).

Listing 1-36 Oracle Table Generated From VSAM File

DROP TABLE CUSTOMER ;
COMMIT ;

CREATE TABLE CUSTOMER (

VS_CUSTIDENT NUMERIC (6) NOT NULL,
VS_CUSTLNAME VARCHAR (30),
VS_CUSTFNAME CHAR (20),
VS_CUSTADDRS VARCHAR (30),
VS_CUSTCITY CHAR (20),
VS_CUSTSTATE CHAR (2),
VS_CUSTBDATE NUMERIC (8),
VS_CUSTEMAIL VARCHAR (40),
VS_CUSTPHONE NUMERIC (10),
VS_FILLER VARCHAR (100),
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CONSTRAINT PKCUSTOMER PRIMARY KEY (
VS_CUSTIDENT) )

COMMIT ;

Note: The copy book opcsror containsafield redefinition; vs-cUSTBDATE-G PIC 9(008),
asthisisatechnical field, no discrimination rule isimplemented. In this case, only the
redefined field is created in the generated table vs_CcUSTBDATE NUMBER (8).

Preparing the Environment

This section describes the tasks to perform before generating the components to be used to
migrate data from VSAM files to DB2/Luw(udb) tables.

Initializing Environment Variables
Before executing Tuxedo ART Workbench set the following environment variables:
® export TMPPROJECT=$Home/tmp
— thelocation for storing temporary objects generated by the process.
You should regularly clean this directory.
® export $PARAM=$HOME/param
— thelocation of the configuration files.
Implementing the Configuration Files
Three files need to be placed in Tuxedo ART Workbench file structure as described by:
e $PARAM for:
— db-param.cfg,
e $PARAM/file for:
— Datamap-<configuration name>.re,

— mapper-<configuration name>.re.

For aFile-To-Db2/luw (UDB) conversion you must create the batamap-<configuration

name>.re aNd mapper-<configuration name>.re filesyourself.

Two other configuration files:
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e file-templates-db2luw. txt

® file-move-assignation-db2luw.pgm

are automatically generated in the file structure during the installation of Tuxedo ART
Workbench . If specific versions of these files are required for particular z/OS files they will be
placed in the sparam/file filestructure.

Configuring the Files

Database Parameter File (db-param.cfg)
For the db-param.cfg file, only the target and file parameters need to be adapted.

Listing 1-37 db-param.cfg Example

# This configuration file is used by FILE & RDBMS converter
# Lines beginning with "#" are ignored

# write information in lower case

# common parameters for FILE and RDBMS

# source information is written into system descriptor file (0OS, DBMS=,
# DBMS-VERSION=)

target_rdbms_name:udb

target_rdbms_version:9

target_os:unix

# optional parameter

target_cobol:cobol_mf

hexa-map-file:tr-hexa.map

#

# specific parameters for FILE to RDBMS conversion
file:char limit_until_varchar:29

# specific parameters for RDBMS conversion

rdbms:date_format:YYYY/MM/DD
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rdbms: timestamp_format:YYYY/MM/DD HH24 MI SS FF6
rdbms: time_format:HH24 MI SS
# rename object files

# the file param/rdbms/rename-objects-<schema>.txt is automatically loaded
# by the tool if it exists.

Mandatory Parameters

® target_rdbms_name. udb

Name of the target RDBMS.

® target_rdbms_version:9
Version of the target RDBMS.

® target_os.unix
Name of the target operating system.

® file:char_limit_until_varchar:29

Indicates the maximum field length of a COBOL alphanumeric (PIC X) field before the
field be transformed into an b2 /Luw (udb) VARCHAR datatype.

In this example, fields longer than 29 characters become varcHaR, fields shorter than 30
characters becomes cuar fields.
Optional Parameters

target_cobol:cobol_mf
Name of the COBOL language. Accepted values are “ cobol_mf” (default value) and
“cobol it”.

In this example, the language is Micro Focus COBOL.

hexa-map-file:tr-hexa.map

Specifiesamapping tablefile between EBCDIC (z/OS code set) and ASCII (Linux/UNIX
code set) hexadecimal values; if nhexa-map-file isnot specified, awarning will be
logged.

Datamap Parameter File (Datamap-<configuration name>.re)
Each vsawu file to be migrated must be listed.
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The following parameters must be set:

Table 1-24 Datamap Parameters

Parameter Value in example Set by
configuration  STFILEUDB Freely chosen by user.
name

(data map STFILEUDB-map)

system name STFILEUDB Determined by the System

(system cat: : STFILEUDB) Description File in the Cataloger.

file name PJO1AAA.SSVSAM.CUSTOMER z/OS physical file name.

Organization Indexed Source organization

Note: The description of the different parameters used is provided in the Tuxedo ART
Workbench Reference Guide, File To File Convertor.

The PJO1AAA.SS.VSAM.CUSTOMER fileisaVSAM KSDSfile and the organization is
therefore indexed. The parameters, keys offset 1 bytes length 6 bytes primary,
describe the key. In this example, the key is six byteslong starting in positionl.

Listing 1-38 Example Datamap File: Datamap-STFILEUDB.re

%% Lines beginning with "%%" are ignored
data map STFILEUDB-map system cat::STFILEUDB

%

oe

oo
o°

Datamap File PJ01AAA.SS.VSAM.CUSTOMER

%

o°

file PJO1AAA.SS.VSAM.CUSTOMER
organization Indexed

keys offset 1 bytes length 6 bytes primary
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Mapping Parameter File (mapper-<configuration name>.re)
Each z/OS file to be migrated, that isincluded in the Datamap configuration file, must be listed.

A file parameter and its options must be included for every vsau file to convert to an
DB2/Luw(udb) table. The following parameters must be set:

Table 1-25 Mapping Parameters

Parameter Value in example Set by
configuration STFILEUDB Coherent with the name used in the
name datamap configuration file.

(ufas mapper STFILEUDB)

file name

PJO1AAA.SS.VSAM.CUSTOMER

Name used in the Datamap file.

include include "COPY/ODCSFOB.cpy" The name and path of the copy file
BCOACO1E.cpy isfreely chosenby
the user when creating the file.
table name table name CUSTOMER Provide aname for the

DB2/Luw(udb) table to be created.

map record

map record VS-ODCSFO-RECORD
defined in
"COPY/ODCSFOB.cpy"

VS-ODCSFO-RECORD corresponds
to thelevel 01 field name in the copy
file.

logical name

logical name ODCSFOB

Chosen by the user, maximum eight
characters. Thisnameis used for
naming the objects (COBOL, JCL)
created by the different toolsin
Tuxedo ART Workbench .

converter name

converter name ODCSFOB

Same name and use as logical name.

Note: The description of the different parameters used is provided in the Oracle Tuxedo
Application Rehosting Workbench Reference Guide - File To File Convertor.

Listing 1-39 Example Mapper File: mapper-STFILEUDB.re

%% Lines beginning with "%%" are ignored

ufas mapper STFILEUDB
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oe
oe

oe
oe

Desc file PJ01AAA.SS.VSAM.CUSTOMER

oe
oe

file PJO01AAA.SS.VSAM.CUSTOMER transferred converted
table name CUSTOMER
include "COPY/ODCSFOB.cpy"
map record VS-ODCSFO-RECORD defined in "COPY/ODCSFOB.cpy"
source record VS-ODCSFO0-RECORD in "COPY/ODCSFOB.cpy"
logical name ODCSF0B
converter name ODCSF0B

attributes LOGICAL_MODULE_IN_ADDITION

Installing the Copy Files

Once the COBOL Description files have been prepared, the copy files described in the
mapper-<configuration name>.ref“eShOUHjbepkmedinthe$PARAM/file/recs—source

directory.

If you use aCOBOL copy book from the source platform to describe afile (see notein COBOL
Description), thenitisthelocation of the copy book that isdirectly used in the mapping parameter
fileasinthe "copy/0oDCSFOB. cpy" example above.

Generating the Components

To generate the components used to migrate data from VSAM file to DB2/L uw(udb) tables
Tuxedo ART Workbench usesthe £ile.sh command. This section describes the command.

file.sh

Name
file.sh — Generate z/OS migration components.
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Synopsis
file.sh [ [-g] [-m] [-1 <installation directory>] <configuration name> -s

<installation directory> (<configuration name>,...) ]

Description
file.sh generates the components used to migrate vsau files by Tuxedo ART Workbench .

Options

-g <configuration name>
Generation option. The unloading and loading components are generated in
$TMPPROJECT USing the information provided by the configuration files.

-m <configuration name>
M odification option. Makesthe generated shell scripts executable. The COBOL programs
are adapted to thetarget COBOL fixed format. When present, the shell script that modifies
the generated source filesis executed.

-i <installation directory> <configuration name>
Installation option. Places the components in the installation directory. This operation
uses the information located in the file-move-assignation-db2luw.pgn file.

-s<ingtallation directory> <schema name>,...)
Enables the generation of the configuration filesand DML utilities used by the COBOL
converter. All configuration filesare created in $PaARAM/dynamic-configand DML files
in <trf>/DML directory.

Example
file.sh -gmi SHOME/trf FTFILOO1

Using the Make Utility
MakeisaUNIX utility intended to automate and optimize the construction of targets (files or
actions).

Y ou should have a descriptor file named makefile in the source directory in which al operations
are implemented (a makefile is prepared in the source directory during the initialization of a
project).

The next two sections describe configuring amake file and how to use Tuxedo ART Workbench
File-To-File Converter functions with amakefile.
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Configuring a Make File

Version.mk

Theversion.mk configurationfilein $param isused to set the variablesand parametersrequired
by the make utility.

In version.mk specify where each type of component isinstalled and their extensions, as well
asthe versions of the different tools to be used. Thisfile also describes how the log files are
organized.

The following general variables should be set at the beginning of migration processin the

version.mk file
® ROOT_PROJECT
® DIR_TRADDATA
® TOOLS_DATA

® LOGDIR

In addition, the FIL.E_scHEMAS variable is specific to file migration, it indicates the different
configurations to process.

This configuration should be complete before using the makefile.

Make File Contents
The contents of the makefile summarize the tasks to be performed:

e Including vesion.mk
e Controlling if the main variables are set
e Collecting the value of variables and building the required lists to process.

e Implementing the targets.
A makefile and aversion.mk file are provided with Tuxedo ART Workbench Simple
Application.
Using a makefile with Tuxedo ART Workbench File-To-File Converter

The make FileConvert command can be used to launch Tuxedo ART Workbench
File-To-File Converter. It enablesthe generation of the componentsrequired to migrate z/OSfiles
to aUNIX/Linux target platform.
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The make file launchesthe file.sh tool withthe -g, -m and -1 options, for al configurations
contained in the FILE_SCHEMAS Variable.

Locations of Generated Files

The unloading and loading components generated with the -1 $HomE/trf option are placed in
the following locations:

Table 1-26 Location of Components

Location Contents

SHOME/trf/unload/file/<configuration name> The programsand JCL used for each
unloading are generated for each

<configuration name>.

SHOME/trf/reload/file/<configuration name> The programs and KSH used for
each loading are generated for each

<configuration name>.

Example:loadtable-0ODCSFO. ksh
RELTABLE-ODCSFO0.sgb

$TMPPROJECT/outputs The generation log files

Mapper-log-<configuration
name> can be used to resolve
problems.

$HOME/trf/SQL/file/<schema name> Location of the SQL scriptsfor creating

tablesand the Korn shell scriptsused to
perform various technical operations
for the DB2/luw (udb) tables generated.

SHOME/ trf /DML Location of the COBOL and
Embedded SQL accessroutines. These
routines are executed by the COBOL
programs instead of the access verbs
used for the VSAM file migrated to
DB2/luw (udb) tables.

Examples of Generated Components
For the example used in this chapter, the following scripts are generated.
The SQL script used to create the CUSTOMER table is named:

Oracle Tuxedo Application Rehosting Workbench Users Guide 1-107



Oracle Tuxedo Application Rehosting Workbench Users Guide

e ODCSFOB.5q
The scripts used for the different technical operations are named:
® cleantable-ODCSFOB.ksh
® createtable-ODCSFOB.ksh
® droptable-ODCSFOB.ksh
® ifemptytable-ODCSFOB.ksh

® ifexisttable-ODCSFOB.ksh

Nine COBOL programs are generated, their usageis described in the Oracle Tuxedo Application
Rehosting Workbench Reference Guide.

® ASG_ODCSFOB.cbl

® close_all files STFILEUDB.cbl

® dml_locking.cbl

® init_all _files.cbl

® UL_ODCSFO0B.cbl

® close_all files.cbl

® DI, ODCSFOB.cbl

® getfileinfo.cbl

® init all files STFILEUDB.cbl

One Embedded-SQL program for accessing the DB2/Iuw (udb) CUSTOMER table is generated:

® RM_ODCSFOB. sgb

Modifying Generated Components

The generated components may be modified using aproject’ sown scripts. these scripts (sed, awk,
perl,...) should be placed in:

SPARAM/file/file-modif-source.sh

When present, thisfilewill be automatically executed at the end of the generation process. It will
be called using the <configuration name> asan argument.
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The DB2-to-Oracle Migration Process

e File Organization
e Re-Engineering Rules to Implement
e Preparing the Environment

e Generating the Components

File Organization

When migrating from a z/OS DB2 source platform to an Oracle UNIX target platform, the first
question to ask is, which tables should be migrated? When not all DB2 tables are to be migrated,
aDB2 DDL representing the sub-set of objects to be migrated should be built.

Migration Process Steps

The principle stepsin the DB2- to-Oracle migration process, explained in detail in therest of this
chapter, are:

1

2
3
4
5.
6
7
8

Create an overall list of the tables to be migrated. When not al of the DB2 tables are to be
migrated, build aDB2 DDL for those tables to be migrated; otherwise take the entire DB2
DDL used by the site.

. Prepare the environment to be used to generate the components.
. Using Tuxedo ART Workbench generate the components used in the following steps.

. Unload the tables from the source platform.

Transfer the data to the target platform.

. Transcode and reload the data.
. Check theresults.

. Build the Oracle database.

Interaction With Other Oracle Tuxedo Application Rehosting Workbench Tools

The DB2-to-Oracle migration is dependent on the results of the Catal oger; the DB2-to-Oracle
migration impacts the COBOL conversion and should be completed before beginning the
program conversion work.
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Re-Engineering Rules to Implement

This section describes the reengineering rules applied by Tuxedo ART Workbench when

migrating data from a DB2 database to an Oracle database.

Migration Rules Applied
Thelist of DB2 objects that are included in the migration towards Oracle are described in

Creating the Generated Oracle Objects.

Migrated DB2 objects keep their names when migrated to Oracle except for the application of
Tuxedo ART Workbench renaming rules (see Preparing and Implementing Renaming Rules).

DB2-to-Oracle Data Type Migration Rules

Table 1-27 DB2 to Oracle Data Types

DB2 z/0S data type Oracle format

CHAR (length) Becomes CHAR if length <= 2000 bytes
Becomes VARCHAR? if length > 2000 bytes

VARCHAR (length) VARCHAR2 (length)

DECIMAL(...) NUMBER(...)

NUMERIC (...) NUMBER(...)

DEC (...) NUMBER(...)

SMALLINT NUMBER(5)

INTEGER NUMBER(10)

TIMESTAMP TIMESTAMP

TIMESTMP TIMESTAMP

DATE DATE

TIME DATE

DOUBLE BINARY_DOUBLE

FLOAT (prec) BINARY_DOUBLE
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DB2 z/0S data type Oracle format
REAL BINARY_DOUBLE
CLOB CLOB

BLOB BLOB

DB2-to-0racle Column Property Migration Rules
A column property can change the behavior of an application program.

The following table shows all of the DB2 column properties and how they are converted for the

target Oracle database.

Table 1-28 DB2 to Oracle Column Properties

DB2 column properties

Oracle format

Notes

WITH DEFAULT

DEFAULT <value>

<value> dependson DB2/z/OSdata
type.

WITH DEFAULT "

CHAR: DEFAULT ‘'

A zero bytelength in DB2 becomesa
NULL flag on Oracle.

VARCHAR2: DEFAULT '
WITH DEFAULT '<value>' | DEFAULT '<value>'
NOT NULL NOT NULL
IDENTITY Create a Sequence Asthe IDENTITY attribute does not
Create a Trigger exist on Oracle, Tuxedo ART
Workbench replaces the attribute by
Sequence and Trigger objects.
FOR SBCS... Attribute ignored

Preparing and Implementing Renaming Rules
Oracle Tuxedo Application Rehosting Workbench permits the modification of the different

names in the DDL source file (table name, column name).

Renaming rules can be implemented for the following cases:
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e \When Oracle reserved words are found in the DB2 DDL source file.

e When there isadesire to perform areengineering of the DDL sourcefile.

Note: If, when executing Tuxedo ART Workbench , an Oracle reserved word is found in the
DDL source, an error isreported and Tuxedo ART Workbench continuesthe analysis of
the DDL.

Renaming rules should be placed in afile named rename-objects-<schema name>.txt. This
file should be placed in the directory indicated by the $PARAM/rdbms parameter.

Renaming rules have the following format:

o table:

table;<schema name>;<DB2 table name>;<Oracle table name>

e column:

Column; <schema name>;<DB2 table name>;<DB2 column name>;<Oracle column
name>

Comments can be added asfollowing: ¢ Text.
Example:

% Modification applied to the AUALPHOT table

column; AUANPROU; AUALPHOT ; NUM_ALPHA; MW_NUM_ALPHA

Preparing and Implementing LOBS Data Type Migration

Tuxedo ART Workbench permits the download of CLOB and BL OB data types. The DB2
unloading utility downloads each row of CLOB or BLOB columns into a separate file (PDS or
HFS dataset type). This utility (psnur11B) downloads data of all columns and NULL technical
flagsinto aunique MV S member file, excepted for CLOB or BLOB columns which are replaced
by the file name of the CLOB or BLOB separate file.

A PDS dataset type does not allow somefiles depending on your MV S system configuration, you
may need to choose another dataset type for downloading CLOB or BLOB columns.

Based on those two constraints, you should set correct parametersin db-param.cfg
configuration file (see Implementing the Configuration Files).
Preparing and Implementing MBCS Data Migration

Tuxedo ART Workbench provides the transcoding for single byte data. However, if your DB2
data contains MBCS characters, you should choose psnuproc unloading utility and set csv data
format. The MBCS transcoding is done by the transfer tools.
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Based on this constraint, you have to set correct parametersin db-param.cfg configuration file
(see Implementing the Configuration Files).

Example of a Migration of DB2 Objects

In thisexample, the DB2 DDL contains atable named ODCSFO with aprimary key and aunique
index named XCUSTIDEN:

Listing 1-40 DDL Example Before Migration

DROP TABLE ODCSFO;
COMMIT;
CREATE TABLE ODCSFO0

(CUSTIDENT DECIMAL(6, 0) NOT NULL,

CUSTLNAME CHAR(030) NOT NULL,
CUSTFNAME CHAR(020) NOT NULL,
CUSTADDRS CHAR(030) NOT NULL,
CUSTCITY CHAR(020) NOT NULL,
CUSTSTATE CHAR(002) NOT NULL,
CUSTBDATE DATE NOT NULL,
CUSTEMAIL CHAR(040) NOT NULL,
CUSTPHONE CHAR(010) NOT NULL,

PRIMARY KEY (CUSTIDENT) )
IN DBPJO1A.TSPJO1A
CCSID EBCDIC;
COMMIT;
CREATE UNIQUE INDEX XCUSTIDEN
ON ODCSFO0
(CUSTIDENT ASC) USING STOGROUP SGPJO1A;

COMMIT;
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After applying the migration rules, and without implementing any renaming rules the following
Oracle objects are obtained:

Listing 1-41 Oracle Tahle Example After Migration

WHENEVER SQLERROR CONTINUE;
DROP TABLE ODCSF0 CASCADE CONSTRAINTS;
WHENEVER SQLERROR EXIT 3;
CREATE TABLE ODCSFO (
CUSTIDENT NUMBER(6) NOT NULL,
CUSTLNAME CHAR (30) NOT NULL,
CUSTFNAME CHAR (20) NOT NULL,
CUSTADDRS CHAR(30) NOT NULL,
CUSTCITY CHAR(20) NOT NULL,
CUSTSTATE CHAR(2) NOT NULL,
CUSTBDATE DATE NOT NULL,
CUSTEMAIL CHAR(40) NOT NULL,

CUSTPHONE CHAR (10) NOT NULL) ;

Listing 1-42 Oracle Index Example After Migration

WHENEVER SQLERROR CONTINUE;
DROP INDEX XCUSTIDEN;
WHENEVER SQLERROR EXIT 3;
CREATE UNIQUE INDEX XCUSTIDEN ON ODCSFO
(
CUSTIDENT ASC

)
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Listing 1-43 Oracle Constraint Example After Migration

WHENEVER SQLERROR CONTINUE;

ALTER TABLE ODCSF0O DROP CONSTRAINT CONSTRAINT_O01;
WHENEVER SQLERROR EXIT 3;

ALTER TABLE ODCSFO ADD

CONSTRAINT CONSTRAINT_01 PRIMARY KEY (CUSTIDENT) ;

Preparing the Environment

This section describes the tasks to perform before generating the components to be used to
migrate the DB2 datato Oracle.

Implementing the Cataloging of the DB2 DDL Source Files

The DB2 DDL source filesto be migrated are located when preparing for the catal og operations.
During the migration process, all valid DB2 syntaxes are accepted, although only the SQL
CREATE command is handled and migrated to Oracle.

system.desc File Parameters

For a DB2-To-Oracle migration, a parameter must be set in the system.desc System
Description File in the Cataloger that is used by all of Tuxedo ART Workbench tools:

® DBMS-VERSION="8".

Indicates the version of the RDBM S to migrate.

Schemas

A schema should consist of a coherent set of objects (for example there should be no CREATE
INDEX for atable that does not exist in the schema).

By default, if the SQL commands of the DB2 DDL are prefixed by aqualifier or an authorization
ID, the prefix is used by Tuxedo ART Workbench as the name of the schema—for example,
CREATE TABLE <qualifier or authorization ID>.table name.
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The schema name can a so be determined by Tuxedo ART Workbench using the global-options
clause of the system.desc file.

For example:

system STDB20ORA root ".."
global-options
catalog="..",

sgl-schema=<schema name>.

The schema name can a so be determined for each DDL directory by Tuxedo ART Workbench
using thedirectory options clause of the system.desc file. For more information, see
options-clause in Catal oger.

directory "DDL" type SQL-SCRIPT
files "*.sqgl"

options SQL-Schema = "<schema name>".

Implementing the Configuration Files

Only one file needs to be placed in Tuxedo ART Workbench file structure as described by
$PARAM:

® db-param.cfg,
Two other configuration files:
® rdbms-templates. txt

® rdbms-move-assignation.pgm

are automatically generated in the file structure during the installation of Tuxedo ART
Workbench . If specific versions of these files are required, they will be placed in the
$PARAM/rdbms file structure.

Initializing Environment Variables
Before executing Tuxedo ART Workbench set the following environment variables:

e eXport TMPPROJECT=/$home/ tmp
— thelocation for storing temporary objects generated by the process.

You should regularly clean this directory.
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® export PARAM=$HOME/param

— thelocation of the configuration files.

Generation Parameters

Listing 1-44 Example db-param.cfg File

# This configuration file is used by FILE & RDBMS converter
# Lines beginning by "#" are ignored

# write information in lower case

# common parameters for FILE and RDBMS

# source information is written into system descriptor file (0OS, DBMS=,

# DBMS-VERSION=)

target_rdbms_name:oracle

target_rdbms_version:11

target_os:unix

# optional parameter

target_cobol:cobol_mf

hexa-map-file:tr-hexa.map

#

# specific parameters for FILE to RDBMS conversion
file:char limit_until_varchar:29

# specific parameters for RDBMS conversion
rdbms:date_format:YYYY/MM/DD

rdbms: timestamp_format:YYYY/MM/DD HH24 MI SS FF6
rdbms:time_format:HH24 MI SS

rdbms: lobs_fname_length:75
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rdbms:jcl_unload_lob_file_system:pds
rdbms:jcl_unload_utility name:dsnutilb
#rdbms:jcl_unload_format_file:csv

# rename object files

# the file param/rdbms/rename-objects-<schema>.txt is automatically loaded
by # the tool if it exists.

Only the parameters target_<xxxxx> and rdbms : <xxxxx> need to be adapted.

Mandatory Parameters

® target_rdbms_name. oracle

name of the target RDBMS.

® target_rdbms_version:.11
version of the target RDBMS.
® target_os:unix

Name of the target operating system.

Optional Parameters

target_cobol:cobol_mf
Name of the COBOL language. Accepted values are“ cobol_mf” (default value) and
“cobol_it”.

In this example, language is Micro Focus COBOL.

hexa-map-file:tr-hexa.map
Specifiesamapping tablefile between EBCDIC (z/OS code set) and ASCII (Linux/UNIX
code set) hexadecimal values; if hexa-map-£ile iSnot specified, awarning will be
logged.

Optional Parameters in Case of DATE, TIME and TIMESTAMP Data Types

The following rdbms parameters indicate the date, timestamp, and time formats used by z/OS
DB2 and stored in DSNZPARM:

® rdbms:date_format: YYYY/MM/DD
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® rdbms:timestamp_format:YYYY/MM/DD HH24 MI SS FF6

® rdbms:time format:HH24 MI SS

These parameters impact the rel oading operations, COBOL date, and time manipulations. They
are optional and only necessary if the DB2 database contains the bATE, TIME OF TIMESTAMP
fields.

WARNING: Correct setting of these parametersis essential.

Optional Parameters in Case of CLOB or BLOB Data Types

The following rdbms parameters are optional and only necessary if the DB2 schema contains
CLOB or BLOB datatypes.

WARNING: A correct setting of these parametersis essential.

® rdbms:jcl_unload_lob_file_system:pds / hfs

The number of member files that can be created on aPDS s limited. Asthe DB2
unloading utility creates anew member file for each CLOB/BLOB column and row, which
may exceed the maximum number allowed for LOBS files to be created on a PDS dataset
type, in that case you need to choose HFS dataset type. Contact your DB2 MVS
administrator for more helps. By default, use “pds”.

® rdbms:lobs_fname_length:75

You need to cal culate the maximum length of the CLOB or BLOB file name as written by
the DB2 unloading JCL in the table datafile:

— pds

If the length of target MV S dataset nameis equal t0 “MIGR. SCH1.TAB1.COLUMN1" (22
characters), the maximum length of the string created by the JCL would be 32: 22 + 2
(parenthesis characters) + 8 (member name).

— HFS

If the length of target MV S directory nameis equal to
“/LOB/SCHEMA2 /TABLE2 /SECOND2” (27 characters), the maximum length of the string
created by the JCL would be 36: 27 + 1 (slash character) + 8 (file name).

Note: You should set value “dsnutilb” for rdbms:jcl_unload_utility_name parameter.

Optional Parameters for JCL Unloading Utility
The following parameters are optional:
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® rdbms:jcl_unload_utility name:dsnutilb

® rdbms:jcl_unload_format_file:binary

Y ou can also change the value depending on the presence of DB2 unloading utility onthe MVS.
Note;

e Thefirst parameter is necessary if the DB2 schema contains CLOB or BLOB data
types.

e The second parameter can be set to “csv” only if the jc1_unload_utility_name
is set to “dsnuproc”.

o |f the database contains MBCS characters, you should choose "dsnuproc" asthe
unloading utility and "csv" asthe unloading format.

Generating the Components

To generate the components used to migrate data from DB2 databases to Oracle databases,
Tuxedo ART Workbench usesthe rdbms . sh command. This section describes the command.

rdbms.sh

Name
rdbms.sh — Generate DB2 to Oracle database migration components.

Synopsis
rdbms.sh [ [-c|-C] [-g] [-m] [-r] [-i <installation directory>] <schema
name> ] -s <installation directory> (<schema name>,...) ]

Description

rdbms . sh generates Tuxedo ART Workbench components used to migrate z/OS DB2 databases
to UNIX Oracle databases.

Options
Generation Options

-C <schema name>
Thefollowing componentsare generated in $TMPPROJECT : DDL Oracle, the soL*LOADER
cTL files, the XML file used by the COBOL converter, and configuration files
(mapper . re and Datamap . re). If an error or warning is encountered, the processwill not
abort.
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See Executing the Transcoding and Reloading Scripts for information about the SQL
scripts created during the generation operation.

-c <schema name>
This option has the same result as the -c option except the process will abort if an error
or warning is generated.

-g <schema name>
The unloading and loading components are generated in $TMPPROJECT USINg the
information provided by the configuration files. Y ou should run the rdbms . sh command
with -c or -c command before this option.

Modification Options

-m <schema name>
Makes the generated shell scripts executable. The COBOL programs are adapted to the
target COBOL fixed format. When present, the shell script that modifies the generated
source is executed.

-r <schema name>
Removes the schema name from the generated objects (create table, table name, CTL file
for SQL*LOADER, KSH). When this option is used, the name of the schema can also be
removed from the COBOL components by using the option:
sql-remove-schema-qualifier located inthe config-cobol file (COBOL
conversion configuration file) used when converting the COBOL components.

Installation Option

-i <installation directory> <schema name>
Places the components in the installation directory. This operation uses the information
located in the rdbms-move-assignation.pgn file.

Generate Configuration Files for COBOL Conversion

-s<installation directory> <schema name>,...)
Enables the generation of the COBOL convertor configuration file. Thisfile takes all of
the unitary XML files of the project. All thesefiles are created in
SPARAM/dynamic-config.

Example: rdbms-conv.txt  rdbms-conv-PJ01DB2.xml

Example

rdbms.sh -Cgrmi $HOME/trf PJ01DB2
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Using the Make Utility

MakeisaUNIX utility intended to automate and optimize the construction of targets (files or
actions).

Y ou should have a descriptor file named makefile in the source directory in which al operations
are implemented (a makefile is prepared in the source directory during the initialization of a
project).

The next two sections describe configuring amake file and how to use Tuxedo ART Workbench
File-To-File Converter functions with amakefile.

Configuring a Make File

Version.mk

Theversion.mk configurationfilein $param isused to set the variablesand parametersrequired
by the make utility.

In version.mk specify where each type of component isinstalled and their extensions, as well
asthe versions of the different tools to be used. Thisfile also describes how the log files are
organized.

The following general variables should be set at the beginning of migration processin the

version.mk file
® ROOT_PROJECT
® DIR_TRADDATA
® TOOLS_DATA

® LOGDIR

In addition, the RoBMS_scHEMAS variable is specific to DB2 migration, it indicates the different
schemas to process.

This configuration should be compl ete before using the make file.

Make File Contents
The contents of the makefile summarize the tasks to be performed:

e Including vesion.mk
e Controlling if the main variables are set

e Collecting the value of variables and building the required lists to process.
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e |mplementing the targets.
A makefile and aversion.mk file are provided with Tuxedo ART Workbench Simple
Application.

Using a Makefile With Oracle Tuxedo Application Rehosting Workbench File-To-File Converter

The make RdbmsConvert command can be used to launch Tuxedo ART Workbench

File-To-File Converter. It enables the generation of the components required to migrate a DB2
database to Oracle.

Themakefilelaunchesthe rdoms . sh tool withthe -c, -g, -r, -mand -1 options, for al schemas
contained in the RDBMS_ SCHEMAS variable.

Locations of Generated Files

The unloading and loading components generated with the -1 $HoME/trf option are placed in
the following locations:

Table 1-29 Location of Components

Location Contents

$HOME/trf/unload/rdbms/<schema name> The JCL used for each unloading are
generated for each <schema name>.

$HOME/trf/SQL/rdbms/<schema name> Location by <schema name> of the SQL
scripts used to create the Oracle objects.
For the example used in this chapter there
are three scripts:

¢ INDEX-ODCSFO.sgl
¢ TABLE-ODCSFO0.sgl
¢ CONSTRAINT-ODCSFO.sgl

SHOME/trf/reload/rdbms/<schema Location by <schema name> of the

name>/src COBOL transcoding programs. For the
example in this chapter, thereis one
program:

* MOD_ODCSFO0.cbl

and another program in case of CLOB data
type:
* CLOB_<table>_<column>.cbl
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Table 1-29 Location of Components

Location

Contents

SHOME/trf/reload/rdbms/<schema
name>/ctl

L ocation by <schema name> of the CTL
filesused by SQL*LOADER. For the
examplein this chapter, thereisone CTL:

* ODCSFO.ctl

SHOME/trf/reload/rdbms/<schema
name>/ksh

Location by <schema name> of the
reloading Korn shell scripts. For the
example in this chapter, thereis one
script:

¢ Jloadrdbms-ODCSFO0.ksh

$TMPPROJECT/outputs/<schema name>

Thegenerationlogfiles produced when using
the -c or -C options.
rdoms-converter-<schema name> can be
used to resolve problems.

trf/DSNUTILS/<schema name>

Location by <schema name> of the
COBOL programs for DB load/unload. For
the example in this chapter, there're two
programs:

PJ01DB2-0DCSF0-L.pco
PJ01DB2-0DCSF0-U.pco

Modifying Generated Components

The generated components may be modified using aproject’ sown scripts. these scripts (sed, awk,

perl,...) should be placed in:

SPARAM/rdbms/rdbms-modif-source.sh

When present, thisfilewill be automatically executed at the end of the generation process. It will

be called using the <schema name> asan argument.

COBOL Conversion

Migrating data files is described in the following sections:

e Requirements & Prerequisites

e Overview of the COBOL Converter in the Replatforming Process
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e Conversion Steps
e Using amake File

e Troubleshooting the COBOL Converter

Requirements & Prerequisites

Cataloguing Requirements

Catal oguing is mandatory before running the COBOL converter in order to check the consistency
of the assetsto be migrated and fix any errorsrelated either to syntax or to the coherency (missing
or unused components) of the asset.

Data Conversion

The data migration process must have been performed before the COBOL conversion is started.
This dependency is because the datamigration tools generate some of the configuration filesread
by the COBOL converter. The configuration files from data conversion are documented in the
Oracle Tuxedo Application Rehosting Workbench Reference Guide.

Overview of the COBOL Converter in the Replatforming Process
The inputsto Tuxedo ART Workbench COBOL converter process are:

e The abstract syntax trees of the COBOL programs stored in the pob files produced by
Tuxedo ART Workbench Cataloger.

e A set of configuration files, some of them are produced by the data conversion tools that
specifies information about file-to-RDBM S conversion and relational DBM S conversion
(from DB2to Oracle).

Conversion Steps

Building and Setting the Configuration Files

The main configuration file for tranglation is config-coBoL. It references other additional
configuration files including:

® keywords-file
® tr-hexa.map

® rename-call-map-file
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Samples of al the needed configuration files are given in the Simple Application. Y ou only need
to check and adapt the valuesif necessary.

All of the configuration files that the COBOL Converter uses are described in the COBOL
Converter chapter of the Oracle Tuxedo Application Rehosting Workbench Reference Guide.

Configuring config-COBOL

After preparing the prerequisites for the COBOL conversion, prepare the main configuration file
using the following example as amodel.

Note: Thefollowing files can be used:

® post-translation-file used when thereisaneed to perform some specific
transformations. Thisfile isto write manually.

e rdbms-conversion-file used when migrating DB2 to an Oracle database. This
fileis generated by the DB2-to-Oracle Convertor.

e conv-ctrl-list-file used when there arefilesto be converted to Oracle tables.
Thisfile should be generated by the File-to-File Converter.

Listing 1-45 config-cobol File

Config:
"Config version 1.0"
# sgl-rules : none.

/* GENERAL */

target-dir: "../trf/.
keywords-file: "../param/keywords-file".
rename-call-map-file: "../param/rename-call-map-file".

accept-date : MW-DATE.

accept-day : MW-DAY.

# post-translation-file: "../param/renov.desc".
hexa-map-file: "../param/tr-hexa.map".

# rdbms-conversion-file : "dynamic-config/rdbms-conv.txt".
conv-ctrl-list-file : "dynamic-config/Conv-ctrl.txt".
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on-size-error-call : "ABORT".

dcrp. /* Without reconcilation of copies files */

end

keywords-file

The keywords-fileisahint file for the COBOL Converter to help rename specific variables
including reserved keywords probably not renamed systematically by Tuxedo ART Workbench
COBOL Converter.

Thisis areengineering mechanism offered by the WorkBench to perform a (mass-change)
renaming operation for the customer’s own purposes, even when the variables are not Micro
Focus COBOL or COBOL-IT reserved keywords.

Place the following entry in the main configuration file config-cobol:

keywords-file: "../param/keywords-file"

Listing 1-46 Sample Keywords File

( TAB . MW-TAB )
( DOUBLE . MW-DOUBLE )

( POS . MW-POS )

In this example each occurrence of the item TAB will be replaced by MW-TAB.

tr-hexa.map

The tr-hexa.map fileis amapping table between EBCDIC (z/OS code set) and ASCI|
(Linux/UNIX code set) hexadecimal values.

Place the following entry in the main configuration file config-cobol:

Oracle Tuxedo Application Rehosting Workbench Users Guide 1-127



Oracle Tuxedo Application Rehosting Workbench Users Guide

1-128

hexa-map-file: "../param/tr-hexa.map"

Thisfileis used by some trandation rules like Tr-Hexa-Map and may help the user to solve
problems related to differences between EBCDIC and ASCII codesin values and strings that
could lead to different behavior in sorting and in string comparisons.

Note: hexa-map-fileisan optional item; if it is not specified, awarning will be logged.
Generated hexa-map-file with convert-hexa-copy-to-map.sh script

Thisscript islocated in REFINEDIR/scripts/convert-hexa-copy-to-map.sh.

Syntax
REFINEDIR/scripts/convert-hexa-copy-to-map.sh convertmw_copy_file
convertmw_copy_file: location of the CONVERTMW.cpy file

The script generates a tr-hexa.map fileinside the current directory (it should be the PARAM
directory).

Hexadecimal Code for Space Example
The hexadecimal code for spacein z/0OSis 40 and the hexadecimal codefor spacein UNIX is20.
The statement in the source platform code is:

01 VarName pic X value X'40'.
Thisistrandated as:

Listing 1-47 Hexadecimal Code Translation

*{ Tr-Hexa-Map 1.4.2.1

*01 VarName pic X value X'40'.
—

01 VarName pic X value X'20"'.
*}

Listing 1-48 Sample of tr-hexa.map

00;00

Oracle Tuxedo Application Rehosting Workbench Users Guide



Detailed Rehosting Methodology

01;01
02;02
03;03
37;04
2d; 05
2e;06

2f;07

40;20

rename-call-map-file

The rename-call-map-file isamapping file between the old call name and the new one.

Itisused by sometrandation ruleslike Tr-Rename-External-call and allowsthe user to make

specific changes if needed.
Place the following entry in the main configuration file config-cobol:

rename-call-map-file: "../param/rename-call-map-file"

Listing 1-49 Example rename-call-map-file

("MQGET" . "MWMQGET")
("KIX-ABEND" . "KIX ABEND")
("KIX-ASKTIME" . "KIX_ASKTIME")

In this example all callsto mocET are changed to MWMQGET.
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Conversion

There are many possibilities allowed by the conversion command options (for more information,
see theOracle Tuxedo Application Workbench Reference Guide). In this section the following
exampl es are described:

e Trandate Batch programs and CICS programs.
e Trandate alist of programs.

e Trandate one program.

The distinction between programs (Batch and CICS) and sub-programsis mandatory; the option
-cobol-type takesthe following values:

e Batch programs. batch
e CICS programs: tpr

e Sub-programs: sub
In the following command lines, the following working variables are set:

Table 1-30 Conversion Variables

Variable Value

REFINEDIR /product/art_wbllgRl/refine
PROJECT S (HOME) / simpleapp

PARAM SPROJECT/param

SOURCE SPROJECT/source

LOGS SPROJECT/Logs

Translation of Batch, CICS Programs and Sub-Programs
The command lines are:

e Totrandate all batch programs:

SREFINEDIR/refine cobol-convert -v version -loop -limit=50 -s
SPARAM/system.desc -c $PARAM/config-cobol -cobol-type batch
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The COBOL Converter knows which are the batch programsto be translated from the
system description file which describes all components. Where version isthe release
version, for examplemM2_1.5_7

e Totrandate all CICS programs invoke the command:

SREFINEDIR/refine cobol-convert -v version -loop -limit=50 -s
SPARAM/system.desc -c $PARAM/config-cobol -cobol-type tpr

e To tranglate one program, for example the CICS program peMM002 . cbl, invoke the
command:

SREFINEDIR/refine cobol-convert -v version -loop -limit=50 -s
SPARAM/system.desc -c $PARAM/config-cobol -cobol-type tpr
CICS/PGMMO002.cbl

e Totrandate all sub-programs files invoke the following command:

SREFINEDIR/refine cobol-convert -v version -loop -limit=50 -s
SPARAM/system.desc -c $PARAM/config-cobol -cobol-type sub

e Totrandate all CICS programs invoke the command:

SREFINEDIR/refine cobol-convert -v version -loop -limit=50 -s
SPARAM/system.desc -c $SPARAM/config-cobol -cobol-type tpr -cics
Thelog fileis generated in the directory from where the command line is executed. If you want
to have logs in a specific directory or file use -1og-file-base followed by the path and name
of the file to store the execution logs.
SREFINEDIR/refine cobol-convert -v version -loop -limit=50 -s
SPARAM/system.desc -log-file-base

SLOGS/trans-cbl/translate-cobol-datetime -c¢ $PARAM/config-cobol
-cobol-type sub

In this example, the logs file will be generated in
$LOGS/trans-cbl/translate-cobol-datetime. Thelogs directory should be previously
created.

Reconciling Copyhooks

Reconciliation of copybooks can be executed implicitly by the COBOL Converter or can be
performed separately (through usage of the dcrp option, see Configuring config-COBOL) after
al

programs have been generated.
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To apply reconciliation separately, you should execute the following script from the directory
where converted programs are located, (in the case of the Simple Application, from the
$PROJECT /trf directory:

Listing 1-50 Copy Reconciliation

for file in “find * -name '*-copies'’
do
SREFINEDIR/scripts/reconcil-copy-opt-imbr $PROJECT/trf S$file .cbl

done

Checking Results
To check conversion results, verify that:

o All expected programs are generated.
e There are no empty programs.
e There are no truncated programs.

e There are no multi-versions for copybooks (reconciliation completed properly).
For empty or truncated programs, the user can refer to execution logs generated in $Logs to
analyze errors encountered during the conversion.
Compiling
Compilationisavalidation step for conversion. A program cannot be considered fully converted
if it has not compiled successfully.
Compilation Options and Settings

Y ou need to check that the compilation environment is configured correctly for Micro Focus
COBOL or COBOL-IT compilation according to the following variables:
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Table 1-31 Compilation Variables

Variable Value Usage
COBDIR /Product/microfocus/cobol COBOL product access
COBOLITDIR /product/COBOL-IT COBOL-IT product access

Other COBOL-IT
environment variables

source $COBOL ITDIR/bin/cobol-it-setup.sh

Initializes environment
variables
(PATH.LD_LIBRARY_PAT
H...)

PATH $COBDIR/bin: ${PATH} Add Cobdir to PATH
variable
LD_LIBRARY_PATH /usr/1lib:$COBDIR/1ib:${ORACLE_HOME}/ Defined

lib:${JAVA_HOME}/1lib

LD_LIBRARY_PATH

COBCPY ../DML: . ./Master-copy/COPY:../fixed- Indicateswhere programs
copy: . can find includes
PCCINCLUDE "include=. ./Master-copy/COPY, Indicates where programs

include=../../fixed-copies,
include=.

can find includes

A compilation options file must be prepared. The compilation options used for the Simple

Application are:

Listing 1-51 MF Compilation Options Example

SOURCEFORMAT"FREE"

DEFAULTBYTE"0O0"

ADDRSV"COMP-6"

coMP-6"2"

ALIGN"8"

NOTRUNCCALLNAME

NOTRUNCCOPY
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NOCOPYLBR
COPYEXT"cpy, cbl"
RWHARDPAGE
PERFORM-TYPE"OSVS"
NOOUTDD

INDD

NOTRUNC
HOSTARITHMETIC
NOSPZERO
INTLEVEL"4"
SIGN"EBCDIC"
ASSIGN"EXTERNAL"
NOBOUND

SETTINGS
REPORT-LINE"256"
WARNING"2"

TRACE

LIST()

For more information, see the Oracle Tuxedo Application Rehosting Workbench Reference
Guide.

Compilation Command
The command to compile the programs BATCH/PGMMB0O0 . cbl:

Listing 1-52 MF Compilation Example

# From $PROJECT/trf/BATCH

cd $PROJECT/trf/BATCH
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export COBCPY=../DML:../Master-copy/COPY:../fixed-copy:.

export PCCINCLUDE="include=../Master-copy/COPY, include=../fixed-copies,

include=."

cob -ug PGMMBO0O.cbl -C "use(../../compil_tools/opt.dir)" -C
"list (PGMMBOO.lst)" -C XREF -C SETTINGS 2> PGMMBO0O.err
Where:

e opt.dir is afile where the compilation options are specified.
e Compilation errors are generated in PGMMBOQO.err.

e Compilationislisted in PGMMBOO.Ist.

e Compilation is successful if GMMBO0O.gnt is generated.

Note: The best way to compile programsis to use a compilation makefile, you can set
compilation options and a required configuration and perform compilation procedure
using amake tool designed for these operations

For the Simple Application example, there is a compilation makefile that can be used for other
projects. See Using a make File.

Using a make File

Configuration

The makefile delivered with the Simple Application example implements all conversion
operations and can be used in any other project with the following adaptations:

e Set the required working variables.

e Update the version.mk configuration file according to your project properties and
organization.

This configuration is supplementary to the preceding configuration started in the catal oging step.

Before using the make commands, the user should check the valuesin the version.mk supplied
with the Simple Application:
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Listing 1-53 version.mk Example

#

# Defined extensions converted files
#

ext_trad = cbl

ext_trad_copy = cpy

ext_trad_ksh = ksh

ext_trad_map = bms

#

# Define Version variables

# Information

# with GLOBAL_VERSION=CURRENT all -v option in the makefile are ignored
#

GLOBAL_VERSION = M2_L3_5

CATALOG = $ (GLOBAL_VERSION)

TRAD = $(GLOBAL_VERSION)
TRAD_JCLZ = $(GLOBAL_VERSION)
DATA_TOOLS = $(GLOBAL_VERSION)
RECONCIL_COPY = $ (GLOBAL_VERSION)
TIMEOUT = 900

TIMEOUT_PARSE = 300

#
# Define Config and opt files
#

FILE_TRAD_JCL = "$(PARAM) /config-trad-JCL.desc"
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FILE_TRAD_COBOL = "$(PARAM) /config-cobol"

COMM_TRADJCL = "-c¢ $(FILE_TRAD_JCL)"

COMM_RECONCIL_COPY = "reconcil-copy-opt-imbr"

COBOL Conversion
To perform the COBOL conversion the following commands are run from $SoURCE :

e Totrandate all programsin the source directory
make trad
e To trandlate batch programs only:
make trad_batch
e Totrandate CICS programs only:
make trad cics
e To trangdlate sub-programs:
make trad_sub
Reconciling Copybooks
To reconcile copybooks invoke the following command from $source:

make reconcil_copy

Troubleshooting the COBOL Converter

During transl ation you may encounter error messages or the COBOL Converter may abort.
Certain errors are shown below as examples of how to proceed when errors occur.

Configuration File Does Not Exist

Particularly at the beginning of the conversion process, some configuration files could be
missing, the COBOL Converter then aborts showing the following error:

Message

Parsing config /home2/wkb7/simpleapp/param/config-cobol...
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*FATAL*: Hexa-map-file: this file
' /home2 /wkb7/simpleapp/param/tr-hexa.map' does not exist

Error: Uncaught throw of :MESSAGE-ERROR to :MESSAGE-ERROR.

1 (abort) Quit process.

Type :b for backtrace, :c <option number> to proceed, or :? for other
options

Solution
Add the missing configuration file or disable the line in the main configuration fileif thefile
requested (in this example, tr-hexa.map) iSuUNNecessary.
Missing POB file
M essage
Parsing config /home2/wkb7/simpleapp/param/config-cobol...
Creating target file /home2/wkb7/simpleapp/trf/CICS/PGMM002.cbl

*FATAL INTERNAL ERROR*: Can't find POB file
/home2 /wkb7/simpleapp/source/CICS/pob/PGMM002.cbl.pob; please
re-catalog the system.

FIN

Rest in peace, Refine...
Solution

Either the programs is not catalogued yet or the . pob file was wrongly deleted. Recatalog to
generate the requested file.

POB File Too OId
M essage
Creating target file /home2/wkb7/simpleapp/trf/CICS/PGMM0O02.cbl

*FATAL INTERNAL ERROR*: POB file

/home?2 /wkb7/simpleapp/source/CICS/pob/PGMM0O02.cbl.pob is less recent
than source file /home2/wkb7/simpleapp/source/CICS/PGMM002.cbl; please
re-catalog the system.
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Solution

This error occursif the modification date of the source program is more recent than its
corresponding POB file. Sometimesthe POB fileis generated but the source program is updated
later, recatal og the program to ensure you have the latest changes.

Parsing error encountered

A program containing parsing errorsisnot translated, especially programswith fatal errorsduring
cataloging. Generally, COBOL Converter can translate programs containing errors with
severities lessthan FATAL.

M essage
Program name is PGMMO002
Warning:-- Parse-Error at line 163

*FATAL*: file CICS/PGMM002.cbl contains true parse errors, ABORTING!

FIN

Rest in peace, Refine...

Solution
Check the source code of the program and fix any errors, catal og the program and convert again.

More detail s about the parsing errors can be found in the catal oging reportsand logs. In principle,
you should not start conversion work before fixing errorsidentified during the cataloging step.

JCL Conversion
Trandating JCL is described in the following sections:

e Requirements & Prerequisites
e Overview of the COBOL Converter in the Replatforming Process
e Conversion Steps

e Using amake File
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Requirements & Prerequisites

Cataloguing Requirements

Cataloguing is mandatory before running the JCL translator in order to check the consistency of
the assets to be migrated and fix any errors related either to syntax or to the coherency (missing
or unused components) of the asset.

Data Conversion

The data migration process must have been performed before the JCL trandation is started. This
dependency is because the file migration tools generate some of the configuration files read by
the JCL Trandlator. The configuration files from data conversion are documented in the Oracle
Tuxedo Application Rehosting Workbench Reference Guide.

Overview of the JCL Translator in the Replatforming Process
Theinputsto Tuxedo ART Workbench JCL Trandator process are:

e The abstract syntax trees of the JCL stored in the pob files produced by the Catal oger.

e A set of configuration files produced by the data conversion tools that specifies
information about the File-to-File Converter conversion and the DB2-to-Oracle Convertor
conversion.

e A set of configuration files which are either:

— Generated by other Oracle Tuxedo Application Rehosting Workbench tools, the
DB2-to-Oracle Convertor provides the JCL translator with the list of filesto be
converted to Oracle tables

— Supplied together with Tuxedo ART Workbench and customizable.

Translation Steps
This section provides information and procedures for:

Building and Setting the Configuration Files
Tranglation Steps
Checking Results
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Building and Setting the Configuration Files

In addition to the AST of the JCL(s) to convert produced by the Cataloger, Tuxedo ART
Workbench JCL Trandator takes asinput a main configuration file that specifies various aspects
of thetrandation, such as:

e Customizable top skeleton and bottom skeleton;

e Root pathname for migrated data files, temporary files and spool files;
e Thelist of datafiles converted to Oracle tables;

e The sort utility to use on the target platform;

e Component and data-file renaming information;

e Program-launcher configuration;

Thisfileisvery easy to write using any standard text editor, or to generate from other sources of
information. below, we comment a sample of configuration file written to translate JCL filesin
the simple application STFILEORA provided with Tuxedo ART Workbench tools.

The main configuration file also refers to separate sub-files which are either:
e Generated by other Tuxedo ART Workbench tools
e Supplied together with Tuxedo ART Workbench (and customizable)
e Wholly written by the user.

Tuxedo ART Workbench comes with examples of configuration files.

The main configuration file for the JCL trandlation iscalled config-trad-JcL.desc inthis
guide for use with the Simple Application application.

The following sections describe the different configuration parameters and configuration
sub-files and gives afull sample at the end of this section.

Top Skeleton and Bottom Skeleton

The sub-files specified by the two options top-skeleton and bottom-skeleton represent
respectively aheader file and afooter file for the generated script. Y ou can customize thesefiles.

Listing 1-54 Top Skeleton and Bottom Skeleton Entries in the Main Configuration File

top-skeleton = "../param/top-ksh.txt"
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bottom-skeleton = "../param/bottom-ksh.txt"

Listing 1-55 Example of top-ksh.txt Prolog Code

#@ (#)- SCRIPT NAME == $[JOBNAME] .ksh --- VERSION OF $[DATE]
#@ (#) - AUTHOR ==

#@ (#) - TREATMENT ==

#@ (#) - OBSERVATIONS == MAINFRAME MIGRATION

#e (#) -

Where:

JOBNAME
Will take the name of the current JOB after trandlation.

DATE
Is the generation date of the KSH script.

List of Data Files Converted to Oracle Tables

When files are converted to Oracle tables, the main configuration file must reference a
sub-configuration file such as

file-list-in-table = "../param/dynamic-config/File-in-table.txt"
This sub-fileis generated by the File-to-File Converter. Thisfileindicatesto the JCL Trand ator,

which arethefilesthat will be converted to Oracle tables in order to correctly translate the steps
involving these files. In our example PJ012AA. SS.VSAM. CUSTOMER iS the file to be converted.

For example, when the JCL source involves files that will be converted to Oracle tables, the
corresponding shell script usesthe Batch Runtime function m_programexec with the -b option
to execute a COBOL program. The -b option indicates a connection to the database must be
opened before executing the program. For example:

m_ProgramExec -b RSSABBO1
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Post-Translation

The sub-file specified by the option post-transl ation-file contains a sequence of rules which are
used to automatically perform post-trans ation after Tuxedo ART Workbench Converter. Seethe
Post-Trandation Configuration File in Workbench Reference Guide.

The Post-Trandation entry in the main configuration file is as follows:

post-translation-file = "../param/renov.desc"

Full Example Configuration

The general optionsroot-skeleton, target-proc, label-end, management of FSN, etc. are described
in the JCL Translator section of the Oracle Tuxedo Application Workbench Reference Guide.

Listing 1-56 JCL Translator Configuration File for STFILEORA Simple Application (config-trad-JCL.desc ):

% config.desc :

%

root-skeleton = .. /trf-jcl/"
target-proc = "../trf-jcl/Master-Proc"

use-sort=mf-sort

%

var-dataroot = "${DATA}/"
var-tmp = "${TMP}/"
var-spool = "${SPOOL}/"

% Ksh heading

%

top-skeleton = "../param/top-ksh.txt"

% KSH footer

%

bottom-skeleton = "../param/bottom-ksh.txt"
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% Files passed in tables
file-list-in-table = "../param/dynamic-config/File-in-table.txt"
% Post-Translation Configuration File
post-translation-file = "../param/renov.desc"
% Suffix of translated ksh du ksh traduit
suffix-skeleton = "ksh"
% Management of FSN to keep
set-no-delete-fsn = SORTIE ( ZIP390 ),
ENTREE ( ZIP390 ),
* ( DB2CMD, CSQUTIL ),
CFTIN ( CFTUTIL ),
SYSUT1 ( DUMMY ),
* ( ADRDSSU ).
% Management of FSN to delete
set-delete-fsn = SYSOUT ( IDCAMS ),
SYSEXEC ( CSCOLMVS ),
SYSTSIN ( * ),
SYSPUNCH ( * ),
TOOLIN ( * ),
SYSUDUMP ( * ),
SYSDBOUT ( * ),
SYSABOUT ( * ),

SYSTSPRT ( * ),
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SORTLIB ( * ),
OPLIB ( * ),
STEPLIB ( * ),

JOBLIB ( * ).

Launchers Configuration

This file describes how to interpret the source JCL to find for instance the program to be
launched, and how this launch operation should be translated; predefined configuration for
IKJEFTO1, DLIBATCH and other standard launchers.

Listing 1-57 Launcher Entry in Main Configuration File

global-options jclz-launcher-spec-file = "launchers”.

Listing 1-58 Example of Launcher Code

LAUNCHER DFSRRCO00
IndexProg : 2,
IndexPSB : 3

END

LAUNCHER DB2BATCH
IndexProg : 2,
IndexPSB : 3

END

LAUNCHER SWCP7110
IndexProg : 2,
IndexParm : 4,

Separator :
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END

Full Example Configuration

The general options root-skeleton, target-proc, label-end, etc. are described in the JCL
Tranglator section of the Oracle Tuxedo Application Rehosting Workbench Reference Guide.

Listing 1-59 JCL Converter Configuration File for Simple Application (config-trad-JCL.desc )

% config.desc :

root-skeleton "../trf-jcl/"
target-proc = "../trf-jcl/Master-Proc"
use-sort=mf-sort

3

o

o

°

var-dataroot = "$S{DATA}/"

var-tmp = "${TMP}/"

var-spool = "${SPOOL}/"

top-skeleton = "../param/top-ksh.txt"
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% Ksh heading

% KSH footer

oe

bottom-skeleton = "../param/bottom-ksh.txt"

% KSH footer

o0

% File passed in table
%

file-list-in-table = "../param/dynamic-config/File-in-table.txt"

% Suffix of translated ksh

suffix-skeleton = "ksh"

% Management of FSN to keep
set-no-delete-fsn = SYSIN ( DSNUTILB ),
OUTPUT ( ZIP390 ),
INPUT ( ZIP390 ),
* ( DB2CMD, CSQUTIL ),
CFTIN ( CFTUTIL ),
SYSUT1 ( DUMMY ),

* ( ADRDSSU ).
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% Management of FSN to delete
set-delete-fsn = SYSOUT ( IDCAMS ),
SYSEXEC ( CSCOLMVS ),
SYSTSIN ( * ),

SYSIN ( IDCAMS, XMFSORT, ICEMAN, SPOOL, SORT ),
SYSPUNCH ( * ),
TOOLIN ( * ),
SYSUDUMP ( * ),
SYSDBOUT ( * ),
SYSABOUT ( * ),
SYSTSPRT ( * ),
SORTLIB ( * ),

OPLIB ( * ),

STEPLIB ( * ),

JOBLIB ( * ).

Translation Steps

The Tuxedo ART Workbench JCL Trandator executes on amigration platform (Linux) and can
automatically translate a single job file, a series of jobs files or the entire system content.

Set Environment Variables
Before executing the tranglator the following variables must be set:
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Table 1-32 Translator Variables

Variable Value Usage

REFINEDIR /product/art_wbllgRl/re Tuxedo ART Workbench product file structure.
fine

PROJECT $ (HOME) / simpleapp Project location.

PARAM $PROJECT /param Location of configuration files.

SOURCE $PROJECT/source Location of source files.

LOGS $PROJECT/Logs Location of source files.

Translation Commands

The following commands can be used to execute the tranglation. Logs file are generated in
SLOGS/trad-jcl.

Command Lineto Translate One JCL File

To create aKorn shell script with the same name as the input file except with a.ksh suffix.

Listing 1-60 Single JCL Translation Script

cd SLOGS/trans-jcl

SREFINEDIR/refine jclz-unix -v version -s S$PARAM/system.desc -c
SPARAM/config-trad-JCL.desc JCL/defvcust.jcl

Command Lineto Translatea List of JCL Files

Totrandate alist of JCL filesinvoke following command:

Listing 1-61 List of JCL Translation Script

cd SLOGS/trans-jcl
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SREFINEDIR/refine jclz-unix -v version -s $PARAM/system.desc -c
SPARAM/config-trad-JCL.desc -f jcl-files-1list

Command Lineto Translate All JCL Files
To trandate all JCL filesinvoke a command:

Listing 1-62 All JCL Translation Script

cd $SLOGS/trans-jcl

SREFINEDIR/refine jclz-unix -v version -s S$PARAM/system.desc -c
$SPARAM/config-trad-JCL.desc

JCL Post-translation Steps

Due to the limitations of the JCL translation or when site-specific trandlation is needed, thereis
apossibility to perform repetitive post-translation tasks automatically.

The post-trang ation mechanism allows you to change one block of lines by another.

Post-Tranglation Example
To illustrate post-trand ation usage the following example add a comment after line containing
m_ProgramExec IEFBR14 ""inthe/prtvcust.ksh JCL script.
1. Writethefollowing rulein renov-jcl.desc:
# by user John Doe on YY/MM/DD
regle add-comment-1
filtre [
+JCL/prtvcust.ksh
1
transform [

m_FileAssign -m R -a R -d SHR VKSDCUST ${DATA}/METAW00.VSAM.CUSTOMER
m_ProgramExec PGMMBO1l ""

into [
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m_FileAssign -m R -a R -d SHR VKSDCUST ${DATA} /METAWO00 .VSAM.CUSTOMER
m_ProgramExec PGMMBO1 ""

# Added comment

2. Invoke acommand line:

SREFINEDIR/M2_L3_5/scripts/post-trans -c=\#META-RENOV\#
-r=$PROJECT/param/renov-jcl.desc JCL/prtvcust.ksh < JCL/prtvcust.ksh >
JCL/prtvcust.ksh.renov

grep -v "#META-RENOV#" JCL/prtvcust.ksh.renov > JCL/prtvcust.ksh

Checking Results
To check conversion results, verify that:

o All expected files are generated.

e All corresponding ksh scripts are generated.
e All procs and includes are extracted.

e There are no empty scripts.

e There are no truncated scripts.

Check the error messages; the JCL translator prints error messages encountered during the
tranglation in the generated script. Check if any messages are present by searching for the
following keywords: " UNDEFINED ", " NIL ", " UNTRANSLATED ". The complete list of
error messages along with their explanation can be found in the Oracle Tuxedo Application
Rehosting Workbench Reference Guide.

e Control the procedures
e Control the Batch RunTime functions.
e Check that there are no unjustified warning messages.

Using a Make File

The use of makefileswhen using Tuxedo ART Workbench isrecommended because it enables
you to:

e Document all (executable) processes

o Effectively manage incremental operations and thereby savetime.
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e Control and check the results of processes
A makefile should be placed in the source directory in which the operations are implemented at
theinitialization of a project.
Configuration
See “Make Configuration” in the Catal oger.

JCL Translation
Totrandate all the JCL in the $ssource file system
From the $source directory launch the command:

make trad_jcl

The JCLs are trand ated sequentially one by one.

Configure

Database, Compiler, and Others

In order to compile sources, we need collect some information. Y ou can input these information
in the configure wizard.

If you choose COBOL-IT astarget COBOL compiler and you would use ISAM filesin open
system, you must set "BDB DbHome Location"”; it must point to a directory where the database
and log fileswill be stored. For moreinformation, see"Oracle Berkeley DB" partin "COBOL-IT
Compiler Suite Enterprise Edition - Reference Manual" or "The Berkeley DB Environment" part
in "Berkeley DB Programmer's Reference Guide'.

After building is complete, the root makefile and sub makefile would be generated under related
subdirectory. It will also copy entire "fixed-copy" directory from workbench installed directory
to build directory.

Tuxedo

Main function of Tuxedo wizard is to generate ubbconfig file for Batch runtime and CICS
runtime.

The configurableitemsinclude Tuxedo location, IPC KEY, Machine Name, APPDIR and so on.
For more information, see Oracle Tuxedo 12c Release 2 (12.2.2).
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CICS

Main function of CICSwizard isto generate setenv filefor CICS runtime. The configurableitems
include CICS runtime location,| PC key for common work area and monitor settings.

For more information, see Oracle Tuxedo Application Runtime for CICS and Batch 12c Release
2(12.2.2).

Batch

Main function of Batch wizard is to generate jesconfig and setenv file for Batch runtime. The
configurable items include Batch runtime location, JESROOT and so on.

For more information, see Oracle Tuxedo Application Runtime for CICS and Batch 12¢c Release
2(12.2.2).

IMS

Main function of IMSwizard isto generate setenv file for IMS runtime. The configurable items
include IMS runtime location, and so on.

For more information, see Oracle Tuxedo Application Runtime for IMS 12¢ Release 2 (12.2.2).

Build

Build step guide users to build application components, data rel oading programs, data access
programs and tuxedo configuration files.

Gmake utility will be used when do the building task. Related makefiles are generated in previous
step.

Deploy
Pack Target

Generate threetar files, which contain all the files under deploy directory. Thistar files are ready
for deployment.

Deploy Application

Unpack tar filesto the location that user specify.
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Setup Runtime

Setup Batch runtime environment

Prepare the environment of Batch runtime. For moreinformation, see Oracle Tuxedo Application
Runtime for CICS and Batch 12c Release 2 (12.2.2).

Setup CICS runtime environment

Prepare the environment of CICS runtime. For moreinformation, see Oracle Tuxedo Application
Runtime for CICS and Batch 12c Release 2 (12.2.2).

Setup IMS runtime environment

Prepare the environment of IMS runtime. For more information, see Oracle Tuxedo Application
Runtime for IMS 12c Release 2 (12.2.2).

Reload File Data

All the defined fileswill bedisplayed inthetable. Filesunder the sourcelocation will belist while
clicking last column of the table.

After click "Finish", all the result of reloading will be placed in the location which user specify.

Reload DB2 Data

Thisstep issimilar to previous step, except result datawill be placed into database instead of file
path user specified.

Run

CICS Runtime
Boot or shutdown ART CICS runtime.

Batch Runtime
Boot or shutdown the ART Batch runtime, and manipulate jobs of ART Batch Runtime.

IMS Runtime
Boot or shutdown the ART IMS runtime.
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Performing the Data Migration

Reset

Cleanup output from the corresponding steps.

Performing the Data Migration
Executing the File-to-File Generated Converter Programs

This section describes the tasks of unloading, transfer and reloading using the components
generated using Tuxedo ART Workbench (see Generating the Components).

Preparation

Configuring the Environments and Installing the Components

Installing the Unloading Components Under z/0S

The components used for the unloading (generated in $HOME/trf/unload/file) should be
installed on the source z/OS platform. The generated JCL may need adapting to specific site
constraints including JOB cards, library access paths and access paths to input and output files
(Data Set Name — DSN).

Installing the Reloading Components on Target Platform

The components used for the reloading (generated in $HOME/trf/reload/file) should be
installed on the target platform (Runtime).

The following environment variables should be set on the target platform:

Table 1-33 Variables and Their Target Platform

Variahle Value

DATA_SOURCE The name of the directory containing the files transferred from z/OS
to be reloaded.

BIN The location of the generic reload and control scripts

(SHOME/trf/reload/bin)

TMPPROJECT The temporary directory.

MT_LOG Directory to contain execution logs.
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Table 1-33 Variahles and Their Target Platform

Variable Value

DATA Directory containing the output files from the transcoding and
reloading processes. These are the files ready to be used on the target
platform.

COB_EXTFH_INDEXED If you choose COBOL-IT astarget COBOL compiler and you use

COB_EXTFH_LIB BDB as 15aM filesin an open system, you must set these two

environment variables, so that BatchRT can generate BDB format
file, otherwise Micro Focus COBOL compatible file will be
generated:

export COB_EXTFH_INDEXED=BDBEXTFH
export

COB_EXTFH_LIB=/path_to_Cobol-IT/1lib/libbdbextfh
.so

For example:

export
COB_EXTFH_LIB=/opt/cobol-it-64/1ib/libbdbextfh.
so

Unloading JCL

An unloading JCL is generated for each z/OS file listed in the Datamap Parameter File
(Datamap-<configuration name>.re). These unloading JCLsare named <logical file

name>.jclunload
Note: The .jclunload extension should be deleted for execution under z/OS.

Transferring the Files

Files should be transferred between the source z/OS platform and the target platform in binary
format using the file transfer tools available at the site (CFT, FTP, ...).

Compiling the Transcoding Programs
The generated COBOL programs used for transcoding and reloading are named:

RELFILE-<logical file name>

For the example provided in Mapping Parameter File (mapper-<configuration name>.re), the
generated programs are:

® RELFILE-FQSAMO1l.cbl,
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® RELFILE-FQSAM02.cbl,

® RELFILE-ODCSF0OB.cbl.

Sequential Files (VSAM ESDS, QSAM, Generation Data Set)

When migrating a sequential file, atarget coBoL LINE SEQUENTIAL output fileis generated:

Listing 1-63 FILE CONTROL Example — Extract From Program: RELFILE-FQSAMO1.chl:

SELECT SORTIE
ASSIGN TO "SORTIE"
ORGANIZATION IS LINE SEQUENTIAL

FILE STATUS IS IO-STATUS.

VSAM KSDS Files
When migrating aVSAM KSDSfile, an 1npExED output file will be generated:

Listing 1-64 FILE CONTROL Example — Extract From Program: RELFILE-ODCSFOB.chl:

SELECT MW-SORTIE
ASSIGN TO "SORTIE"
ORGANIZATION IS INDEXED
ACCESS IS DYNAMIC
RECORD KEY IS VS-CUSTIDENT

FILE STATUS IS IO-STATUS.
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These COBOL programs should be compiled with the target COBOL compiler using the options
described in the COBOL converter section of the Tuxedo ART Workbench Reference Guide.

Executing the Transcoding and Reloading Scripts
The transcoding and reloading scripts use the following parameters:

Synopsis
loadfile-<logical file name>.ksh [-t/-1] [-c <method>]

loadgdg-<logical file name>.ksh [-t/-1] [-c <method>]

Options

-t
Transcode and reload the file.

Transcode and reload the file (same action as -t).

-cftp:i<...>:<...>
Implement the verification of the transfer (see Checking the Transfers).

Examples

For the example provided in Mapping Parameter File (mapper-<configuration name>.re), the
generated scripts are:

® loadfile-FQSAMO1.ksh,
® loadfile-FQSAMO2.ksh
® loadfile-ODCSFOB.ksh.

Files

By default, the input file is located in the directory indicated by spaTa_source, and the output
fileisplaced in the directory indicated by $paTa.

These files are named with the logical file name used in the Mapping Parameter File
(mapper-<configuration name>.re).

An execution log is created in the directory indicated by sut_1.0G.
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A return code different from zero is produced when a problem is encountered.

Checking the Transfers
This check usesthe following option of the 1oadfile-<logical file name>.ksh

-c¢ ftp:<name of transferred physical file>:<name of FTP log under UNIX>

Note: Thisoption verifies, after the reloading, that the physical file transferred from z/OS
and thefile reloaded on the target platform contain the same number of records. This
check is performed using the FTP log and the execution report of the reloading
program. If the number of recordsis different, an error message is produced.

Troubleshooting

This section describes problems resulting from usage errors that have been encountered when
migrating files from the source to target platform.

Overview
When executing any of Tuxedo ART Workbench tool users should check:

o |f any error messages are displayed on the screen.

o If theMapper-log-<configuration name> file containsany errors (see Common
Problems and Solutions).

Error messages and associated explanations are listed in the appendix of the Oracle Tuxedo
Application Rehosting Workbench Reference Guide.

Common Problems and Solutions
Error: Unknown file organization *UNDEFINED*

When executing file.sh -gmi S$HOME/trf STFILEORA thefollowing message appears:
Refine error...
Log
The contents of the Mapper-1log-sTFILEORA log file include:
file PJO1AAA.SS.QSAM.CUSTOMER.REPORT loaded/unloaded
file logical name MW-SYSOUT
*** Unknown file organization : *UNDEFINED*

mapping record MW-SYSOUT
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record MW-SYSOUT: logical name MW-SYSOUT

record MW-SYSOUT: logical name MW-SYSOUT

Explanation
A fileto bemigrated ispresent in themapper-<configuration name>.re fileand absent from

theDatamap.<configuration name>.re file.

Error: Record... not found
When executing file.sh -gmi S$HOME/trf STFILEORAL thefollowing message appears:

Refine error...

Log

The contents of the Mapper-1og-sTFILEORAL log file include:

file PJO1AAA.SS.QSAM.CUSTOMER.REPORT loaded/unloaded
file logical name MW-SYSOUT

file is sequential: no primary key
*** record "MW-SYSOUT in COPY/MW_SYSOU2T.cpy' not found ***
*** ERROR: all records omitted ***

mapping records

Explanation
The copy file is unknown.
Error: Record... not found

When executing file.sh -gmi $HOME/trf STFILEORA2 the following message appears:

Refine error...

Log

The contents of the Mapper-1og-sTFILEORA2 lOg file include:

file PJO1AAA.SS.QSAM.CUSTOMER.REPORT loaded/unloaded
file logical name MW-SYSOUT

file is sequential: no primary key

*** record "MW-SYSOUTTT in COPY/MW_SYSOUT.cpy' not found ***
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record MW-SYSOUT reselected (all records omitted)
mapping record MW-SYSOUT

record MW-SYSOUT: logical name MW-SYSOUT

Explanation
The RECORD name (level 01 field) is unknown.
Error: External Variahle PARAM is not set

When executing file.sh -gmi $HOME/trf STFILEORA3 the following message appears:

Refine error...
Log

The contents of the Mapper-1og-sTFILEORA3 log fileinclude:

FHE A R R R R R R
##

Control of schema STFILEORA3
External Variable PARAM is not set!

ERROR : Check directive files for schema STFILEORA3

Explanation

The variable sparaM has not been set.

Executing File-to-Oracle Generated Converter Programs

This section describes the tasks of unloading, transfer and reloading using the components
generated using Tuxedo ART Workbench (see Generating the Components).
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Preparation

Configuring the Environments and Installing the Components

Installing the Unloading Components Under z/0S

The components used for the unloading (generated in $HOME/ trf/unload/file) should be
installed on the source Z/OS platform. The generated JCL may need adapting to specific site
constraints including JOB cards, library access paths and access paths to input and out put files
(Data Set Name — DSN).

Installing the Reloading Components Under UNIX

The components used for the reloading (generated in $HOME/trf/reload/file) should be
installed on the target platform (runtime).

Installing the Oracle Object Creation Components

The components used for creating the Oracle objects (generated in $HOME/ SQL/ file/<schema
name>) should beinstalled on the target platform (runtime).

Setting the Target Platform Environment Variables

Table 1-34 lists environment variables that should be set on the target platform.

Table 1-34 Environment Variables and Their Platform

Variable Value

DATA_SOURCE The name of the directory containing the files transferred from z/OS
to be reloaded.

DATA The name of the directory containing the physical files converted to

ASCII format and ready to be loaded to Oracle tables.

BIN The location of the generic reload and control scripts
($HOME/trf/reload/bin)

TMPPROJECT The temporary directory.

MT_LOG Directory to contain execution logs.

NLS_LANG Set according to the instructionsin the Oracle documentation.
DDL The location of the SQL scripts used to create Oracle objects

($SHOME/trf/sSQL/file/<schema name>).

1-162 Oracle Tuxedo Application Rehosting Workbench Users Guide



Performing the Data Migration

The following variable should be set according to the information in the Oracle Tuxedo
Application Rehosting Workbench Installation Guide:

® MT_DB_LOGIN.

Unloading the JCL

An unloading JCL is generated for each zZ/OSfile listed in the Datamap Parameter File
(Datamap-<configuration name>.re). These unloading JCLs are named <logical file
name>.jclunload. These JCL usethe REPRO function of the IDCAMS utility to unload the
files.

Note: The .jclunload extension should be deleted for execution under z/OS.

Transferring the Files

Files should be transferred between the source z/OS platform and the target UNIX platformin
binary format using the file transfer tools available at the site (CFT, FTP, ...).

Compiling the Transcoding Programs
The generated COBOL programs used for transcoding and reloading are named:
RELTABLE-<logical file name>
Example:
RELTABLE-ODCSFO0.pco

These COBOL programs should be compiled with the target COBOL compiler using the options
described in the COBOL converter section of Oracle Tuxedo Application Workbench Reference
Guide.

Each program produces an output file that is then read by the SQL*LOADER utility.

Executing the Oracle Object Creation Scripts
The option -a of the 1oadtable-<..>.ksh scripts enables the creation of the Oracle objects.

Executing the Transcoding and Reloading Scripts
The transcoding and reloading scripts have the follow parameters:

Synopsis

loadtable-<logical file name>.ksh [-d] [-t/-1] [-c <method>]
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Options

-d
Create the Oracle objects.

Transcode and reload the file.
Transcode and reload the file (same action as -t).

-cftp:<...><..>
Implement the verification of the transfer (see Checking the Transfers).

Examples

Files

1-164

For the example provided in Mapping Parameter File (mapper-<configuration name>.re), the
generated script is:

o |oadtable-ODCSFOB.ksh

By default, the input file islocated in the directory indicated by spata_sourck, and the output
fileisplaced in the directory indicated by $paTa.

These files are named with the logical file name used in the Mapping Parameter File
(mapper-<configuration name>.re) configuration file.

An execution log is created in the directory indicated by smMT_1.0G.

A return code different from zero is produced when a problem is encountered.

Checking the Transfers
This check uses the following option of the 1oadtable-<logical file name>.ksh

-c ftp:<name of transfered physical file>:<name of FTP log under UNIX>

Note: Thisoption enables the verification after the reloading that the physical file
transferred from z/OS and the file reloaded on the target platform contain the same
number of records. This check is performed using the FTP log and execution report
of the reloading program. If the number of recordsis different, an error messageis
produced.
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Compiling the Access Routines and Utilities

The COBOL and PRO* COBOL access routines should be compiled using the target COBOL
compilation options described in the Oracle Tuxedo Application Rehosting Workbench
Reference Guide.

Troubleshooting

This section describes problems resulting from usage errors that have been encountered when
migrating files from the source to target platform.

Overview
When executing any of Tuxedo ART Workbench tool users should check:

o If any error messages are displayed on the screen.

e |If theMapper-log-<configuration name> file containsany errors (see Common
Problems and Solutions).

Error messages and associated explanations are listed in the appendix of the Oracle Tuxedo
Application Rehosting Workbench Reference Guide.
Common Problems and Solutions

Error: External Variable PARAM isnot set

When executing file.sh -gmi $HOME/trf STFILEORA thefollowing message appears:

Control of configuration STFILEORA

External Variable PARAM isnot set!

ERROR: Check directive filesfor configuration STFILEORA
Abort

Explanation

The variable sparaAM has not been set.

Error: Target directory does not exist
When executing file.sh -gmi $HOME/trf STFILEORAL thefollowing message appears:

Target output directory /home2/wkb9/trf is missing
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Check parameters: -i <output_directory> <schema>

ERROR : usage : file.sh [ [-g] [-m] [-1 <output_directory>] <schema_name>
-s <output_directory> (<schema>,...) ]
abort

Error: Unknown file organization
When executing file.sh -gmi $HOME/trf STFILEORA2 the following message appears:
Refine error...

Log
The contents of the Mapper-1og-STFILEORA2 log file include:
file PJO1AAA.SS.VSAM.CUSTOMER Oracle
file logical name ODCSFO0B
**%* Unknown file organization : INDEXD
mapping record VS-ODCSFO0-RECORD
record VS-ODCSFO-RECORD: logical name VS
record VS-ODCSFO-RECORD: logical name VS
record VS-ODCSFO-RECORD REDEFINES:
field VS-CUSTBDATE as opaque (default strategy)
record VS-ODCSFO-RECORD REDEFINES:

field VS-CUSTBDATE as opaque (default strategy)

Explanation
Thefileis configured with afile organization of INDEXD instead of INDEXED.

Error: Theillegal text is: " converted

When executing: file.sh -gmi $HOME/trf STFILEORA the following message appears:

HAHHAH AR AR H A H A H AR H A AR R R R A
Control of configuration STFILEORA
HA#HAHF SR AR HASH AR HAHH RS HAHHH

Control of templates
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OK: Use Default Templates list file

File name is /REFINE/convert-data/default/file/file-templates.txt
FHEFHHH A H SRR SRS S

Control of Mapper

FHEFHSHF A H SRR RS SSH

COMPONENTS GENERATION

Parsing mapper file /home2/wkb9/tmp/mapper-STFILEORA.re.tmp
Parse error at character position 1346 in file:

/home2 /wkb9/tmp/mapper-STFILEORA.re. tmp.
The illegal text is: "converrted

table name CUSTOMER

include \"COPY/ODCSFOB.cpy\"

map record VS-ODCSFO-RECORD defin"
While parsing in grammar UFAS-CONVERTER: :MAPPER-INPUT-GRAMMAR,
CONVERRTED is a symbol, which is not a legal token

at this point in the input. The legal tokens at this point are:

:END "templates" "filler" "field" "file" "one-for-n" "multi-record"

"table" "transferred" "mode-tp" ... [14 others]

*ERROR*: parse error is found in /home2/wkb9/tmp/mapper-STFILEORA.re.tmp.

Refine error...
/tmp/refine-exit-status.snl CMmEINY F25625
ERROR: generation aborted

abort
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Explanation
A typing error in the word ‘ CONVERTED’ was made in the mapping file.
Error: Cannot find filein file table named PJO1AAA.SS.VSAM .CUSTOMERS

When executing: file.sh -gmi $HOME/trf STFILEORA thefollowing message appears:

FHEFH AR R A
Control of configuration STFILEORA

FHEFHHH A H A H SRR RS

Control of templates

Project Templates list file is missing
/home2 /wkb9/param/file/file-templates. txt

OK: Use Default Templates list file

File name is

/Qarefine/release/M2_L4_1/convert-data/default/file/file-templates. txt
HHAFHSHHRHH A H SRR RS H

Control of Mapper

HHAHHSHHRHH A H S H AR RHERSHH

COMPONENTS GENERATION

Point 1 !!
Warning: Can't find file in file table named PJ01AAA.SS.VSAM.CUSTOMERS

Point 2 !!

Refine error...
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/tmp/refine-exit-status.IvmFDYsYDdr31956

ERROR : generation aborted

Abort

Explanation

The name of thefile to convert to an Oracle table does not correspond to the name present in the
Datamap file

Executing File-to-UDB (formerly DB2/Luw) Converter
Programs

This section describes the tasks of unloading, transfer and reloading using the components
generated using Tuxedo ART Workbench (see Generating the Components).

Preparation

Configuring the Environments and Installing the Components

Installing the Unloading Components Under z/0S

The components used for the unloading (generated in $HOME/trf/unload/file) should be
installed on the source Z/OS platform. The generated JCL may need adapting to specific site
constraints including JOB cards, library access paths and access paths to input and out put files
(Data Set Name — DSN).

Installing the Reloading Components Under UNIX

The components used for the reloading (generated in $HOME/ trf/reload/file) should be
installed on the target platform (runtime).

Installing the DB2/luw (udb) Object Creation Components

The components used for creating the Oracle objects (generated in $HOME/ SQL/ file/<schema
name>) should beinstalled on the target platform (runtime).

Setting the Target Platform Environment Variables

The following environment variables should be set on the target platform
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Table 1-35 Environment Variahles on Target Platform

Variable Value

DATA_SOURCE The name of the directory containing the files transferred from z/OS
to be reloaded.

DATA The name of the directory containing the physical files converted to

ASCII format and ready to be loaded to Oracle tables.

BIN The location of the generic reload and control scripts
(SHOME/trf/reload/bin)

TMPPROJECT The temporary directory.

MT_LOG Directory to contain execution logs.

NLS_LANG Set according to the instructions in the Oracle documentation.
DDL The location of the SQL scripts used to create Oracle objects

($SHOME/trf/SQL/file/<schema name>).

PATH This UNIX/Linux variable has to contain the directory of oracle
Tuxedo Application Runtime for Batch utilities

The following variable should be set according to the information in the Oracle Tuxedo
Application Rehosting Workbench Installation Guide:

e MT_DB_DBNAME.
e MT_DB_USER.

e MT_DB_PWD.

Unloading the JCL

An unloading JCL is generated for each z/OS file listed in the Datamap Parameter File
(Datamap-<configuration name>.re). These unloading JCLsare named <logical file
name>.jclunload. These JCL usethe REPRO function of the IDCAMS utility to unload the
files.

Note: The .jclunload extension should be deleted for execution under z/OS.
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Transferring the Files

Files should be transferred between the source z/OS platform and the target UNIX platformin
binary format using the file transfer tools available at the site (CFT, FTP, ...).

Compiling the Transcoding Programs

The generated COBOL programs used for transcoding and reloading are named:
RELTABLE-<logical file name>

Example:

RELTABLE-ODCSFO0. sgb

These COBOL programs should be compiled with the target COBOL compiler using the options
described in the COBOL converter section of Tuxedo ART Workbench Reference Guide.

Each program produces an output file that is then read by the SQL* LOADER utility.

Executing the Oracle Object Creation Scripts
The option -a of the 1oadtable-<..>.ksh scripts enables the creation of the Oracle objects.

Executing the Transcoding and Reloading Scripts

The transcoding and reloading scripts have the follow parameters:

Synopsis
loadtable-<logical file name>.ksh [-d] [-t/-1] [-c <method>]

Options
-d

Create the DB2/luw (udb) objects.
Transcode and reload thefile.
Transcode and reload the file (same action as -t).

-cftp:i<...>:<...>
Implement the verification of the transfer (see Checking the Transfers).
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For the example provided in Mapping Parameter File (mapper-<configuration name>.re), the
generated script is:

o |oadtable-ODCSFOB.ksh

By default, the input file islocated in the directory indicated by spata_sourck, and the output
fileis placed in the directory indicated by $paTa.

These files are named with the logical file name used in the Mapping Parameter File
(mapper-<configuration name>.re) configuration file.

An execution log is created in the directory indicated by $mMT_LoG.

A return code different from zero is produced when a problem is encountered.

Checking the Transfers
This check uses the following option of the 1oadtable-<logical file name>.ksh

-c¢ ftp:<name of transfered physical file>:<name of FTP log under UNIX>
Note: Thisoption enables the verification after the reloading that the physical file
transferred from z/OS and the file reloaded on the target platform contain the same
number of records. This check is performed using the FTP log and execution report

of the reloading program. If the number of recordsis different, an error messageis
produced.

Compiling the Access Routines and Utilities

The COBOL and Embedded-SQL access routines should be compiled using the target COBOL
compilation options described in the Oracle Tuxedo Application Rehosting Workbench
Reference Guide.

Troubleshooting

This section describes problems resulting from usage errors that have been encountered when
migrating files from the source to target platform.

Overview
When executing any of Tuxedo ART Workbench tool users should check:
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o |f any error messages are displayed on the screen.

o If theMapper-log-<configuration name> file containsany errors (see Common
Problems and Solutions).

Error messages and associated explanations are listed in the appendix of the Oracle Tuxedo
Application Rehosting Workbench Reference Guide.
Common Problems and Solutions

Error: External Variable PARAM is not set
When executing file.sh -gmi $HOME/trf STFILEUDB the following message appears:

Control of configuration STFILEUDB
External Variable PARAM is not set!
ERROR: Check directive filesfor configuration STFILEUDB

Abort

Explanation
The variable $parRAM has not been set.

Error: Target directory does not exist
When executing file.sh -gmi $HOME/trf STFILEUDB1 thefollowing message appears:

Target output directory /home2/wkb9/trf is missing

Check parameters: -i <output_directory> <schema>

ERROR : usage : file.sh [ [-g] [-m] [-1 <output_directory>] <schema_name>
-s <output_directory> (<schema>,...) ]
abort

Error: Unknown file organization
When executing file.sh -gmi $HOME/trf STFILEUDB2 the following message appears:
Refine error...
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Log
The contents of the Mapper-1og-sTF1LEUDB2 log file include:
file PJO1AAA.SS.VSAM.CUSTOMER Oracle
file logical name ODCSFO0B
**%* Unknown file organization : INDEXD
mapping record VS-ODCSFO0-RECORD
record VS-ODCSFO-RECORD: logical name VS
record VS-ODCSFO-RECORD: logical name VS
record VS-ODCSFO-RECORD REDEFINES:
field VS-CUSTBDATE as opaque (default strategy)
record VS-ODCSFO-RECORD REDEFINES:

field VS-CUSTBDATE as opaque (default strategy)

Explanation
Thefileis configured with afile organization of INDEXD instead of INDEXED.

Error: The illegal text is: "converted
When executing: file.sh -gmi $HOME/trf STFILEUDB the following message appears:

HHAFHSHH A H A H SRR R R
Control of configuration STFILEUDB

HHAHHSHH A H A H SRR RS S

Control of templates

OK: Use Default Templates list file

File name is /REFINE/convert-data/default/file/file-templates-db2luw.txt
HHAHHSHH A H A H SRR SRS H

Control of Mapper

HHAHHSHH A H A H SRR SRS S

COMPONENTS GENERATION
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Parsing mapper file /home2/wkb9/tmp/mapper-STFILEUDB.re.tmp
Parse error at character position 1346 in file:

/home2 /wkb9/tmp/mapper-STFILEUDB.re. tmp.
The illegal text is: "converrted

table name CUSTOMER

include \"COPY/ODCSFOB.cpy\"

map record VS-ODCSFO-RECORD defin"
While parsing in grammar UFAS-CONVERTER: :MAPPER-INPUT-GRAMMAR,
CONVERRTED is a symbol, which is not a legal token

at this point in the input. The legal tokens at this point are:

:END "templates" "filler" "field" "file" "one-for-n" "multi-record"

"table" "transferred" "mode-tp" ... [14 others]

*ERROR*: parse error is found in /home2/wkb9/tmp/mapper-STFILEUDB.re.tmp.
Refine error...

/tmp/refine-exit-status.snl CMmEINY F25625

ERROR: generation aborted

abort

Explanation
A typing error in the word ‘ CONVERTED’ was made in the mapping file.

Error: Cannot find file in file table named PJO1AAA.SS.VSAM.CUSTOMERS
When executing: file.sh -gmi $HOME/trf STFILEORA the following message appears:

HHHH R R R R R R R
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Control of configuration STFILEUDB
HA#HAH AR AR HASH AR HA R AR A SRS HH
Control of templates

Project Templates list file is missing
/home2 /wkb9/param/file/file-templates. txt

OK: Use Default Templates list file

File name is

/Qarefine/release/M2_L4_1/convert-data/default/file/file-templates. txt
FHEFHHH A H AR RS

Control of Mapper

FHEFHHH A H A H SRR RS

COMPONENTS GENERATION

Point 1 !!
Warning: Can't find file in file table named PJ01AAA.SS.VSAM.CUSTOMERS

Point 2 !!

Refine error...
/tmp/refine-exit-status.IvmFDYsYDdr31956

ERROR : generation aborted

Abort

1-176 Oracle Tuxedo Application Rehosting Workbench Users Guide



Performing the Data Migration

Explanation

The name of thefileto convert to an DB2/Iuw (udb) table does not correspond to the name present
inthe patamap file.

Executing DB2-to-Oracle Generated Converter Programs

This section describes the tasks of unloading, transfer and rel oading using the components
generated using Tuxedo ART Workbench (see Generating the Components).

Preparation

Configuring the Environments and Installing the Components

Installing the Unloading Components Under z/0S

The components used for the unloading (generated in $HOME/ trf/unload/rdbms) should be
installed on the source z/OS platform. The generated JCL may need adapting to specific site
constraints including JOB cards, library access paths and access paths to input and output files
(Data Set Name — DSN).

Installing the COBOL programs for DB Load/Unload on target platform.

The COBOL programs for DB Load/Unload (generated in $HOME/ t r £ /DSNUTILS/<schema
name>) should be compiled and installed on the target platform (runtime).

Installing the Reloading Components on the Target Platform

The components used for the reloading (generated in $HOME/ tr £/ reload/rdbms) should be
installed on the target platform (runtime).

Table 1-36 lists environment variables that should be set on the target platform.

Table 1-36 Variables and Their Platform

Variable Value

DATA_SOURCE The name of the directory containing the unloaded DB2 tables
transferred from z/OS to be reloaded into Oracle tables.

BIN The location of the generic reload and control scripts
($HOME/trf/reload/bin)

TMPPROJECT The temporary directory.
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Tahle 1-36 Variables and Their Platform

Variable Value

MT_LOG Directory to contain execution logs.

CTL Directory containing the <table name>.ctl filesused by the
SQL*LOADER ($HOME/trf/reload/rdbms/<schema
name>/ctl).

DATA_TRANSCODE Temporary directory used by the DB2 binary data transcoding script

(contains temporary filesin ASCII format).

Note: Incaseof CLOB or BLOB datatype migration, thisdirectory
could contain a sub-directory named <column_name>.

NLS_LANG Set according to the instructionsin the Oracle documentation.

NLS SORT Set according to the instructions in Oracle Tuxedo Application
NLS COMP Workbench Reference Guide and other Oracle documentation.
NLS DATE FORMAT Set according to the instructions in Oracle Tuxedo Application

NLS TIMESTAMP_FORM Workbench Reference Guide and other Oracle documentation.
AT

NLS TIME_FORMAT

The following variable should be set according to the information in the Oracle Tuxedo
Application Rehosting Workbench Installation Guide:
e MT_DB_LOGIN.

The reloading script 10oadrdbms-<table name>.ksh Usesthe sor.*1.DrR Oracle utility. Because
this utility can access to ORACLE servers only, this script should be used in ORACLE servers
and not with client connection. This variable should not contain an e<oracle_sid> string,
especiadly for this reloading step.

Installing the MWDB20RA Package Component on the Target Platform

The package functionscalled by COBOL programs (converted by the COBOL Converter) should
be installed on the target platform (runtime).

Thepackagesarelocated inREFINEDIR/convert-data/ fixed-components/MWDB20RA.plb
and REFINEDIR/convert-data/fixed-components/MWDB20RA_CONST.plb. You should
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adapt the MwDB20RA_CONST . p1b package and install these packages under SQLPLUS as
documented in the DB2-to-Oracle Convertor.

Unloading JCL

To unload each DB2 table, a JCL using the IBM unloading utility is executed. Generally, the
unloading utility creates three files for each table:

e adatafile,
e alogfile,

e aSYSPUNCH file.
If the table contains a CLOB or BLOB data types, the unloading utility creates:

e adatafilefor each column and row.

These files are written in another dataset or directory if the parameter
rdbms:jcl_unload_lob_file_system iSrespectively set topds Or hfs.

These unloading JCLs are named <table name>.jclunload

If the table name is longer than eight characters, Tuxedo ART Workbench attributes an
eight-character name to the z/OS JCL as close as possible to the original. The renaming process
mai ntains the uniqueness of each table name.

e Example:opcsFox1.jclunload

In the example used in this chapter, the table named ODCSFO islengthened to ODCSFOX 1 when
naming the Z7OS JCL.

Transferring the Files

The unloaded data files should be transferred between the source z/OS platform and the target
UNIX platform in binary format using the file transfer tools available at the site (CFT, FTP, ...).

The LOG and SY SPUNCH files should be transferred in text mode.

Thefilestransferred to the target UNIX platform should be stored in the $paTa_source
directory.

The CLOB and BLOB data files should be transferred in binary mode and stored in the
$DATA_SOURCE/<schema_name>.<column_name> di rectory.

The MBCS data files should be transferred in text mode and properly transcoded by transfer
tools. For more information, see Oracle Tuxedo Application Workbench Reference Guide.
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Note: On MVS, the Rehosting Workbench attributes a six-character nameto <column_name>
to the dataset or directory, added with adigit number (1 for the first CLOB or BLOB
column of thetable, 2 for the second, ...). On UNIX/Linux platform, the 1oadrdbms . sh
script usestherea column_name.

Creating the Generated Oracle Objects

The scripts creating Oracle objects (tables, index, constraints, ...) are created in the
$HOME/trf/SQL/rdbms/<schema name> directory. They should be executed in the target
Oracle instance.

The <schema name>.1st file contains the names of all of the tablesin hierarchical sequence
(parent table then child tables).

Table 1-37 liststhe DB2 objects managed by Tuxedo ART Workbench and the name of the script
used to create them:

Table 1-37 DB2 Objects
Object Type File name Notes

TABLE TABLE- Onefile per Table. Thefile contains the
<target_table_name>.sqgl table construction, with column names, data
type and attribute(s).

Constraints, except NULL/NOT NULL
attributes, are not written in thisfile

INDEX INDEX- Thisfilecontainsall the CREATE INDEXes
<target_table_name>.sql associated with the table
<target_table_name>. Thisfilewill
not be generated if there are no indexes
defined on the table

<target_table_name>

Indexes are: unique or not Unique constraint

CONSTRAINT CONSTRAINT- Thisfile contains al constraints associated
with the table <target_table name>. This
file will not be generated if there are no
constraints defined on the table
<target_table name>

<target_table_name>.sqgl

Constraints are: Primary Key, Unique,
Check and Foreign key
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Tahle 1-37 DB2 Objects

Object Type File name Notes
COMMENT COMMENT - Contains all comments for table and
<target_table_name>.sqgl columns. Onefile per table
VIEW VIEW-<schema_name>.sqgl Thisfilecontainsall theViewscreated inthe
source database/schema.

In thisrelease, the Select statements are not
automatically converted into the target
database |language.

SEQUENCE SEQUENCE-<schema_name>.s  Thisfile contains all the CREATE
gl SEQUENCEs already created on the source
Database.
SYNONYM SYNONYMS-<schema_name>.s  Thisfile contains all the CREATE
gl SYNONY Ms aready created on the source
Database.
IDENTITY IDENTITY- In case of IDENTITY when migrating from

<target_table_name>.sqgl DB2to ORACLE, Tuxedo ART Workbench
creates a Sequence and a Trigger object.

Compiling the Transcoding Programs

The generated COBOL programs used for transcoding are named:
MOD_<table name>.cbl

For the example used in this chapter the generated programis:

® MOD_ODCSFO.cbl

The programs should be compiled using the target COBOL compiler and the options documented
in the Oracle Tuxedo Application Rehosting Workbench Reference Guide.

The programs produce RECORD SEQUENTIAL files on output that will then be read by the
SQL*LOADER Utility.

Listing 1-65 FILE CONTROL Example — Extracted from Program: Mop_oDCSFO . cbl

SELECT MW-SORTIE
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ASSIGN TO "SORTIE"
ORGANIZATION IS RECORD SEQUENTIAL
ACCESS IS SEQUENTIAL

FILE STATUS IS IO-STATUS.

The generated COBOL programs used for transcoding CLOB columns are named:

CLOB_<table name>_ <column_name>.cbl

Executing the Transcoding and Reloading Scripts
The scripts enabling the transcoding and rel oading of data are generated in the directory:

SHOME/trf/reload/rdbms/<schema name>/ksh

The format of the script namesis:

loadrdbms-<table name>.ksh

In the example used in this chapter, the script is named:

loadrdbms-ODCSFO .ksh

Each script launches the COBOL program that performs the transcoding and then the
SQL*LOADER utility. The CTL files used by SQL*LOADER are named:

<table name>.ctl.

The CTL file used for the example in this chapter is named:

ODCSFO0.ctl

Transcoding and Reloading Command
The transcoding and reloading scripts have the following parameters:

Synopsis
loadrdbms-<table name>.ksh [-t | [-0|-T]] [-1] [-c: <method>]
Options

-t
Transcodes the fileand all BLOB or CLOB filesif exist.
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-T
Transcodes the file associated to the table only (except for CLOB and BLOB files). This
option is used when atable contains CLOB or BLOB columns.
-0
For BLOB columns: creates only an UNIX link to all binary BLOB transferred files.
For CLOB columns: transcodes only all binary CLOB transferred files.
Reloads the data into Oracle table.
-C rows:
Implement the verification of the transfer (see Checking the Transfers).
Examples

For the example provided in Example of a Migration of DB2 Objects, the generated script is:

® loadrdbms-ODCSFO.ksh

Checking the Transfers
This check uses the following option of the 1oadrdboms-<table name>.ksh

-C rows

Note: This option verifies after the reloading that the reloaded Oracle table contains the
same number of records as the equivalent table unloaded from z/OS by the DB2
unloading utility. If the number of recordsis different, an error message is produced.

Troubleshooting

This section describes problems resulting from usage errors that have been encountered when
migrating data from a source DB2 database to atarget Oracle database.

Overview
When executing any of Tuxedo ART Workbench tools, users should check:
o If any error messages are displayed on the screen.

e |f the rdbms-converter-<schema name>.log file containsany errors (see Common
Problems and Solutions).

Oracle Tuxedo Application Rehosting Workbench Users Guide 1-183



Oracle Tuxedo Application Rehosting Workbench Users Guide

1-184

Error messages and associated explanations are listed in the appendix of the Oracle Tuxedo
Application Rehosting Workbench Reference Guide.

Common Problems and Solutions
Error: RDBMS-0105

When executing $SREFINEDIR/$VERS/rdbms.sh -Cgrmi $HOME/trf PJ01DB2 STFILEORA the
following message appears:

Fatal RDBMS error.
Error: RDBMS-0105: Catalog for /home2/wkb9/param/system.desc is out of date
and needs to be updated externally.

Refine error...

Explanation
Changes have been made to the DDL, re-perform the catal oging operation.

Error: conversion aborted. Can not read

When executing $REFINEDIR/$VERS/rdbms.sh -Cgrmi $HOME/trf SCHEMA thefollowing
message appears:

Refine error...
/tmp/refine-exit-status.MOazZwgTphIN14075

ERROR : conversion aborted . Can not read
/home?2 /wkb9/tmp/outputs/SCHEMA /rdbms-converter-SCHEMA.log log file

abort

Explanation
The schema name is not known.

Error: Configuration file /db-param.cfg is missing!

When executing $REFINEDIR/$VERS/rdbms.sh -Cgrmi $HOME/trf PJ01DB2 thefollowing
message appears:

HAHHA R AR AR H AR H AR AR A AR AR AR H AR H AR HABA AR AR AR HASHA S H AR H AR AR AR HA RS S
CONVERSION OF DDLs and CTL files and GENERATION of directive files

ERROR : Configuration file /db-param.cfg is missing !
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ERROR : Error in reading configuration file

Abort

Explanation
The external variable PARAM is not set.

Error: Target output directory... is missing

When executing SREFINEDIR/$VERS/rdbms . sh -Cgrmi $HOME/bad-directory PJ01DB2 the
following message appears:

Target output directory /home2/wkb9/bad-directory is missing

Check parameters: -i <output_directory> <schema>

ERROR : usage : rdbms.sh [ [-c|-C] [-g] [-m] [-r] [-i <output_directory>]
<schema_name> ] -s <output_directory> (<schema>,...) ]

abort

Explanation

The target directory does not exist.

Error: Abort when using -c option... in case of unsupported features
When executing $REFINEDIR/$VERS/rdbms.sh -c¢ WWARN the following message appears:
WARNING: some unsupported db2 objects have been ignored by this tool.

Check file /home2/wkb9/tmp/outputs/WWARN/unsupported-WWARN.log to see a
detail of those objects.

ERROR:

RDBMSWB-0199: conversion aborted due to 26 Warning message(s). Check

previous error messages and try -C option instead of -c
abort

Explanation

The DDL contains some unsupported features. Check thewarning files. Y ou canignorethisabort
by replacing the -c option with -c option.
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See Also

e Tuxedo ART Workbench Reference Guide
e Tuxedo ART for Batch Users Guide

e Tuxedo ART for CICS Users Guide

e Tuxedo ART for IMS Users Guide

Appendix A: Oracle Tuxedo Application Rehosting Workbench MBCS Support
e Appendix B: The Simple App Application
e Appendix C: Oracle Tuxedo Application Rehosting Workbench Logs
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APPENDlxa

Appendix A: Oracle Tuxedo Application
Rehosting Workbench MBCS Support

This chapter contains the following topics:
e Purpose
e Procedures

o Utility

Purpose

Oracle Tuxedo Application Rehosting Workbench (Tuxedo ART Workbench) supports
Multiple-Byte Character Set (MBCS) for code conversion, which includes (but not limited to)
Japanese, Chinese and Korean. Variable names with MBCS support for code conversion and
MBCS support for data conversion are not supported.

Procedures
Converting the Code Containing the MBCS Characters

Following are the typical proceduresto convert code which includes MBCS using Tuxedo ART
Workbench:

1. Fetch the source code assets (including COBOL, COPY BOOK, JCL, MAP) from mainframe
using FTP tool with binary mode.
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Use code page conversion utility (e.g. ICU uconv) to convert the multiple-byte charactersin
EBCDIC encoding (e.g. IBM-1390) in the source assets to multiple-byte charactersin
encoding on open system (e.g.,. Shift-JS).

Use other tools provided by Tuxedo ART Workbench to convert the source code assets, e.g.
COBOL Converter, JCL Converter.

Migrating the Data Containing the MBCS Characters

Thetypical proceduresfor migrating DB2 data (which includes MBCS characters) using Tuxedo
ART Workbench are asfollows:

1

Set thefollowing db-param. c fg parametersto generate the unload scriptswhich unloadsthe
db2 datain “csv” format:

rdbms:jcl_unload_utility name:dsnuproc

rdbms:jcl_unload_format_file:csv

Invokethe Tuxedo ART Workbench on migration platform and upload the unload scriptsinto
the source platform.

Log in the source platform and unload DB2 data that contains MBCS characters.
Run"tso ftp" command to connect the target platform.

Set the transfer options using ftp commands:

locsite encoding=MBCS

locsite mbdataconn=(file_system_codepage, network_transfer_codep)
locsite mbsendeol=CRLF

file_system_codepage and network_trans fer_ codepagee dreé the corr%pondi ng
Mainframe code pairsto your target MBCS. For example, for Simplified Chinese character
set, choose 1BM-5488 @S file_system_codepage and IMB-1388 Of UTF-8 aS
network_transfer_codepage.

Run“ftp put”command to transfer the datafile to target platform.

Set NLs_LaNG environment parameter and reload the data file without transcoding. For
example, export NLS_LANG="SIMPLIFIED CHINESE_CHINA.XXXX"

For information about the typical procedure of converting the data file containing MBCS from
DB2 on Mainframe, refer to the Tuxedo ART Workbench Reference Guide.
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Utility

Utility
ICU uconv utility isrecommended to convert the multiple-byte charactersin EBCDIC encoding

in the source assets to multiple-byte characters in encoding on open system.

The typical usage of uconv utility is asfollowing:

uconv -f [source_encoding] -t [dest_encoding] -o [output_file_name]

source_file_name

For example, the following command converts the input.bmsfile which isencoded in IBM-1390
to output.bms file which is encoded in Shift-JIS;

uconv -f ibm-1390 -t shift-jis -o output.bms input.bms

Oracle Tuxedo Application Rehosting Workbench Users Guide A-3



Appendix A: Oracle Tuxedo Application Rehosting Workbench MBCS Support

A-4 Oracle Tuxedo Application Rehosting Workbench Users Guide



APPENDIXG

Appendix B: The Simple App
Application

This chapter contains the following topics:
e Introduction
e Description of the Simple App Components

e Using Oracle Tuxedo Application Rehosting Workbench to Rehost the Simple App

Simple App Functionalities

Using the Simple App Application

Simple App APIs

e Simple App Documentation References

Introduction

This chapter isintended to be a step by step guide to rehosting the Simple App Application. It
will walk you through each step in using the Oracle Tuxedo Application Rehosting Workbench
(Tuxedo ART Workbench) to rehost the application. In order to begin any rehosting project you
must obtain the source code located on the mainframe. Appendix 4 - Extracting and Transferring
Mainframe Componentsisaguideto achieving this. The source code and datawas copied to your
machine during the installation of the Oracle Tuxedo Application Rehosting Workbench. By
defaultitwill bein.../art_ wb12cR1/samples/STFILEORA. It isrecommended that you copy this
directory to awork area before using the Workbench so that you will have a clean copy that you
can always go back to should something go wrong during the rehosting process or if you or
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somebody else would like to do the sample rehosting again. For the purpose of this exercise, we
will assumethat .../art wb12cR1/samples/STFILEORA has been copied to /lab.

Description of the Simple App Components

This section describes the Simple App component architecture and the online and batch
interactions.

Figure 0-1 Simple App Component Architecture

HCTL DPROGRAM("PCMMO0Z")

HCTL PROGRAM("PCMMO03"} — T

Moo3 XCTL . ("P@BMOOL™} | 1001 I | 1002 I
l l

PROGRIM
("BGMMO01" ) ‘

Customer
Maintenance

Customer
Inquiry

P@P1003 RETUERN o0l a0z

e —
METAO0 _Co s CUSTOMER, FERORT
= ]*L/J

asmt o ye)
custaER .
C —
e : —
—
—

00_QSAM_CUSTGMER
0 _QSEM. CUSTOMER . UBDATE

Customer

List of Components by Type

CICS Screens
Name Description
MAPMO00 Customer maintenance entry menu.
MAPM0O1 Customer datainquiry screen.
MAPM002 Customer data maintenance screen (new customer, update and delete customer).
MAPMO03 Customer list screen.
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CICS Programs
Name Description
PGMMO000 Customer maintenance entry program.
PGMMO001 Customer datainquiry program.
PGMM002 Customer data maintenance program (new customer, update and del ete customer).
PGMM003 Customer list program.

Batch Programs

Name Description

PGMMBO00 Initial load of the vsau file. Thisfileisloaded from a QSAM file.

PGMMBO1 This program produces alist of the customers stored in the vSAM customer file.
PGMMBO02 This program accesses a QSAM file containing commands and data used to update

the main vsaum customersfile.

Transaction Codes

Name Description

MO00 Main entry transaction code (program PGMM000).
MOO01 Customer inquiry (program PGMMO001).

M002 Customer maintenance (program PGMM002).
M003 Customer list (program PGMMO003).
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Jobs

Name Description

DEFVCUST Thisjob runsan IDCAMS utility in order to DELETE & DEFINE the vsaM
customer file.

CHKVCUST Thisjob runsan IDCAMS utility and REPRO the vsauM fileinto aQSAM which can
be easily read and checked.

LODVCUST Thisjob runsthe PGMMBO0O0 batch program which reads a sequential file containing
data to be stored in the newly defined vsaMm customer file.

PRTVCUST Thisjob runs the PGMMBOL1 batch program which produces a report of the
customers referenced in the vsau file.

UPDVCUST Thisjob runsthe PGMMBO02 batch program which contains data used to update the

VSAM customer file.
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Map Descriptions

Listing 0-1 MAPMO00O - Simple App Main Menu

B T T T S T < T L e T <
MAPMOO0O Simple sample application 07/17/2009

M000

Customer’s identifier: aaaaaa

PF04 - Customer’s List

PFO05 - Add a new customer

PF06 - Modify an existing customer
PF07 - Delete an existing customer
PF08 - Customer’s inquiry

PF03 - Quit application

Info: Type a customer number, select an action and press Enter.

QERECERECEEECERERERELRELALELRELAELALEAERALEEERLEELRELRELRERERERELRELRELRERELLELLECLELLRERERERERERERE

Oracle Tuxedo Application Rehosting Workbench Users Guide B-5



Appendix B: The Simple App Application

Listing 0-2 MAPMO0O03 - Customer List

B R T T S R T
MAPMO0O03 Customers list
M003
Sel ID Last name First name

@ (QRELERERER CECECECECEERLELRELRELRELRERELAERERER RURERERERERRERERERER
@ (QRERREEREE CERLRELLRERLRECREERAEERLRERLRERLRELRE RLrERLRERRERRERERRERRER
@ (CRELELERER CECERERELELRERERERELELRELERERER RURERERERERRERERERER
@ (QREQERERER CECEEECECEERERELRELRELRELRELAERERER fERERERERERRERERERER
@ (QRERLREEREE CERLRELLRERLRELLRELLAEERLRERLRERLRLEERE RLrERLRERRERRERERRERRER
@ (CRELELERER CECELERELERLRERERERELRELELERERER RURERERERERRERERERER
@ (CRERERERER CECECECECERERELRELRLELRELRELRELERERAER fURERERERERRERERERER
@ (QRERLREEREE CERLRELLRERLRELRELLALEERLRERLRERLRELRE RLrERLRERRERRRERRERRER
@ (CRELERERER CECERERERERLRERERLRELCELRELERAERER RURERERERERRERERERER

@ (CRERERERER CECECECECEERELEELRLELRELRELRELAERERAER fURERERERERRERERERER

-PF7: Page up -PF8: page down -PF3: return to previous menu

VA

07/17/2009

@e/ee/eeee
Qe/ee/eeee
Qe/ee/eeee
@e/ee/eeee
Qe/ee/eeee
Qe/ee/eeee
@e/ee/eeee
Qe/ee/eeee
Qe/ee/eeee

Qe/ee/eeee

-Info: Enter a non blank character and press enter to view customer's data

QEERLEERLRELLRECLLEELALELLELLELCLRELCRELCLALEERLRERARERLRERLRERLRLELRLELRLRERRERRLERLALERRRERRERRERRE
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Listing 0-3 MAPMO0O01 - Customer Detailed Information

B R T T T S S S A < B T TT T A SR -
MAPMMO1 Customer's detailed information 07/17/2009

M001

Customer's identifier: aaaaaa

-Last name : A2333333333333333333333333333a

-First name_____: aadaaldaaidaaiddaaidaaaa

-Address : Addaadaadaadaaadaadaaidaaidaaaaa

-City. : Addaddaddaadaadadaaaa

-State : aa

-Birth date___ : aa/aa/aaaa

-Email : 223332333333323233233233333333333334333aa
-Phone number__ : aaaaaaaaaa

-PF03: return to previous screen

QEEAEREREREEEEELRERLRELAELAERAELALELALERALRLERELLRLLRLLRERERERELRELRELRERERERERERERRRRRERERERERE
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Listing 0-4 MAPMO002 - Customer Maintenance

B R T~ R T S S T U A
MAPMO0O02 Customer's maintenance 07/17/2009
MO002

Customer's identifier: aaaaaa Action: @eeee@

-Last name : dddaaaaaaaadadadadadadaaaaaaaa

-First name____ : adaaaaaaaaaaaaaaaaaa

-Address : ddaaaaaaadadadadadadadaaaaaaaa

-City : adaaaaaaaaadadaaaaaa

-State : aa

-Birth date_  : aa/aa/aaaa

-Email : Adddadadadadadadaaaanaaaaaaaaaaaaaaaaaaa
-Phone number__: aaaaaaaaaa

-PFll: clear screen
-PF12: confirm action

-PF03: return to previous screen

QELRELRELELELELERERELERELRERERERELRELAELAELAELRLERLERELRELRELELLRERERERERERERERERERRRERRERRRR
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Program Descriptions

CICS Program Descriptions

PGMMO0O00 (customer maintenance main menu)

PGMM 000 isthe Simple Sample Application (access) main menu program. From thisscreen, one
may access the following functions:

e Customer list
e Customer detailed information inquiry

e Customer data maintenance:
— Add anew customer
— Update customer information
— Delete an existing customer

Each function can be reached by entering a specific function key. At the end of the called
function, areturn is performed back to this main menu.

Controls:

This program checks that a valid customer identification number is entered when accessing the
inquiry and maintenance functions.

PGMMO0O01 (customer detailed information inquiry)

This program receives — thru the communication area— a customer identification number. The
program accesses the vsam customer file in order to display the customer data when known.

Controls:

Assuming that no data can be modified by this program, no control is performed.
PGMMO002 (customer data maintenance)
This program enables the maintainance of the vsam customersfile:

e Creating a new customer

e Updating an existing customer

e Deleting an existing customer
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PGMMO002 receives an action code and, when needed, a customer identification number. The
action to be performed is displayed on the screen (CREATE, UPDATE Of DELETE).

Controls:
The controls carried-out depend on the action to perform.

When creating a new customer, the programs checks that:

e The Customer identification number is not null, is numeric and not already used in the
customer vsau file.

e Last name, first name, address, city, email address and birth date are not equal to spaces.

e Phone number, if not equal to zero, must be numeric.

When updating an existing customer, the controls are the same as the ones used when creating a
customer except for the customer identification number, which cannot be modified.

Thereis no control performed on a customer deletion request.

PGMMMO3 (customer list)

This program lists the customers stored in the vsawu file. A limited number of customers are
displayed on each screen —the pr7 and pr8 keys give access to the previous and next pages. A
non-blank character at the beginning of a customer's line gives access to the detailed customer
information screen (see program PGMMO001).

Batch Program Descriptions

PGMMBOO (VSAM file initial load)

This batch program reads a sequential file containing datato be stored in the vsawu file. For each
record in the entry file, avsam record is created. The vsaum file must have been DELETED and
DEFINED prior to executing this program. All data from the entry file is supposed to be valid:
hence, no control is performed within this program.

PGMMBO1 (customer report)

PGMMBOL1 reads al the customer record from the vsau file and produces areport. An example
of the report produced isincluded in this document.
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PGMMBO2 (batch customer maintenance program)

Each input sequential file record contains a three characters action code (app, upp or DEL) and
the customer data required when creating anew customer or updating an existing one. Each input
line updatesthe vsam customer file. Customer datafrom the sequential fileissupposed to bevalid
so that no control is performed by the PGMMBO2 batch program.

Using Oracle Tuxedo Application Rehosting Workbenchto
Rehost the Simple App

Create Project

The Tuxedo ART Workbench Plug-in is an add-in to Eclipse which wasinstalled along with the
other components of the Oracle Tuxedo Application Rehosting Workbench. The Workbench is
started by clicking on the Tuxedo ART Eclipse IDE icon on your desktop.

If you not in the "Tuxedo ART Workbench and Runtime" perspective, you can switch it
manually, Click Window->Open Perspective->Other, and then select "Tuxedo ART Workbench
and Runtime", then click "OK".

To create anew ART project click File>New>Project and choose "ART->Tuxedo ART Project”
inthelist, then click Next.

On the Create an ART Project screen enter the name of your project and either leave Use default
location checked or uncheck it and enter the location of the work area that the Workbench will
use for the project, then click Next.

Onthe next screen enter the Workbench Install Directory if it isdifferent from the default already
shown and click Next.

On the next screen enter the location of the Application Source Folder. Thisisthe location that

you copied the provided application source and datato as outlined in the Introduction above. Y ou
can use the Browse button to locate the source directory. Append the directory "source" to this

location to indicate where the actual source files are located and click Next.

On the next screen the " Target Database Type" and "COBOL Compiler Type" are shown. These
can be modified if necessary, we user the default value in the case. Click Finish to continue.

Once you click Finish, the ART Project Wizard will create a new project and popul ate the work
areawhich was specified. The Workbench also creates additional working directories and
populates them with parameter files and scripts. The structure of the work areais shown below.
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Figure B-1 Work Area Structure

ART Workbench and Runtime - Eclipse
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The Create Project phase is now complete.

Import

Theimport phase copy sourcefilesinto the project. All the sub-directories of the directory which
you specified while creating project will be showed in the table as shown bel ow.
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Figure B-2 Import Wizard

‘.-% Import Wizard x|
Specify the sub-directories
Please select the sub-directories that you want to import, the root
directory is
Path Import Previously Impor
[=* Yes No
RDO Yes No
BATCH Yes No
Clcs Yes No
COPY Yes MNo
MAP Yes No
@ | cancet || Ensn |

Select all of them, then click "Finish". All the selected sub-directories will be imported into
project.

Prepare

The Prepare phase makes the source ready for further processing by the other components of the
Workbench. Since source from different mainframes may have been gathered in various ways,
the Prepare process alows you to choose the proper processing for your source. If after going
through the prepare process you realize that something is still not correct, you can execute
ART>Reset>Clean Prepare, which will be discussed later, to delete the output of the Prepare
phase and execute it again with different options.

To execute the Prepare phase, from the menu bar click ART>Prepare...

The Preparation Page will be displayed. On this screen you can check MBCS code page
conversion if required. For details on MBCS please reference the Appendix 3 - Tuxedo ART
Workbench MBCS Support. If during file transfer from the mainframe, <CR> characters were
inserted before the end of each line, you can check dos2unix conversion to remove these.

Thisistypically the case when the source files are transferred to a Windows machine. Check
Rename sourcefile nameto UPPER CASE, all the sourcefile'sbase namewill be changeto upper
case . Since none of this preparation is necessary for this application, click "Finish" to complete.
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Figure B-3 Preparation Wizard

= preparationWizara x|
Preparation Page.

Select the task to be processed in the preparation stage

[] Execute custom script before prepare steps

[] MBCS code page conversions

[¥] \dos2unix conversion

dos2unix location |/usr/bin/dos2unix ‘lﬁmwse ]

[] Rename source file name to UPPER CASE

[] Execute custom script after prepare steps

,

Analyze

The Analyze phase reads all of the sources and searches for missing components, dependencies,
and creates an abstract representation of the source which isused in the Migrate step that follows.
Reports are generated for each component type highlighting areas which must be addressed
before executing the Migrate phase.

Before executing the Analyze phase, you must define the data migration required for the
application. To do this, go to the STFILEORA Properties page by right clicking STFILEORA
then clicking Properties. Click File Converter,and compl ete the table below asfollows (Thetable
we need to be scrolled to the left to show al fields.):

The Simple APP Application includes two files as described in the Data Description section of
the Simple App Functionalities section above. Their names are

® PJO1AAA.S2.QSAM.CUSTOMER
® PJO1AAA.S2.QSAM.CUSTOMER.UPDATE

"QS-ODCSF0-RECORD" and "QS-ODCSFU-RECORD" respectively are the Record Names
specified in the COPYBOOK.

"opcsro" and "opcsrur respectively arethe L ogical Names used by Tuxedo ART Workbench
internally.

Oracle Tuxedo Application Rehosting Workbench Users Guide



Using Oracle Tuxedo Application Rehosting Workbench to Rehost the Simple App

The Organization of PJ01AAA.S2.QSAM. CUSTOMER iS Indexed. The Organization of
PJO1AAA.S2.QSAM.CUSTOMER . UPDATE iS "sequential”. The Key Offset and Key Length for
PJO1AAA.S2.QSAM.CUSTOMER are 0 and 6 respectively. Since
PJO1AAA.S2.QSAM.CUSTOMER . UPDATE iSa QSAM file, thereis no key.

The Converted property is Trueif the file will be migrated to an Oracletable or Falsewhenitis
left asafile.

The Transferred property meansit's apermanent file with data that needsto be transferred from
mainframe to open system. When set to True, Workbench will generate unload JCL ,
EBCDIC-to-ASCII transcoding programs, and reloading scripts.

The record structures of these files are defined in two COBOL copybooks and are entered in the
Include field:

® COPY/ODCSFO0.cpy

® COPY/ODCSFU.cpy
Once these properties are entered, click Apply. The status of the Propertiesfor STFILEORA
are shown below.

Figure B-4 Properties Page

[=

P Resource

= ART Workbench

Properties for STFILEORA

File Converter

File Schema Definition
Enter file description in the following table

-

Cataloger

File Schemsz File Name Recor|
P COBOL Converter m PJO1AAA S5 QSAM CUSTOMER -0ODCS5

DBZ Converter

File Converte

P Global

P JCL Converter
Builders

Project References
Run/Debug Settings
Task Repository

STFILEORA PJO1AAA 55 QSAM CUSTOMER UPDATE -ODCS

(oI

D)

ljnser‘t Another 5 Ruws] [Dgphcatel [Dgletel

Target System Information
Target RDEMS: ORACLE

Char Limit Until Varchar [2000

Task Tags
Target Cobol: Micro Focus
P validation
WikiText
[Restmrs Qefaults] [ Apply ]
T D}
®

All information in the table is required to generated the datamap file and mapper file used by file
converter.
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To makethe clear meaning of each columnin thetable, refer to "Datamap file" and "mapper file"
section in the Oracle Tuxedo Application Rehosting WorkbenchReference Guide.

Before executing catal og, we must configure scope.

Click ART->Analyze->Configure Scope, al the source files are recognized successfully, and all

of them will be process defaullt.

Let's configure the library path of COBOL programs. Select "BATCH" and click "Advanced
settings for sub-directory: BATCH", click "Libraries" tab-folder, click "New" to add alibrary,
changeit to "COPY". Similar to above steps, we set "COPY" asthe "Library" of sub-directory

"CICS".

Figure B-5

~
@

& Configure Scope Wizard ==

Analyze Configuration

Please configure scope, global settings can be set in property page.

[[] Execute custom script before analyze steps [~]
[] Source code uses MBCS encoding.

Path Source Exte Target Exter Iype Depend Process

jcL *jel Prjal = i ves

MAP *bms i *bms i BMs i ves

acs i +cbl i Cobol-TPR CoPY i Yes

RDO *rdo i *rdo i RDO i Yes Select All

DDL ddi { sal | saL-seript i Yes Selectnone ||
copY *.cpy H=l i Cobol-Library i Yes

BATCH +.cbl i bl { Cobol-Batch | COPY i Yes
Advanced settings for sub-directory: CICS

COBOL | jcL | sQL | SQL Libraries

Use Global
Use Global
Remove Cobol Reserved Words
=2}
Gl 1)

To execute the Analyze phase, from the menu bar click ART>Analyze>Catalog.

When the Catalog process is complete, review the console logs and the generated reports in the
Reports window as shown below. The reports are also available in CSV Format in the

.../Jworkspace/STFILEORA/Reports directory.
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Figure B-6 Reports View

[ Problems | & History | % Reports & . B Console G ¥ =8

STFILECRA

J Anomalies } Cobol Programs | Cobol Copy | JCL Files ‘ JCL Sub Files | JCL Jobs | Screens ‘ SQL Tables ‘}
PATH SUB PATH LINE SUB-LINE SEVERITY CATEGORY TAG DESCRIPTION E
BATCH/RSSABBOO chl 117 WARNING  SYNTAX PARSE-WARNING Clasing cons
BATCH/RSSABBOO.chl 144 WARNING SYNTAX PARSE-WARNING Closing cong
BATCH/RSSABBOO.chl 166 WARMING  SYNTAX PARSE-WARNING Closing cong
BATCH/RSSABBOO cbl 193 WARNING SYNTAX PARSE-WARNING Closing cong
BATCH/RSSABBOO.chl 220 WARMING  SYNTAX PARSE-WARNING Closing cong
BATCH/RSSABBOO.chl 242 WARNING SYNTAX PARSE-WARNING Closing cong
RATCHRSSARRNN h 201 \WARMING GYNTAY  PARSE.WARNING Clncinn rr‘\rn &

v

If it isnecessary to rerun the Catal oger, it is necessary to delete the generated POB files. Thiscan
be accomplished by clicking ART>Analyze>Clean POB Repository from the menu bar.

Convert

This phase converts the COBOL programs and other source artifacts so that they will be ready
for compilation and execution. It uses the abstract representation created during the Catalog
phase. It also creates JCL decksfor unloading dataon the mainframe and various scriptsfor future
steps in the rehosting process. Y ou can Convert individual types of components or all
components at once. To execute the Migrate phase, from the menu bar click ART->Convert
->Convert Components, and choose components to convert as need.

The Convert process will executeincrementally asadditional filesare added to or modified in the
source directory. However, if it is necessary to rerun the Convert phase, al of the target files
created can be deleted by clicking ART>Convert>Clean Target from the menu bar.

Configure

The Configure phase provides the capabilities to create makefiles for compiling components and
configuration files for the Oracle Tuxedo Application Runtime for CICS and Batch. It provides
options to create configuration for Tuxedo, CICS, and Batch independently. To execute the
Configure phase, from the menu bar click ART>Configure as shown in following wizard.
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Figure B-7 Configuration Wizard

8 Configuration Wazard

The Configure Wizard is used to create the required configuration files. Including makefiles
whichwill ultimately be used to build the rehosted application, the datamigration utilities created
during the Migrate phase, and files to setup the environment.

"Database” tab alows you to specify the target database; "Compiler” tab allows you to specify
the COBOL compiler options and PDK SH location; "Others' tab allows you to specify the ART
CICS Pre-compiler and the ART CICS mapgen configuration. "MBCS Trandate” can also be
configured here.

The Tuxedo/CICS/Batch/IM S tabs allow you to either choose the default configuration or
customize for your environment.

For more information, see Oracle Tuxedo Domain/CICS Runtime/Batch Runtime
documentation.

Build

This phase compiles application components and data rel oading programs and so on. To execute
the build phase, from the menu bar click ART->Build then choose one or more of the build
options. Y ou can convert individual types of components or all components at once.
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Deploy

The Deploy phase createstar files of al of the programs, scripts, JCLsand configuration filesthat
were created in the previous steps and are now ready for Deployment. Y ou can also choose Local
Deploy to compile and execute the rehosted application on the machine where the Workbench
has been running. The Deploy phase aso reloads data into file or database. Deployment to a
different machine requires some manual intervention, the scope of which is beyond this section.
To execute the Deploy phase, from the menu bar click ART>Deploy then choose one of the
Deploy options.

Click "ART->Deploy->Pack and Deploy", “Pack” generates four tar files which will be placed
to pack directory under project.

“Deploy Application” will un-tar the tar filesinto deploy directory.
Click "ART->Deploy->Setup Runtime” to setup BATCH, CICS, and IMS runtime environment.

Click "ART->Deploy->Reload File Data" to launch the wizard. Choose the data source location,
for example "/home/artuser/oracle/art_wb12110/samples/STFILEORA/data_source”, then click
the "Data Source File" column in thetable, all the filesin the front path will be listed, choose the
matched one. Choose the deploy location, then click "Finish" as show below.

Figure B-8 Reload File Data

& Reload File Data Wizard i
Reload File Data
Please selact a path
VSAM/QSAM source Location [).‘humEJxduu,‘Samples,'lvmcs_ sssss /STFILEDB2/data_soi| | Browse
File Schema File Name Data Source File
STFILEDB2Z PID1AAASS WSAM.CUSTOMER
STFILEDB2 PI01AAA S5 OSAM CUSTOMER REPOF;
STFILEDB2Z PID1AAASS.QSAM. CUSTOMER.UPDAT
STFILEDB2 PI01AAA S5 OSAM CUSTOMER
VSAM/QSAM deploy Location /home/xdou/Workspace LifeCycle/FILEDB2 EUC-KR/dep| | Browse
[ Execute custom script after setup steps
3\ A—
@ Cancel Finish
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Run

Click "ART->Batch Runtime->Start" to start Batch runtime. Y ou can manipulate jobs by further
clicking "ART->Batch Runtime->Manipulate Jobs'.

Click "ART->CICS Runtime->Start" to start CICS runtime. Y ou can open 3270 terminal to
connect CICS runtime and invoke your transaction.

Click "ART->IM S Runtime->Start" to start IMSruntime. Y ou can open 3270 terminal to connect
IMS runtime and invoke your transaction.
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Simple App Functionalities
Batch Processing

Batch programsand utilities are used to popul ate, update and list the vsam customer filethat hosts
the datamanaged within the application. Fivejobsaredelivered with the application. Thischapter
describes how they are used.

VSAM Customers File Initial Load

1. Step 1: vsau file definition

First, define the vsam customer file thru the IDCAMS utility using DELETE/DEFINE
commands.

2. Step 2: vsawm fileinitial load
The batch program PGMMBOO is used to populate the vsaw file.

3. Step 3: vsawu file check

IDCAMS s used to rEPRrO the vsau file into a sequentia file which can easily beread in
the Z/OS environment.

4. Step 4: vsau filereport

Batch program PGMMBO1 produces alist of the customers stored in the vsam customer
file.
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Figure 0-2 VSAM Customers File Initial Load

@ JOB: DEFVCUST

DELETE/DEFINE

@ JOB: LODVCUST

)
JOB: RPTVCUST

REPRO

—

VSAM Customer File Update
1. Step 1: vsawm file update

Batch program PGMMBO02 reads a sequential file containing updates to be performed on
vsaum customersfile. Theinput fileis sorted by the IBM standard sort utility.

2. Step 2: vsaw file report

Batch program PGMMBO2 is used again in order to check that the updates were correctly
applied to the vsam customersfile.
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Data Description

o=
) Gt

JOB: UPDVCUST

VSAM
REPCORT

UPDATE

Simple App Functionalities

Simple Sample Application relies on only one vsam main customer file. In order to keep the
migration process as simple as possible, the datais stored in displayable formats (in COBOL
syntax, this means that only "X" and "9" USAGE DISPLAY pictures are used).

The vsam customer file contains the following information:

Table 0-1 VSAM Customer Fle Description

Name Type Length Description

CUSTIDENT Num. 6 Customer identification number
CUSTLNAME Alpha | 30 Customer last name
CUSTFNAME Alpha | 20 Customer first name
CUSTADDRS Alpha | 30 Customer address (street...)
CUSTCITY Alpha | 20 City

CUSTSTATE Alpha | 2 State

CUSTBDATE Num. 8 Customer birth date
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Table 0-1 VSAM Customer Fle Description

Name Type Length Description
CUSTEMATIL Alpha | 40 Customer email address
CUSTPHONE Num. 10 Customer phone number

Thisvsau fileisaKey Sequenced Data Set (KSDS) based on the customer's identification
number. Each record contains 266 characters and the key is stored from position 1 to position 6.

VSAM Customer File COBOL Description

Listing 0-5 VSAM Customer File COBOL Description

01 ODCSFO-RECORD.

05 CUSTIDENT PIC 9(006).
05 CUSTLNAME PIC X(030).
05 CUSTFNAME PIC X(020).
05 CUSTADDRS PIC X(030).
05 CUSTCITY PIC X(020).
05 CUSTSTATE PIC X(002).
05 CUSTBDATE PIC 9(008).

05 CUSTBDATE-G REDEFINES CUSTBDATE.
10 CUSTBDATE-CC PIC 9(002).
10 CUSTBDATE-YY PIC 9(002).
10 CUSTBDATE-MM PIC 9(002).

10 CUSTBDATE-DD PIC 9(002).

05 CUSTEMAIL PIC X(040).
05 CUSTPHONE PIC 9(010).
05 FILLER PIC X(100).
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The following report is produced by program PGMMBOL that lists the customers from the vsam

file (METAWO00 . vSAM. CUSTOMER) after theinitial load.

Listing 0-6 Simple App Initial Report

07/16/2009

5553557901 09/07/1961
5559827383 01/24/1973
5556531100 10/12/1981
5558762763 07/27/1962
5553410156 12/25/1991

07/16/2009

5557811021 07/27/1962
5558981572 07/27/1962
5553122000 01/01/1958
5559990123 06/29/1929

PGMMBO1 Simple Sample Application
_ ID _ _ LAST NAME _ FIRST NAME _ CITY
1 Richardson Bobby New Orleans
2 Roberts Sammy San Francisco
3 Douglas Burt Atlanta
4 Ewing Samantha New York
5 Prince Anne Fresno
PGMMBO1 Simple Sample Application
_ ID _ _ LAST NAME _ FIRST NAME _ CITY
6 Colombus Christopher Colombus
7 Raul Menedez Fresno
8 Doors Bill Seattle
9 Awing Charles San antonio

The following report is based upon the updated customer file.

Listing 0-7 Simple App Updated Customer File Report

PGMMBO 1 Simple Sample Application

ID _ _ LAST NAME _ FIRST NAME _ CITY

07/16/2009

_ PHONE _B. DATE _
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10

11

12

Richardson
Roberts
Douglas
Ewing
Prince

_ LAST NAME

Colombus
Doors
Awing
Simms
LaFayette

Jackson

Bobby
Sammy Jr
Burt
Samantha
Anne

FIRST NAME

Christopher
Bill
Charles
Arthur

Eric

Mic

New Orleans
San Francisco
Atlanta

New York

Fresno

Colombus
Seattle

San antonio
New Orleans
Plesanton

Fresno

5553557901
5559827383
5556531100
5558762763
5553410156

_ PHONE

09/07/1961
01/24/1973
10/12/1981
07/27/1962

12/25/1991

_ _B. DATE _

5557811021 07/27/1950

5553122000
5559990123
5551298373
5554653213

5559800727

01/01/1958
06/29/1929
01/17/1969
02/12/1995

01/01/1959

Using the Simple App Application

B-26

This section provides an example use of the Simple App Applicationin order to illustrate how to

use the application.
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Viewing A Customer Record

1. Accessyour CICS environment and enter the Simple App main transaction code m000 to
connect to the application.

e e =

Digelg 11 & = &) FieiE|Eim|miniE|] o) 1)

2. Themain menuisdisplayed. Enter 000003 inthe Customer identifier field and pressthe PFO8
key to inquire on the customer.
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3. The customer record of Douglas Burt is displayed. Press PFO3 to return to the Mmain menu.

s
w| Plo|w] o Plwie]

Updating A Customer Record

1. FromtheMain menuenter 000003 inthe Customer identifier field and press the PFO6 key to
update customer information.
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2. Inthe update screen al data may be modified. The screen header shows the action upPDATE.
Change the customer’s address and press ENTER.

3. Press PF12 to confirm the updates. A Maintenance ok messageisdisplayed inthe screen
footer. To cancel your input, press pr03 in order to return to the Main menu.

1193 93(9715] 2]
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Printing Customer Reports

1. FromthemMain menu, press PFO4 to access the Customer List first page.

2. PressPF08to display the next pageinthelist. Press PFO7 to display apreviouspageinthelist.

Note: You can perform acustomer inquiry by entering any non-blank character in the selection
(Sel) column to the left of each customer.

Adding New Customers

1. FromtheMain menu press PFO5, the following screen is displayed.
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Action isset to CREATE in the screen header and fields are unprotected.

2. Enter the new customer dataincluding a valid non-existing identifier, and press ENTER.

The program validates the record; when no errors are found, a confirmation message is
displayed.

3. Press PF12 to create a new customer record.

A New customer added message is displayed.

4. Press PFO3 to return to the main menu.

Simple App APIs

This section lists the CICS APIswhich are used within the Simple App application programs.

MAP APIs
SEND

EXEC CICS
SEND MAP('MAPMO00O') MAPSET('MAPM000') ERASE
END-EXEC.
EXEC CICS
SEND MAP ('MAPMO000') MAPSET('MAPM000') CURSOR ERASE
END-EXEC.
EXEC CICS
SEND MAP('MAPMO001') MAPSET('MAPMOOl') FROM(MAPM0010O) ERASE

END-EXEC.

RECEIVE

EXEC CICS
RECEIVE MAP('MAPM000O') MAPSET ('MAPM000")
END-EXEC.

EXEC CICS
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RECEIVE MAP('ORDMAP1l') MAPSET ('ORDSET1') INTO (ORDMAP1)

END-EXEC.

NAVIGATION APIs
RETURN

EXEC CICS
RETURN
END-EXEC.
EXEC CICS
RETURN TRANSID('M000O') COMMAREA (COMM-RECORD)
LENGTH (LENGTH OF COMM-RECORD)

END-EXEC.

XCTL

EXEC CICS
XCTL PROGRAM (PGM-DEST) COMMAREA (COMM-RECORD)
LENGTH (LENGTH OF COMM-RECORD)

END-EXEC.

ABEND

EXEC CICS
ABEND ABCODE ('META"')

END-EXEC.

VSAM APIs
STARTBR

EXEC CICS STARTBR DATASET ('ODCSFO')

RIDFILD (CUST-FILE-KEY)
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EQUAL

RESP (RESPONSE-CODE)
END-EXEC.
EXEC CICS STARTBR DATASET ('ODCSF0')

RIDFILD (CUST-FILE-KEY)

GTEQ
RESP (RESPONSE-CODE)
END-EXEC .
EXEC CICS

READ FILE('ODCSFO0')
INTO (VS-ODCSF0-RECORD)
RIDFLD (CUST-FILE-KEY)
LENGTH (LENGTH OF VS-ODCSFO-RECORD)
EQUAL
RESP (RESPONSE-CODE)
END-EXEC .
EXEC CICS READ DATASET ('ODCSFO')
INTO (READ-ODCSF0-RECORD)
LENGTH (LENGTH OF READ-ODCSFO-RECORD)
RIDFLD (CUST-FILE-KEY)
EQUAL
UPDATE
RESP (RESPONSE-CODE)

END-EXEC.
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WRITE

EXEC CICS WRITE DATASET ('ODCSFO0")
FROM (MAJ-ODCSFO0-RECORD)
LENGTH (LENGTH OF MAJ-ODCSF0-RECORD)
RIDFLD (MAJ-CUSTIDENT)

KEYLENGTH (6)
RESP (RESPONSE-CODE)

END-EXEC.

REWRITE

EXEC CICS REWRITE DATASET ('ODCSFO')
FROM (READ-ODCSFO-RECORD)
LENGTH (LENGTH OF READ-ODCSFO0-RECORD)
RESP (RESPONSE-CODE)

END-EXEC.

READNEXT

EXEC CICS READNEXT DATASET ('ODCSFO')
INTO (CLT-ODCSFO0-RECORD)
LENGTH (LENGTH OF CLT-ODCSFO0-RECORD)
RIDFLD (CUST-FILE-KEY)
RESP (RESPONSE-CODE)

END-EXEC.

READPREV

EXEC CICS READPREV DATASET ('ODCSFO')
INTO (CLT-ODCSFO0-RECORD)
LENGTH (LENGTH OF CLT-ODCSFO0-RECORD)

RIDFLD (CUST-FILE-KEY)
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RESP (RESPONSE-CODE)

END-EXEC.

ENDBR

EXEC CICS ENDBR DATASET ('ODCSFO0')

END-EXEC.

DELETE

EXEC CICS DELETE FILE (*ODCSFO0"')
RIDFLD (CUST-FILE-KEY)
RESP (RESPONSE-CODE)

END-EXEC.

MISCELLEANOUS APIs
TIME

EXEC CICS
ASKTIME ABSTIME (ABS-TIME)
END-EXEC.
EXEC CICS
FORMATTIME ABSTIME (ABS-TIME)
DDMMYY (VDATEO) DATESEP('-")

END-EXEC.

HANDLE CONDITIONS

EXEC CICS

IGNORE CONDITION MAPFAIL
END-EXEC.
EXEC CICS

HANDLE CONDITION PGMIDERR (PGM-NOTFOUND)
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Simple App Documentation References

Y ou may find a detailed description of the CICS APIs at the following address:

http://publib.boul der.ibm.com/infocenter/cicsts/v3rl/index.jsp?topic=/com.ibm.cics.ts31.doc/df
hp4/topics/dfhp4 _commands.htm

Detailed Description of the CICS APIs

Thefollowing CICS APIs are used in the Simple App application.

Table 0-2 Simple App CICS APIs

API Description

ASKTIME Request current date and time of day.

DELETE Delete arecord from afile - vsam KSDS, vsaM RRDS, and data tables only.

ENDBR End browse of afile.

FORMATTIME Transform absol ute date and time into a specified format.

LINK Link to another program expecting return. The external CICS interface (EXCI)
provides a LINK command that performs all six commands of the interfacein one
invocation. Seethe CICS External Interfaces Guide for information about the EXCI.

READ Read arecord from afile.

READNEXT Read next record during a browse of afile.

READPREV Read previous record during afile browse; vsam and data tables only.

RECEIVE MAP

Receive screen input into an application data area. For further information about
BMS, see the

RETURN Return program control.
REWRITE Update arecord in afile.
SEND MAP Send mapped output data to aterminal. The keywords are separated into those

supported by minimum, standard, and full BMS. For further information about
BMS, see the CICS Application Programming Guide.
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Simple App Documentation References

Tahle 0-2 Simple App CICS APIs

API Description

START Start task at a specified time.
STARTBR Start browse of afile.
WRITE Write arecord.

XCTL Transfer program control.

This document is based upon the following reference guide: CICS Transaction Server for zZ/OS
Application Programming Reference
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Appendix C: Oracle Tuxedo Application
Rehosting Workbench Logs

This chapter contains the following topics:
e Purpose

e Procedures

Purpose

Oracle Tuxedo Application Rehosting Workbench (Tuxedo ART Workbench) L ogs are printed
on screen to show the running status of Workbench.

Procedures
Controlling Output of Logs

The environment variable wBLoGLEVEL isintroduced to define what level log will be output; i.e.,
al Workbench logsthat are prior than werocLEVEL will be output. Valid wBL.OoGLEVEL value can
be one of ERROR, WARN, INFO, DEBUG, TRACE; all other values will be directed to default value.

The default wBLOGLEVEL is INFO that ismeaning all logs whose level is INFO, WARN, ERROR Will
be output, others will be discard.

For example, if WBLOGLEVEL is set aswarn, only Error and Warn Logs are printed on screen.

export WBLOGLEVEL=WARN
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C-2

[19:31:56] WARN :(r4z-catalog) Line 25: Reference to unqualified undeclared data name:
WKk-Aidcount

[19:31:56] WARN :(rdz-catalog) This program contains errors, some of which may not appear
here.

Controlling Exit When Error Log Occurs

The environment variable wBEXITONERROR iS introduced to define whether Workbench should
continue or quit when an ERROR level log is met. There are two directionswhen an ERROR log
is met, to continue execute or to stop execute after reporting this error.

The default wBEXITONERROR Valueis YES, i.e,. Workbench will quit when an ERROR log is met.

WBEXITONERROR Can be set to No/FALSE, to stop quit. (All others values will be directed to
default YES).
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